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Read this manual carefully before you use this machine and keep it handy for future reference. For safe and correct use, be sure to read the Safety Information 

before using the machine.
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* 	The product names of Windows NT 4.0 are as follows:

Microsoft® Windows NT® Workstation 4.0

Microsoft® Windows NT® Server 4.0



Manuals for This Printer
For particular functions, see the relevant parts of the manual.

Safety Information

Provides information on safe usage of this machine.

To avoid injury and prevent damage to the machine, be sure to read this.

Hardware Guide

Contains information about paper and procedures such as installing options, replacing consumables,
responding to error messages, and resolving jams.

Software Guide (This manual)

Contains procedures for using this machine in a network environment, utilizing the software, and using
security functions.

Note to Administrator

Contains administrators' notes, such as information about administrators' hidden menus and hard disk
overwrite functions.

Administrators must store this manual carefully.
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Description for the Specified Model
In this manual, the following items explain about the printer for the specified models:

:

This explains about the 220 - 240 V model printer.

Read if you purchase this model.

:

This explains about the 120 V model printer.

Read if you purchase this model.

• You can identify the printer's model by checking the label on its inside as shown.

ATU088S
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How to Read This Manual

Symbols

This manual uses the following symbols:

Indicates important safety notes.

Ignoring these notes could result in serious injury or death. Be sure to read these notes. They can be found
in the "Safety Information".

Indicates important safety notes.

Ignoring these notes could result in moderate or minor injury, or damage to the machine or to property. Be
sure to read these notes. They can be found in the "Safety Information".

Indicates points to pay attention to when using the machine, and explanations of likely causes of paper
misfeeds, damage to originals, or loss of data. Be sure to read these explanations.

Indicates supplementary explanations of the machine's functions, and instructions on resolving user errors.

This symbol is located at the end of sections. It indicates where you can find further relevant information.

[ ]

Indicates the names of keys that appear on the machine's display panel.

[ ]

Indicates the names of keys on the machine's control panel.
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Using Keys
This section describes the names and usage of the control panel.

ATU049S

1. Display

Displays current printer status and error messages.

2. Selection Keys

Correspond to the function items at the bottom line on the display.

3. [Escape] key

Press this key to return to the previous condition on the display.

4. Scroll Keys

Press to move the cursor in each direction.

When the [ ] [ ] [ ] [ ] key appears in this manual, press the scroll key of the same direction.

5. [OK] Key

Use this key to determine the setting and setting value, or shift to the next level.

6. Data In indicator

Blinks when the printer is receiving data from a computer. The Data In indicator is lit if there is data to be printed.

7. Alert Indicator

Lights up whenever a printer error occurs. Follow the instructions that appear on the display.

8. Power indicator

This indicator remains lit while the power is on. It is unlit when the power is off or while the printer is in the Energy
Saver mode.

9. [Job Reset] key

When the printer is online, press this key to cancel an ongoing print job.

10. [Menu] key

Press this key to make and check the current printer settings.
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11. Online Indicator/[Online] key

Indicates whether the printer is online or offline. Press this to switch between online and offline.

When the lamp is lit, the printer is online, enabling data reception from the host computer.

When the lamp is unlit, the printer is offline, disabling data reception from the host computer.

Press the [Online] key while configuring each setting, to return to the initial screen.
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1. Preparing for Printing

Quick Install
Windows 95/98/Me/2000/XP/Vista, and Windows Server 2003/2003 R2 users can easily install
this software using the CD-ROM provided.

Quick Install sets the TCP/IP port and installs DeskTopBinder and the PCL and/or RPCS driver.

• To install printer driver under Windows 2000/XP Professional/Vista, and Windows Server
2003/2003 R2, you must have an account that has Manage Printers permission. Log on as an
Administrator.

• The Quick Install is not available when using this printer under USB connection.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [Quick Install].

The software license agreement appears in the License Agreement dialog box.

5. After reading the agreement, click [I accept the agreement.], and then click [Next >].

6. Select the printer model you want to use in the [Select Printer] dialog box.

For network connection via TCP/IP, select the printer whose IP address is displayed in [Connect To].

For parallel connection, select the printer whose printer port is displayed in [Connect To].

7. Click [Install].

The printer driver installation starts.

8. Click [Finish].

A message about restarting the computer may appear. Restart the computer to complete installation.

9. Click [Exit] in the first dialog box of the installer, and then take out the CD-ROM.

• To stop installation of the selected software, click [Cancel] before installation is complete.

• Select a printer to whose IP address is displayed in [Connect To] to install SmartDeviceMonitor for
Client when using TCP/IP.
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• Download the printer driver from the supplier's web site when using under Windows NT 4.0.

• Quick Install is not available for parallel connection unless bidirectional communication between the
printer and computer is enabled. See p.74 "Making Option Settings for the Printer" for details about
bidirectional communication between printer and computer.

• If you connect using USB, see p.59 "Installing the Printer Driver Using USB".

1. Preparing for Printing
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Confirming the Connection Method
This printer supports network and local connection.

Before installing the printer driver, check how the printer is connected. Follow the driver installation
procedure that is appropriate to the connection method.

Network Connection

This printer can be used as a Windows printing port or network printer.

Using this printer as the Windows printing port

Network connections can be established through Ethernet and IEEE 802.11b.

Available ports are determined based on the combination of Windows operating system version and
connection method used.

BHH008S

Windows 95/98

Connection Method Available Ports

Ethernet/IEEE 802.11b SmartDeviceMonitor for Client port

Windows Me

Connection Method Available Ports

Ethernet/IEEE 802.11b SmartDeviceMonitor for Client port

Confirming the Connection Method
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Windows 2000

Connection Method Available Ports

Ethernet/IEEE 802.11b

SmartDeviceMonitor for Client port

Standard TCP/IP port

LPR port

Windows XP

Connection Method Available Ports

Ethernet/IEEE 802.11b

SmartDeviceMonitor for Client port

Standard TCP/IP port

LPR port

Windows Vista

Connection Method Available Ports

Ethernet/IEEE 802.11b

SmartDeviceMonitor for Client port

Standard TCP/IP port

LPR port

Windows Server 2003/2003 R2

Connection Method Available Ports

Ethernet/IEEE 802.11b

SmartDeviceMonitor for Client port

Standard TCP/IP port

LPR port

Windows NT 4.0

Connection Method Available Ports

Ethernet/IEEE 802.11b
SmartDeviceMonitor for Client port

LPR port

1. Preparing for Printing

20

1



• See the explanation of how to install the printer driver for each type of port. For the
SmartDeviceMonitor for Client port, see p.23 "Using the SmartDeviceMonitor Port".

• For the Standard TCP/IP port, see p.40 "Using the Standard TCP/IP Port".

• For the LPR port, see p.45 "Using the LPR Port".

Using as a network printer

This printer can be used as the Windows network printer, the NetWare print server, or the NetWare remote
printer.

• In an IPv6 environment, Netware servers cannot be used.

Windows 2000/XP/Vista

Windows Server 2003/2003 R2

Windows NT 4.0

Print Server

Windows 95/98/Me Windows 2000 Windows XP/Vista

Windows Server 2003/2003 R2

Windows NT 4.0

NetWare

Print Server

NetWare

File Server

BHH009S

• See the explanation of how to install the printer driver for each type of network printer.

• For the Windows network printer, see p.50 "Using as the Windows Network Printer".

• For the NetWare print server and remote printer, see p.56 "Using as the NetWare Print Server/
Remote Printer"

Local Connection

Local connections can be established via parallel, USB, and Bluetooth connections.
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Windows operating system version determines the available connection methods.

• Windows 95:

Parallel connection

• Windows 98:

Parallel connection

• Windows 98SE

Parallel and Bluetooth connections

• Windows Me:

USB, Parallel, and Bluetooth connections

• Windows 2000:

USB, Parallel, and Bluetooth connections

• Windows XP:

USB, Parallel, and Bluetooth connections

• Windows Vista:

USB, Parallel, and Bluetooth connections

• Windows Server 2003/2003 R2:

USB, Parallel, and Bluetooth connections

• Windows NT 4.0:

Parallel connection

• See the explanation of how to install the printer driver for each method of connection.

• For the USB connection, see p.59 "Installing the Printer Driver Using USB".

• For the parallel connection, see p.69 "Printing with Bluetooth Connection".
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Using the SmartDeviceMonitor Port

Installing DeskTopBinder-SmartDeviceMonitor for Client

• To install SmartDeviceMonitor for Client under Windows 2000/XP Professional/Vista, Windows
Server 2003/2003 R2, and Windows NT 4.0, you must have an account that has Manage Printers
permission. Log on as an Administrator.

• Install SmartDeviceMonitor for Client before installing the printer driver when using the
SmartDeviceMonitor for Client port.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [DeskTopBinder-SmartDeviceMonitor for Client].

5. Select an interface language, and then click [Next>].

The default interface language is English.

6. The message to quit all other applications appears. Quit all applications, and then click [Next
>].

7. Click [Yes]

8. The DeskTopBinder Lite Setup dialog appears, and then click [Next >].

9. The software license agreement appears in the [License Agreement] dialog box. After
reading through its contents, click [Yes].

10. Click [Full install] or [Custom Install].

[Full install] installs all required applications: DeskTopBinder Lite and SmartDeviceMonitor for
Client.

[Custom Install] installs selected applications.

11. Follow the instructions on the display and click [Next >] to proceed next step.

12. After the installation is completed, select one of the options to restart the computer either
now or later, and click [Complete].

Restart the computer to complete installation.
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• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• To stop installation of the selected software, click [Cancel] before installation is complete.

Installing the PCL or RPCS Printer Driver (TCP/IP)

• To install this printer driver under Windows 2000/XP Professional/Vista, and Windows Server
2003/2003 R2, you must have an account that has Manage Printers permission. Log on as an
Administrators or Power Users group member.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PCL/RPCS Printer Drivers].

5. The software license agreement appears in the [License Agreement] dialog box.

After reading the agreement, click [I accept the agreement.], and then click [Next >].

6. Select the printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

7. Click [Next >].

8. Select the printer model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

9. Double-click the printer name to display the printer settings.

The details shown in [Comment:] , [Driver:], and [Port:] vary depending on the operating system,
printer model, and port.

10. Click [Port:], and then click [Add].

11. Click [SmartDeviceMonitor], and then click [OK].

12. Click [TCP/IP], and then click [Search].

A list of printers using TCP/IP appears.

13. Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use a printer not listed here,
click [Specify Address], and then enter the IP address or host name of the printer.
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14. Check that the port of the selected printer is displayed in [Port:].

15. Set a User Code, if necessary.

Up to 8 numeric characters can be entered. No alphabetic characters or symbols are available.

16. Select the [Default Printer] check box to configure the printer as default.

17. Click [Continue].

Installation starts.

18. After the installation is completed, select one of the options to restart the computer either
now or later, and then click [Finish].

Restart the computer to complete installation.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• Under Windows 95/98/Me, you cannot add an IPv4 address partially similar to the one already
used. For example, if "192.168.0.2" is in use, "192.168.0.2xx" cannot be used. Similarly, if
"192.168.0.20" is in use, "192.168.0.2" cannot be used.

• This allows a SmartDeviceMonitor for Admin user to display and check statistics about the number of
sheets which each user prints. For details, see SmartDeviceMonitor for Admin Help.

• A message appears if there is a newer version of the printer driver already installed. If there is, you
cannot install the printer driver using Auto Run. If you still want to install the printer driver, install using
[Add Printer]. See p.72 "If a Message Appears during Installation".

Installing the PCL or RPCS Printer Driver (IPP)

• To install printer driver under Windows 2000/XP Professional/Vista, and Windows Server
2003/2003 R2, you must have an account that has Manage Printers permission. Log on as an
Administrators or Power Users group member.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PCL/RPCS Printer Drivers].
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5. The software license agreement appears in the [License Agreement] dialog box.

After reading the agreement, click [I accept the agreement.], and then click [Next >].

6. Select a printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

7. Select the printer model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

8. Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the operating system, printer
model, and port.

9. Click [Port:], and then click [Add].

10. Click [SmartDeviceMonitor], and then click [OK].

11. Click [IPP].

12. In the [Printer URL] box, enter "http://printer's address/printer" as the printer's address.

If the server authentification is issued, to enable SSL( a protocol for encrypted communication), enter
"https://printer's address/printer" (Internet Explorer 5.01, or a higher version must be installed).

(example IPv4 address: 192.168.15.16)

http://192.168.15.16/printer

https://192.168.15.16/printer

You can enter "http: //printer's address/ipp" as the printer's address.

13. Enter a name for identifying the printer in [IPP Port Name]. Use a name different from the
one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box becomes the IPP port
name.

14. Click [Detailed Settings] to make necessary settings.

For information about the settings, see SmartDeviceMonitor for Client Help.

15. Click [OK].

16. Check that the port of the selected printer is displayed in [Port:].

17. Set a User Code, if necessary.

Up to 8 numeric characters can be entered. No alphabetic characters or symbols can be entered.

18. Select the [Default Printer] check box to configure the printer as default.

19. Click [Continue].

Installation starts.
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20. After the installation is completed, select one of the options to restart the computer either
now or later, and then click [Finish].

Restart the computer to complete installation.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• This allows a SmartDeviceMonitor for Admin user to display and check the number of sheets each
user prints. For details, see SmartDeviceMonitor for Admin Help.

• To stop installation of the selected software, click [Cancel] before installation is complete.

• A message appears if there is a newer version of the printer driver already installed. If there is, you
cannot install the printer driver using Auto Run. If you still want to install the printer driver, use [Add
Printer]. See p.72 "If a Message Appears during Installation".

Installing the PostScript 3 Printer Driver (Windows 95/98/Me - TCP/IP)

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer], and then click [Next >].

A dialog box for selecting the printer manufacturer and model name appears.

7. Select the name of the printer whose driver you want to install, and then click [Next >].

8. In the[Available ports:] box, click [Printer Port], and then click [Next >].

9. Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

10. Specify whether or not to print a test page, and then click [Finish].

11. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

12. Click the icon of the printer you want to use. On the [File] menu, click [Properties].
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13. On the [Details] tab, click [Add Port…].

14. Click [SmartDeviceMonitor] in the [Other] list, and then click [OK].

15. Click [TCP/IP], and then click [Search].

A list of printers using TCP/IP appears.

16. Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use a printer not listed here,
click [Specify Address], and then enter the IPv4 address or host name of the printer.

You cannot add an IPv4 address partially similar to the one already used. For example, if
"192.168.0.2" is in use, "192.168.0.2xx" cannot be used. Similarly, if "192.168.0.20" is in use,
"192.168.0.2" cannot be used.

17. Click [OK].

18. Check that the selected port is highlighted in [Printer to the following port:], and then click
[OK].

19. Restart the computer to complete installation.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• A User Code can be set after the printer driver installation. For information about User Code, see the
printer driver Help.

Installing the PostScript 3 Printer Driver (Windows 95/98/Me - IPP)

• IPv6 cannot be used under Windows 95/98/Me.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer], and then click [Next >].

A dialog box for selecting the printer manufacturer and model name appears.
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7. Select the name of the printer whose driver you want to install, and then click [Next >].

8. In the [Available ports:] box, click [Printer Port], and then click [Next >].

9. Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

10. Specify whether or not to print a test page, and then click [Finish].

11. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

12. Click the icon of the printer you want to use. On the [File] menu, click [Properties].

13. On the [Details] tab, click [Add Port…].

14. Click [SmartDeviceMonitor] in the Other list, and then click [OK].

15. Click [IPP].

16. In the [Printer URL] box, enter "http://(printer's address)/printer" as the printer's address.

If the server authentification is issued, to enable SSL (a protocol for encrypted communication), enter
"https://(printer's address)/printer" (Internet Explorer 5.01, or a higher version must be installed).

(example IPv4 address: 192.168.15.16)

http://192.168.15.16/printer

https://192.168.15.16/printer

You can enter "http://(printer's address)/ipp" as the printer's address.

17. Enter a name for identifying the printer in [IPP Port Name]. Use a name different from the
one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box becomes the IPP port
name.

18. Click [Detailed Settings] to make necessary settings.

For information about the settings, see SmartDeviceMonitor for Client Help.

19. Click [OK].

20. Check that the selected port is highlighted in [Printer to the following port:], and then click
[OK[.

21. Restart the computer to complete installation.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

• A User Code can be set after the printer driver installation. For information about User Code, see the
printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows 2000 - TCP/IP)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer], and then click [Next >].

7. Click [Create a new port:].

8. Click [SmartDeviceMonitor], and then click [Next >].

9. Click [TCP/IP], and then click [Search].

A list of printers using TCP/IP appears.

10. Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use a printer not listed here,
click [Specify Address], and then enter the IPv4 address or host name of the printer.

11. Check that the name of the printer whose driver you want to install is selected, and then click
[Next >].

12. Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

13. Specify whether or not to share the printer, and then click [Next >].

14. Specify whether or not to print a test page, and then click [Next >].

15. Click [Finish].

The printer driver installation starts.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.
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• A User Code can be set after the printer driver installation. For information about User Code, see the
printer driver Help.

Installing the PostScript 3 Printer Driver (Windows 2000 - IPP)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• IPv6 cannot be used under Windows 2000.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer attached to this computer], and then click [Next >].

7. Click [Create a new port:].

8. Click [DeskTopBinder-SmartDeviceMonitor], and then click [Next >].

9. Click [IPP].

10. In the [Printer URL] box, enter "http://(printer's address)/printer" as the printer's address.

If the server authentification is issued, to enable SSL (a protocol for encrypted communication), enter
"https://(printer's address)/printer" (Internet Explorer 5.01, or a higher version must be installed).

(example IPv4 address: 192.168.15.16)

http://192.168.15.16/printer

https://192.168.15.16/printer

You can enter "http://(printer's address)/ipp" as the printer's address.

11. Enter a name for identifying the printer in [IPP Port Name]. Use a name different from the
name of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box becomes the IPP port
name.

12. Click [Detailed Settings] to make necessary settings.

For information about the settings, see SmartDeviceMonitor for Client Help.
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13. Click [OK].

14. Check that the name of the printer whose driver you want to install is selected, and then click
[Next >].

15. Change the printer name if you want, and then click [Next >].

16. Click [Next >].

17. Specify whether or not to print a test page, and then click [Next >].

18. Click [Finish].

The printer driver installation starts.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

• A User Code can be set after the printer driver installation. For information about User Code, see the
printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP, Windows Server
2003/2003 R2 - TCP/IP)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer attached to this computer], and then click [Next >].

7. Click [Create a new port:].

8. Click [SmartDeviceMonitor], and then click [Next >].
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9. Click [TCP/IP], and then click [Search].

A list of printers using [TCP/IP] appears.

10. Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use a printer not listed here,
click [Specify Address], and then enter the IPv4 address or host name of the printer.

11. Check that the name of the printer whose driver you want to install is selected, and then click
[Next >].

12. Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

13. Specify whether or not to print a test page, and then click [Next >].

14. Click [Finish].

The printer driver installation starts.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

• A User Code can be set after the printer driver installation. For information about User Code, see the
printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP, Windows Server
2003/2003 R2 - IPP)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer attached to this computer], and then click [Next >].
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7. Click [Create a new port:].

8. Click [SmartDeviceMonitor], and then click [Next >].

9. Click [IPP].

10. In the [Printer URL] box, enter "http://(printer's address)/printer" as the printer's address.

If the server authentification is issued, to enable SSL (a protocol for encrypted communication), enter
"https://(printer's address)/printer" (Internet Explorer 5.01, or a higher version must be installed).

(example IPv4 address: 192.168.15.16)

http://192.168.15.16/printer

https://192.168.15.16/printer

You can enter "http://(printer's address)/ipp" as the printer's address.

If you are using Firefox or Netscape under Windows XP SP 2 or Windows Server 2003, you can
enter IPv6 address as "http://IPv6 printer's address/printer".

11. Enter a name for identifying the printer in [IPP Port Name]. Use a name different from the
one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box becomes the IPP port
name.

12. [Detailed Settings] to make necessary settings.

For information about the settings, see SmartDeviceMonitor for Client Help.

13. Click [OK].

14. Check that the name of the printer driver you want to install is selected, and then click [Next
>].

15. Change the name of the printer if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

16. Specify whether or not to print a test page, and then click [Next >].

17. Click [Finish].

The printer driver installation starts.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

• A User Code can be set after the printer driver installation. For information about User Code, see the
printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows Vista - TCP/IP)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi, Russian.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Local printer attached to this computer.].

6. Click [Create a new port:].

7. Click [DeskTopBinder - SmartDeviceMonitor], and then click [Next >].

8. Click [TCP/IP], and then click [Search].

A list of printers using TCP/IP appears.

9. Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use a printer not listed here,
click [Specify Address], and then enter the IP address or host name of the printer.

10. Check that the name of the printer whose driver you want to install is selected, and then click
[Next >].

11. Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

12. Specify whether or not to share the printer, and then click [Finish].

The printer driver installation starts.

• Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.
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• A message appears if there is a newer version of the printer driver already installed. If there is, you
cannot install the printer driver using Auto Run. If you still want to install the printer driver, use [Add
Printer]. See "If a Message Appears during Installation".

• p.72 "If a Message Appears during Installation"

Installing the PostScript 3 Printer Driver (Windows Vista - IPP)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi, Russian.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Local printer attached to this computer.].

6. Click [Create a new port:].

7. Click [DeskTopBinder - SmartDeviceMonitor], and then click [Next >].

8. Click [IPP].

9. In the [Printer URL] box, enter "http://(printer's IP address or host name)/printer" as the
printer's address.

If the server authentification is issued, to enable SSL (a protocol for encrypted communication), enter
"https://(printer's IP address or host name)/printer" (Internet Explorer 5.01, or a higher version must
be installed).

(example IP address: 192.168.15.16)

http://192.168.15.16/printer

https://192.168.15.16/printer

You can enter "http://printer's IP address or host name/ipp" as the printer's address.

If the address is "192.168.001.010", you must enter it as "192.168.1.10" to connect to the printer.
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10. Enter a name for identifying the printer in [IPP Port Name]. Use a name different from the
one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box becomes the IPP port
name.

11. Click [Detailed Settings] to make necessary settings.

12. Click [OK].

13. Check that the name of the printer driver you want to install is selected, and then click [Next
>].

14. Change the name of the printer if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

15. Specify whether or not to share the printer, and then click [Finish].

The printer driver installation starts.

• Auto Run may not work with certain operating system settings. In that case, launch "Setup.exe" on the
CD-ROM root directory.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• A message appears if there is a newer version of the printer driver already installed. If there is, you
cannot install the printer driver using Auto Run. If you still want to install the printer driver, use [Add
Printer]. See "If a Message Appears during Installation".

• p.72 "If a Message Appears during Installation"

Changing the Port Settings for SmartDeviceMonitor for Client

Follow the procedure below to change the SmartDeviceMonitor for Client settings, such as TCP/IP timeout,
recovery/parallel printing, and printer groups.

Windows 95/98:

1. Open [Printers] window from [Start] menu.

2. In the [Printers] window, click the icon of the printer you want to use. On the [File] menu,
click [Properties].

3. Click the [Details] tab, and then click [Port Settings...].

The [Port Settings] dialog box appears.
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Windows 2000/Windows NT 4.0:

1. Open [Printers] window from [Start] menu.

2. In the [Printers] window, click the icon of the printer you want to use. On the [File] menu,
click [Properties].

3. On the [Ports] tab, click [Configure Port...].

The [Port Configuration] dialog box appears.

Windows XP, Windows Server 2003/2003 R2:

1. Open the [Printers and Faxes] window from the [Start] menu.

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use. On the [File] menu, click [Properties]. The printer
properties appear.

3. Click the [Ports] tab, and then click [Configure Port...].

The [Port Configuration] dialog box appears.

Windows Vista:

1. On the [Start] menu, click [Control Panel].

The [Control Panel] window appears.

2. Click [Printer].

The [Printers] window appears.

3. Right-click the icon of the printer you want to use, and then click [Properties].

4. Click the [Ports] tab, and then click [Configure Port].

The [Port Configuration:] dialog box appears.

• For TCP/IP, timeout setting can be configured.

• User, proxy, and timeout settings can be configured for IPP.

• If no settings on the [Recovery/Parallel Printing] tab are available, follow the procedure below.

1. Click [Cancel] to close the [Port Configuration:] dialog box.

2. Start SmartDeviceMonitor for Client, and then right-click the SmartDeviceMonitor for Client icon
on the tasktray.

3. Point to [Properties], and then click [Extended Features Settings].

4. Select the [Set Recovery/Parallel Printing for each port] check box.
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5. Click [OK] to close the [Extended Features Settings] dialog box.

• For information about these settings, see SmartDeviceMonitor for Client Help.
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Using the Standard TCP/IP Port

Installing the PCL or RPCS Printer Driver

• To install printer driver under Windows 2000/XP Professional/Vista, and Windows Server
2003/2003 R2, you must have an account that has Manage Printers permission. Log on as an
Administrators or Power Users group member.

• In an IPv6 environment, you cannot use the Standard TCP/IP Port. Use the SmartDeviceMonitor port

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PCL/RPCS Printer Drivers].

5. The software license agreement appears in the [License Agreement] dialog box.

After reading the agreement, click [I accept the agreement.], and then click [Next >].

6. Select a printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

7. Click [Next >].

8. Select the printer model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

9. Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the operating system, printer
model, and port.

10. Click [Port:], and then click [Add].

11. Click [Standard TCP/IP Port], and then click [OK].

Configure the Standard TCP/IP port settings, and then see Windows Help if [Standard TCP/IP Port]
does not appear.

12. Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

13. Enter the printer name or IPv4 address in the [Printer Name or IP Address] box.

The [Port Name] text box automatically obtains a port name. Change this name if necessary.

When screen for Device selection appears, select "RICOH NetworkPrinter Driver C Model".
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14. Click [Next >].

15. Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

The installation start dialog box reappears.

16. Check that the port of the selected printer is displayed in [Port:].

17. Configure the default printer as necessary.

18. Click [Continue].

The printer driver installation starts.

19. After the installation is completed, select one of the options to restart the computer either
now or later, and then click [Finish].

Restart the computer to complete installation.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• To stop installation of the selected software, click [Cancel] before installation is complete.

• A message appears if there is a newer version of the printer driver already installed. If there is, you
cannot install the printer driver using Auto Run. If you still want to install the printer driver, use [Add
Printer]. See p.72 "If a Message Appears during Installation".

Installing the PostScript 3 Printer Driver (Windows 2000)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• In an IPv6 environment, you cannot use the Standard TCP/IP Port. Use the SmartDeviceMonitor port.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer], and then click [Next >].
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7. Click [Create a new port:].

8. Click [Standard TCP/IP Port], and then click [Next >].

9. Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

10. Enter the printer name or IPv4 address in the [Printer Name or IP Address] box, and then
click [Next >].

When screen for Device selection appears, select "RICOH NetworkPrinter Driver C Model".

11. Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

12. Check that the name of the printer whose driver you want to install is selected, and then click
[Next >].

13. Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

14. Click [Next >].

15. Specify whether or not to print a test page, and then click [Next>].

16. Click [Finish].

The printer driver installation starts.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

• A User Code can be set after the printer driver installation. For information about User Code, see the
printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP, Windows Server
2003/2003 R2)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• In an IPv6 environment, you cannot use the Standard TCP/IP Port. Use the SmartDeviceMonitor port.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.
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4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer attached to this printer], and then click [Next >].

7. Click [Create a new port:].

8. Click [Standard TCP/IP Port] in [Create a new Port], and then click [Next >].

9. Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

10. Enter the printer name or IPv4 address in the [Printer Name or IP Address] box.

The [Port Name] text box automatically obtains a port name. Change this name if necessary.

When screen for Device selection appears, select "RICOH NetworkPrinter Driver C Model".

11. Click [Next >].

12. Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

13. Check that the name of the printer whose driver you want to install is selected, and then click
[Next >].

14. Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

15. Click [Next>].

16. Specify whether or not to print a test page, and then click [Next >].

17. Click [Finish].

The printer driver installation starts.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

• A User Code can be set after the printer driver installation. For information about User Code, see the
printer driver Help.

Installing the PostScript 3 Printer Driver (Windows Vista)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• In an IPv6 environment, you cannot use the Standard TCP/IP Port. Use the DeskTop Binder-
SmartDeviceMonitor port.
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1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Suomi, Magyar, Cestina, Polski, Portugues, Russian,
Catala, Turkce.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Local printer attached to this printer].

6. Click [Create a new port:].

7. Click [Standard TCP/IP Port] in [Create a new port], and then click [Next >].

8. Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

9. Enter the printer name or IP address in the [Printer Name or IP Address] box.

The [Port Name] text box automatically obtains a port name. Change this name if necessary.

When screen for Device selection appears, select “RICOH NetworkPrinter Driver C Model”.

10. Click [Next >].

11. Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

12. Check that the name of the machine whose driver you want to install is selected, and then
click [Next >].

13. Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

14. Specify whether or not to print a test page, and then click [Finish].

The printer driver installation starts.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch “Setup.exe” on
the CD-ROM root directory.
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Using the LPR Port

Installing the PCL or RPCS Printer Driver

• To install this printer driver under Windows 2000/XP Professional/Vista, Windows Server
2003/2003 R2, and Windows NT 4.0, you must have an account that has Manage Printers
permission. Log on as an Administrators or Power Users group member.

• In an IPv6 environment, you cannot use the LPR Port. Use the SmartDeviceMonitor port.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PCL/RPCS Printer Drivers].

5. The software license agreement appears in the [License Agreement] dialog box.

After reading the agreement, click [I accept the agreement.], and then click [Next >].

6. Select a printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

7. Select the printer model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

8. Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the operating system, printer
model, and port.

9. Click [Port:], and then click [Add].

10. Click [LPR Port], and then click [OK].

If [LPR Port] does not appear, see Windows Help and install it.

11. Enter the printer's IPv4 address in the [Name or address of server providing lpd] box.

12. Enter "lp" in the [Name of printer or print queue on that server] box, and then click [OK].

The port is added.

13. Check that the port of the selected printer is displayed in [Port:].

14. Configure the default printer as necessary.
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15. Click [Finish].

The printer driver installation starts.

16. After the installation is completed, select one of the options to restart the computer either
now or later, and then click [Finish].

Restart the computer to complete installation.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• To stop installation of the selected software, click [Cancel] before installation is complete.

• A message appears if there is a newer version of the printer driver already installed. If there is, you
cannot install the printer driver using Auto Run. If you still want to install the printer driver, use [Add
Printer]. See p.72 "If a Message Appears during Installation".

Installing the PostScript 3 Printer Driver (Windows 2000)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• In an IPv6 environment, you cannot use the LPR Port. Use the SmartDeviceMonitor port.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer], and then click [Next >].

7. Click [Create a new port:].

8. Click [LPR Port], and then click [Next >].

9. Enter the printer's IPv4 address in the [Port Name] box, and then click [OK].

10. Check that the name of the printer whose driver you want to install is selected, and then click
[Next >].
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11. Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

12. Specify whether or not to share the printer, and then click [Next >].

13. Specify whether or not to print a test page, and then click [Next >].

14. Click [Finish].

The printer driver installation starts.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

• A User Code can be set after the printer driver installation. For information about User Code, see the
printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP, Windows Server
2003/2003 R2)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• In an IPv6 environment, you cannot use the LPR Port. Use the SmartDeviceMonitor port.

1. Quit all applications currently running.

1. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

2. Select an interface language, and then click [OK].

The default interface language is English.

3. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

4. Click [Next >].

5. Click [Local Printer attached to this computer], and then click [Next >].

6. Click [Create a new port:].

7. Click [LPR Port] in [Create a new Port], and then click [Next >].

8. Enter the printer's IP address in the [Name or address of server providing lpd] box.

9. Enter "lp" in the [Name of printer or print queue on that server] box, and then click [OK].
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10. Check that the name of the printer whose driver you want to install is selected, and then click
[Next >].

11. Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

12. Click [Next >].

13. Specify whether or not to print a test page, and then click [Next >].

14. Click [Finish].

The printer driver installation starts.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

• A User Code can be set after the printer driver installation. For information about User Code, see the
printer driver Help.

Installing the PostScript 3 Printer Driver (Windows Vista)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• In an IPv6 environment, you cannot use the LPR Port. Use the DeskTop Binder-SmartDeviceMonitor
port.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Suomi, Magyar, Cestina, Polski, Portugues, Russian,
Catala, Turkce.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Local Printer attached to this computer.].

6. Click [Create a new port:].
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7. Click [LPR Port] in [Create a new port], and then click [Next >].

8. Enter the printer's IP address in the [Name or address of server providing lpd] box.

9. Enter “Ip” in the [Name of printer or print queue on that server box], and then click [OK].

10. Check that the name of the machine whose driver you want to install is selected, and then
click [Next >].

11. Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

12. Specify whether or not to print a test page, and then click [Finish].

The printer driver installation starts.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch “Setup.exe” on
the CD-ROM root directory.
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Using as the Windows Network Printer

Installing the PCL or RPCS Printer Driver

To use the print server, install the printer driver by selecting "Network printer server", and then select the
Windows 2000/XP/Vista, or Windows Server 2003/2003 R2 shared printer.

This section assumes that the client has already been configured to communicate with a Windows 2000/
XP/Vista, or Windows Server 2003/2003 R2 print server. Do not begin the following procedure before
the client is set up and configured correctly.

• To install the printer driver under Windows 2000/XP/Vista, and Windows Server 2003/2003 R2,
you must have an account that has Manage Printers permission. Log on as an Administrators or Power
Users group member.

• If you print with a print server connected to the printer using the SmartDeviceMonitor port, Recovery
Printing and Parallel Printing cannot be used from the client.

• If you print under Windows XP/Vista or Windows Server 2003/2003 R2 print server, notification
functions of SmartDeviceMonitor may not be used with the client.

• You can install the printer driver from the CD-ROM provided with this printer or download it from the
supplier's Web site.

• If your operating system is Windows XP Pro x64, Windows Server 2003/2003 R2 x64, you must
download the printer driver from the manufacturer's Web site. Select this printer and the operating
system you are using, and then download it.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PCL/RPCS Printer Drivers].

5. The software license agreement appears in the [License Agreement] dialog box.

After reading the agreement, click [I accept the agreement.], and then click [Next >].

6. Select a printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

7. Click [Next >].

8. Select the printer models you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.
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9. Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the operating system, printer
model, and port.

10. Click [Port:], and then click [Add].

11. Click [Network Printer], and then click [OK].

12. Double-click the computer name you want to use as a print server in the [Browse for Printer]
window.

13. Select the printer you want to use, and then click [OK].

14. Check that the port of the selected printer is displayed in [Port:].

15. Configure the User Code as necessary.

For an RPCS printer driver, a User Code can be set after the printer driver installation. For information
about User Code, see the printer driver Help.

16. Select the [Default Printer] check box to configure the printer as default.

17. Click [Continue].

The printer driver installation starts.

18. After the installation is completed, select one of the options to restart the computer either
now or later, and then click [Finish].

Restart the computer to complete installation.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• To stop installation of the selected software, click [Cancel] before installation is complete.

• A message appears if there is a newer version of the printer driver already installed. If there is, you
cannot install the printer driver using Auto Run. If you still want to install the printer driver, use [Add
Printer]. See p.72 "If a Message Appears during Installation".

Installing the PostScript 3 Printer Driver (Windows 95/98/Me)

• If you print from a print server connected to the printer using the SmartDeviceMonitor port, the client
cannot use Recovery Printing and Parallel Printing.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.
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3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Network Printer], and then click [Next >].

7. Click [Browse].

8. Double-click the computer name you want to use as a print server in the [Browse for Printer]
window.

9. Select the printer you want to use, and then click [OK].

10. Check the location of the selected printer is shown, and then click [Next >].

11. Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

12. Specify whether or not to print a test page, and then click [Finish].

13. Restart the computer.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

• A User Code can be set after the printer driver installation. For information about User Code, see the
printer driver Help.

Installing the PostScript 3 Printer Driver (Windows 2000)

• Installing a printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• If you print from a print server connected to the printer using the SmartDeviceMonitor port, the client
cannot use Recovery Printing and Parallel Printing.

1. Quit all applications currently running.

1. Insert the CD-ROM into the CD-ROM drive.

The installer starts.
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2. Select an interface language, and then click [OK].

The default interface language is English.

3. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

4. Click [Next >].

5. Click [Network printer], and then click [Next >].

6. Select the location method from the [Locate Your Printer] screen, and then click [Next >].

7. Double-click the computer name you want to use as a print server in the [Shared printers:]
window.

8. Select the printer you want to use, and then click [Next >].

9. The printer driver installation starts.

10. Click [Next >].

Select the [Yes] check box to configure the printer as default.

11. Click [Finish].

Restart the computer to complete installation.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

• A User Code can be set after the printer driver installation. For information about User Code, see the
printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP, Windows Server
2003/2003 R2)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• If you print from a print server connected to the printer using the SmartDeviceMonitor port, the client
cannot use Recovery Printing and Parallel Printing.

• If you print with a Windows XP or Windows Server 2003 print server, SmartDeviceMonitor notification
functions may not be possible for the client.

1. Quit all applications currently running.

Using as the Windows Network Printer

53

1



1. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

2. Select an interface language, and then click [OK].

The default interface language is English.

3. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

4. Click [Next >].

5. Click [A network printer, or a printer attached to another computer], and then click [Next
>].

6. Select [Browse for a printer], and then click [Next >].

7. Double-click the computer name you want to use as a print server in the [Shared printers]
window.

8. Select the printer you want to use, and then click [Next >].

9. The printer driver installation starts.

10. Click [Next >].

Select the [Yes] check box to configure the printer as default.

11. Click [Finish].

Restart the computer to complete installation.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

• A User Code can be set after the printer driver installation. For information about User Code, see the
printer driver Help.

Installing the PostScript 3 Printer Driver (Windows Vista)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

• If you print from a print server connected to the printer using the DeskTop Binder-
SmartDeviceMonitor port, the client cannot use Recovery Printing and Parallel Printing.

• If you print with a Windows Vista print server, DeskTop Binder-SmartDeviceMonitor notification
functions may not be possible for the client.
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1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Suomi, Magyar, Cestina, Polski, Portugues, Russian,
Catala, Turkce.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [A network printer, or a printer attached to another computer].

6. Select [Browse for a printer], and then click [Next >].

7. Double-click the computer name you want to use as a print server in the [Shared printers]
window.

8. Select the printer you want to use, and then click [Next >].

9. The printer driver installation starts.

10. Click [Next >].

Select the [Yes] check box to configure the printer as default.

11. Click [Finish].

Restart the computer to complete installation.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

• Auto Run may not work with certain operating system settings. In that case, launch “Setup.exe” on
the CD-ROM root directory.
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Using as the NetWare Print Server/Remote
Printer
This explains how to set up the Windows computer used as the NetWare client.

• To install this printer driver under Windows 2000/XP Professional/Vista, Windows Server
2003/2003 R2, and Windows NT 4.0, you must have an account that has Manage Printers
permission. Log on as an Administrators or Power Users group member.

• In an IPv6 environment, Netware servers cannot be used.

The following explanation assumes NetWare Client is installed on the client computer and the NetWare
server environment is correctly set up. Install all necessary client applications before following this
procedure.

Set up the printer driver while logging on to the NetWare file server.

The following values are used in the example:

• Operating system: Windows 98

• NetWare version: 4.1

• File server name: CAREE

• Queue name: R-QUEUE

1. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

2. Select an interface language, and then click [OK].

The default interface language is English.

3. Click [PCL/RPCS Printer Drivers].

4. The software license agreement appears in the [License Agreement] dialog box.

After reading the agreement, click [I accept the agreement.], and then click [Next >].

5. Select the printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

6. Click [Next >].

7. Select the [Printer Name] check box to select the printer model you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

8. Double-click the printer name to display the printer settings.

The details shown in [Comment], [Driver], and [Port] vary depending on the operating system, printer
model, and port.

9. Click [Port:], and then click [Add].
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10. Click [Network Printer], and then click [OK].

11. Double-click the name of the NetWare file server on the network tree.

The created queue is displayed.

12. Select the print queue, and then click [OK].

13. Check that the port of the selected printer is displayed in [Port:].

14. Click [Continue].

The printer driver installation starts.

15. Click [Finish] in the [Select Program] dialog box.

16. After the installation is completed, select one of the options to restart the computer either
now or later, and then click [Finish].

Restart the computer to complete installation.

17. After restarting the computer, open the printer properties from the [Printers and Faxes]
window.

Under Windows 2000, Windows Server 2003 R2, or Windows NT 4.0, launch the [Printers] window,
and then open the printer properties.

18. Click the [NetWare setting] tab.

Under Windows Vista or Windows Server 2003 R2, on the [Printer Settings] tab, clear the [Form
Feed] and [Enable Banner] check boxes.

Do not select these check boxes since they are automatically selected by the printer driver. If you
select the check boxes, the printer may not print correctly.

19. Click [OK] to close the printer properties dialog box.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• To stop installation of the selected software, click [Cancel] before installation is complete.

• The protocol is set to inactive as default. Enable it using Web Image Monitor or Telnet

When using the PostScript 3 Printer Driver

Follow the procedure below to set up the PostScript 3 printer driver.

• In an IPv6 environment, Netware servers cannot be used.

1. In the [Printers] or [Printers and Faxes] window, open the printer properties.
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2. Click the [PostScript] tab.

When using Windows 2000/XP/Vista, Windows Server 2003/2003 R2, or Windows NT 4.0 click
the [Device Settings] tab, and then proceed to step to clear the check box.

3. Click [Advanced].

4. Clear the [Send CTRL+D before job] and [Send CTRL+D after job] check boxes, and then click
[OK].

5. Click [OK] to close the printer properties dialog box.

Form Feed

Do not use NetWare to configure form feed. Form feed is controlled by the printer driver on Windows. If
NetWare form feed is configured, the printer may not print properly.

Follow the procedure below to disable form feed according to the operating system used:

• Under Windows 95/98/Me, clear the [Form feed] check box on the [Printer Settings] tab in the
printer properties box.

• Under Windows 2000/XP/Vista, Windows Server 2003/2003 R2, or Windows NT 4.0 clear the
[Form feed] check box on the [NetWare Settings] tab in the printer properties dialog box.

Banner Page

Do not use NetWare to configure a banner page.

Follow the procedure below to disable banner pages according to the operating system used:

• Under Windows 95/98/Me, clear the [Enable banner] check box on the [Printer Settings] tab in the
printer properties dialog box.

• Under Windows 2000/XP/Vista, Windows Server 2003/2003 R2, or Windows NT 4.0 clear the
[Enable banner] check box on the [NetWare Settings] tab in the printer properties dialog box.

Printing after Resetting the Printer

Printer to print server connection requires 30 - 40 seconds to resume after the printer is reset. During this
period, jobs may be accepted (depending on NetWare specifications) but not printed.

To print after resetting the printer as the remote printer, check on the print server that the remote printer is
disconnected, or wait for two minutes before trying to print.
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Installing the Printer Driver Using USB
This section explains how to install printer drivers using USB.

Before installing, check that only the operating system is running on the computer and no print jobs are in
progress.

The printer drivers can be installed from the CD-ROM provided with this printer.

Windows Me - USB

• Installation via USB is not possible under Windows 95/98. Upgrade to Windows Me or later.

If the printer driver has already been installed, plug and play is enabled, and the icon of the printer
connected to the "USB" port is added to the [Printers] window.

When USB is first used, the plug and play function starts and the [New Hardware Found], [Device Driver
Wizard], or [Add New Hardware Wizard] dialog box appears, depending on the operating system.

1. Download USB Printing Support from the supplier's Web site.

Use a search to find the model name, and then download USB Printing Support from the supplier's
Web site.

Save it where you can locate it easily.

2. Check that the power of the printer is off.

3. Connect the printer and computer using the USB cable.

Connect the USB cable firmly.

4. Turn on the power of the printer.

The plug and play function starts and the [New Hardware Found], [Device Driver Wizard], or [Add
New Hardware Wizard] dialog box appears, depending on the operating system.

5. Select the [Specify a location:] check box, and then click [Browse...].

The [Browse for Folder] dialog box appears.

6. Specify the location where USB Printing Support is located, and then click [Next >].

7. Check the location, and then click [Next >].

USB Printing Support is installed.

8. Click Finish.

If the printer driver has already been installed, plug and play is enabled, and the icon of the printer
connected to the "USB001" port is added to the Printers window.

9. Insert the printer driver. Click [Search for the best driver for your device. [Recommended]],
and then click [Next >].
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10. Select the [Specify a location:] check box, and then click [Browse...].

The [Browse for Folder] dialog box appears.

11. Insert the CD-ROM into the CD-ROM drive.

When Auto Run starts, click [Exit].

12. Specify the location where USB Printing Support is located, and then click [Next >].

If the CD-ROM drive is D, the source files of USB Printing Support are stored in the following location:

• RPCS

D:\DRIVERS\RPCS\WIN9X_ME\(Language)\DISK1

• PCL 5c

D:\DRIVERS\PCL5C\WIN9X_ME\(Language)\DISK1

• PCL 6

D:\DRIVERS\PCL6\WIN9X_ME\(Language)\DISK1

• PostScript 3

D:\DRIVERS\PS\WIN9X_ME\(Language)\DISK1

13. Check the location, and then click [Next >].

Add Printer Wizard starts.

14. Click [Finish].

Installation is complete. If installation is successful, the icon of the printer connected to the "USB001"
port is added to the [Printers] window.

• The number after "USB" varies depending on the number of printers connected.

• It is not necessary to reinstall USB Printing Support when connecting a different printer via USB interface
when USB Printing Support is installed.

• After installing USB Printing Support, if the printer driver is not installed, follow the plug-and-play
instructions of the printer.

• Install the printer driver from the CD-ROM provided with the printer.

Windows 2000 - USB

• Installing a printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

If the printer driver has already been installed, plug and play is enabled, and the icon of the printer
connected to the "USB" port is added to the [Printers] window.
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If the printer driver is not installed, follow the plug-and-play instructions of the printer to install it from the
CD-ROM provided.

1. Check that the power of the printer is off.

2. Connect the printer and computer using the USB cable.

Connect the USB cable firmly.

3. Turn on the power of the printer.

Found New Hardware Wizard starts, and USB Printing Support is installed automatically.

4. In the Found New Hardware Wizard display, click [Search for a suitable driver for my device
[recommended]], and then click [Next >].

5. Select the [Specify location] check box, and then click [Next >].

6. Insert the CD-ROM into the CD-ROM drive.

When Auto Run starts, click [Exit].

7. Specify the location where the source files of the printer driver is stored.

If the CD-ROM drive is D, the source files of the printer driver are stored in the following location:

• RPCS

D:\DRIVES\RPCS\WIN2K_XP\(Language)\DISK1

• PCL 5c

D:\DRIVES\PCL5C\WIN2K_XP\(Language)\DISK1

• PCL 6

D:\DRIVES\PCL6\WIN2K_XP\(Language)\DISK1

• PostScript 3

D:\DRIVES\PS3\WIN2K_XP\(Language)\DISK1

8. Check the printer driver location, and then click [OK].

9. Click [Next >].

10. Click [Finish].

If the printer driver has already been installed, plug and play is enabled, and the icon of the printer
connected to the "USB001" port is added to the [Printers] window.

• To disable Auto Run, press the left Shift key when inserting the CD-ROM into the drive and keep it
pressed until the computer finishes reading from the CD-ROM.

• The number after "USB" varies depending on the number of printers connected.
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Windows XP, Windows Server 2003/2003 R2 - USB

• Installing a printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

If the printer driver has already been installed, plug and play is enabled, and the icon of the printer
connected to the "USB" port is added to the [Printers] window.

The printer drivers can be installed from the CD-ROM provided with this printer.

If the printer driver is not installed, follow the plug-and-play instructions of the printer to install it from the
CD-ROM provided.

1. Check that the power of the printer is off.

2. Connect the printer and computer using the USB cable.

Connect the USB cable firmly.

3. Turn on the power of the printer.

Found New Hardware Wizard starts, and USB Printing Support is installed automatically.

4. In the Found New Hardware Wizard display, click [Search for a suitable driver for my device
[recommended]], and then click [Next >].

5. Insert the CD-ROM into the CD-ROM drive.

If Auto Run starts, click [Cancel], and then [Exit].

6. Select the [Include this location in the search] check box under [Search for the best driver in
these location], and then click [Browse] to select the printer driver location.

If the CD-ROM drive is D, the source files of the printer driver are stored in the following location:

• RPCS

D:\DRIVES\RPCS\WIN2K_XP\(Language)\DISK1

• PCL 5c

D:\DRIVES\PCL5C\WIN2K_XP\(Language)\DISK1

• PCL 6

D:\DRIVES\PCL6\WIN2K_XP\(Language)\DISK1

• PostScript 3

D:\DRIVES\PS3\WIN2K_XP\(Language)\DISK1

7. Check the printer driver location, and then click [Next >].

8. Click [Continue].
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9. Click [Finish].

If installation is successful, the icon of the printer connected to the "USB001" port is added to the
[Printers and Faxes] window.

• To disable Auto Run, press the left Shift key when inserting the CD-ROM into the drive and keep it
pressed until the computer finishes reading from the CD-ROM.

• The number after "USB" varies depending on the number of printers connected.

Windows Vista - USB

• Installing a printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

If the printer driver has already been installed, plug and play is enabled, and the icon of the printer
connected to the "USB" port is added to the [Printers] window.

The printer drivers can be installed from the CD-ROM provided with this printer.

If the printer driver is not installed, follow the plug-and-play instructions of the printer to install it from the
CD-ROM provided.

1. Check that the power of the printer is off.

2. Connect the printer and computer using a USB cable.

Connect the USB cable firmly.

3. Turn on the power of the printer.

Found New Hardware Wizard starts, and USB Printing Support is installed automatically.

4. In the Found New Hardware Wizard display, click [Search for a suitable driver for my device
[recommended]], and then click [Next >].

5. Insert the CD-ROM into the CD-ROM drive.

If Auto Run starts, click [Cancel], and then [Exit].

6. Select the [Include this location in the search] check box under [Search for the best driver in
these location], and then click [Browse] to select the printer driver location.

If the CD-ROM drive is D, the source files of the printer driver are stored in the following locations:

• RPCS

D:\DRIVES\RPCS\WIN2K_XP\(Language)\DISK1

• PCL 5c

D:\DRIVES\PCL5C\WIN2K_XP\(Language)\DISK1

• PCL 6
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D:\DRIVES\PCL6\WIN2K_XP\(Language)\DISK1

• PostScript 3

D:\DRIVES\PS3\WIN2K_XP\(Language)\DISK1

7. Check the printer driver location, and then click [Next >].

8. Click [Continue].

9. Click [Finish].

If the installation is successful, the icon of the printer connected to the "USB001" port is added to the
[Printers and Faxes] window.

• To disable Auto Run, press the left Shift key when inserting the CD-ROM into the drive and keep it
pressed until the computer finishes reading from the CD-ROM.

• The number after "USB" varies depending on the number of printers connected.

Troubleshooting USB

Problem Solutions

The printer is not recognized automatically. Turn off the power of the printer, reconnect the USB
cable, and then turn it on again.

Windows has already configured the USB settings. Open Windows' Device Manager, and then,
under [Universal Serial Bus controllers], remove
any conflicting devices. Conflicting devices have a
[!] or [?] icon by them. Take care not to accidentally
remove required devices. For details, see Windows
Help.

When using Windows 2000/XP or Windows
Server 2003, an erroneous device is displayed
under [USB Controller] in the [Device Manager]
dialog box.

Windows ME and the printer cannot be connected. Download USB Printing Support from the supplier's
website.

Search the model name you use on the supplier's
website, and download USB Printing Support.
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Printing with Parallel Connection
To use a printer connected using a parallel interface, click [LPT1] when installing the printer driver.

The optional IEEE 1284 interface board must be installed on the printer.

Installing the PCL or RPCS Printer Driver

• To install this printer driver under Windows 2000/XP /Vista, Windows Server 2003/2003 R2, and
Windows NT 4.0, you must have an account that has Manage Printers permission. Log on as an
Administrators or Power Users group member.

• If you are using Windows 2000, you can install the printer driver from the CD-ROM provided with
this printer or download it from the supplier's Web site.

• If your operating system is Windows XP Pro x64, Windows Server 2003/2003 R2 x64, you must
download the printer driver from the manufacturer's Web site. Select this printer and the operating
system you are using, and then download it.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PCL/RPCS Printer Drivers].

5. The software license agreement appears in the [License Agreement] dialog box.

After reading the agreement, click [I accept the agreement], and then click [Next >].

6. Select a printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.

7. Click [Next >].

8. Select the printer models you want to use.

The printer name can be changed in the [Change settings for 'Printer Name'] box.

9. Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the operating system, printer
model, and port.

10. Check that [LPT1:] is shown in [Port:].

11. Select the [Default Printer] check box to configure the printer as default.
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12. Click [Finish].

The printer driver installation starts.

13. After the installation is completed, select one of the options to restart the computer either
now or later, and then click [Finish].

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• To stop installation of the selected software, click [Cancel] before installation is complete.

• A message appears if there is a newer version of the printer driver already installed. If there is, you
cannot install the printer driver using Auto Run. If you still want to install the printer driver, use [Add
Printer]. See p.72 "If a Message Appears during Installation".

Installing the PostScript 3 Printer Driver (Windows 95/98/Me)

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local Printer], and then click [Next >].

A dialog box for selecting the printer manufacturer and model name appears.

7. Select the name of the printer whose driver you want to install, and then click [Next >].

8. In the [Available ports:] box, click [Printer Port], and then click [Next >].

9. Change the printer name if you want, and then click [Next>].

Select the Yes check box to configure the printer as default.

10. Specify whether or not to print a test page, and then click [Finish].

11. Restart the computer to complete installation.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.
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• The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.

Installing the PostScript 3 Printer Driver (Windows 2000)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer], and then click [Next >].

A dialog box for selecting the printer manufacturer and model name appears.

7. Select [LPT1] at the [Printer Port] dialog box, and then click [Next >].

8. Select the name of the printer whose driver you want to install, and then click [Next >].

9. Select whether or not to share the printer, and then click [Next >].

10. Specify whether or not to print a test page, and then click [Finish].

The printer driver installation starts.

11. Restart the computer to complete installation.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows XP/Vista, Windows Server
2003/2003 R2)

• Installing this printer driver requires Administrators permission. Log on using an account that has
Administrators permission.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

5. Click [Next >].

6. Click [Local printer attached to this computer], and then click [Next >].

7. Select the port you want to use, and then click [Next >].

A dialog box for selecting the printer manufacturer and model name appears.

8. Select the name of the printer whose driver you want to install, and then click [Next >].

9. Click [Close] to close the [Printer Port] dialog box.

10. Click [Next >].

11. Change the printer name if you want, and then click [Next >].

12. Specify whether or not to print a test page, and then click [Finish].

The printer driver installation starts.

13. Restart the computer to complete installation.

• Auto Run may not work with certain operating system settings. If this happens, launch "Setup.exe" on
the CD-ROM root directory.

• The printer driver with the selected language will be installed. The English printer driver is installed
when the following language is selected: Cestina, Magyar, Polski, Portugues, Suomi.

• A user code can be set after the printer driver installation. For information about user code, see the
printer driver Help.
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Printing with Bluetooth Connection

Supported Profiles

SPP, HCRP

• A maximum of two Bluetooth adaptor or Bluetooth-equipped computers can be connected at
the same time using the Bluetooth interface: one by SPP, one by HCRP.

• When connecting more than one Bluetooth adaptor or Bluetooth-equipped computer at the same
time, the first device that establishes connection is selected. When selecting the connection
between the other devices, cancel the first established connection.

• Conditions for bidirectional communications

• SPP connection does not support bidirectional communications.

• HCRP connection supports bidirectional communications.

BIP

• For BIP connection, a module including PostScript 3 must be installed in the printer.

• Only one Bluetooth adaptor or Bluetooth-equipped computer can be connected via BIP.

• Only JPEG images that can be printed using BIP.

• User Codes are disabled for BIP.

• You cannot print if print functions are restricted.

• Some printers do not support BIP.

• In this manual, the instruction referred to print using SPP. To print using HCRP or BIP, see the Help
supplied with the Bluetooth adapter you use.

Printing with Bluetooth Connection

To install the printer driver, follow the procedure used to install parallel interface.

• To install the printer driver under Windows 2000/XP Professional/Vista, Windows Server
2003/2003 R2, and Windows NT 4.0, you must have an account that has Manage Printers
permission. Log on as an Administrators or Power Users group member.

1. Start 3Com Bluetooth Connection Manager.

2. Check that the printer you want to use appears in 3Com Bluetooth Connection Manager.

3. On the [Tool] menu, click [COM port].
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4. Check that the message "Bluetooth Serial Client (COMx) " appears under Client Ports. (X
indicates the COM port number used by Bluetooth.)

5. Click [Close].

6. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

7. Click the icon of the printer you want to use.

8. On the [File] menu, click [Properties].

9. Click the [Ports] tab.

10. Under [Port], select the [COMx:] check box. X indicates the COM port number used by
Bluetooth.

11. Click [OK].

Close the [Printers] window.

• System requirements vary depending on the Bluetooth standard and specifications. For details, see
the manuals provided with each product.

• For information about setting up Bluetooth under other operating systems or using it with different
utilities, see the manuals provided with those operating systems or utilities.

• To always use the same printer, select the [Always use for this connection] check box.

• If a dialog box appears while transmitting a print job, reestablish network connection as follows:

1. Select the printer you want to use in the [Printers and Faxes] box.

2. Click [Connect].

• For details, see the manuals provided with the Bluetooth adaptor or computer equipped with
Bluetooth.

Configuring Security Mode Settings

This describes how to configure the security mode settings.

1. Start 3Com Bluetooth Connection Manager.

2. On the [Tools] menu, click [Security Mode].

The [Security Mode] dialog box appears.

3. Select the security mode in the [Security Mode:] list.

If you click [High], or [Custom], and specify [Link] in the [Custom Settings] dialog box, enter the
Bluetooth password. For information about entering the password, see p.71 "Printing in the Security
Mode".
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For all other security modes and custom settings, no password is required.

For information about each mode, see the manuals provided with the utility.

4. Click [OK].

Close the [Security Mode] dialog box.

• For details about the security mode, see 3Com Bluetooth Connection Manager Help. For details about
the password entry which is required to transmit print jobs, see the following section.

Printing in the Security Mode

This describes how to print in the security mode.

1. Send the print job to the printer in use.

Depending on the computer configuration, the [Connect] dialog box may appear. If it does, use it to
establish the network connection.

The [Authentication] dialog box appears.

2. Enter the Bluetooth password, and then click [OK].

As the Bluetooth password, enter the last four digits of the printer's serial number. You can find the
serial number on the label on the back of the printer. For example, if the serial number is
00A0-001234, the Bluetooth password is 1234.

3. The print job is sent.

• The Bluetooth password differs for each printer and cannot be changed.
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If a Message Appears during Installation
Message number 58 or 34 indicates the printer driver cannot be installed using Auto Run. Install the printer
driver using [Add Printer] or [Install Printer].

For Windows 95/98/Me, Windows 2000 and Windows NT 4.0:

1. On the Start menu, point to [Settings], and then click [Printers].

2. Double-click the Add Printer icon.

3. Follow the instructions in Add Printer Wizard.

• If the printer driver is on a CD-ROM, the location of the RPCS printer driver is either \DRIVERS\RPCS
\WIN9X_ME, or \DRIVERS\RPCS\WIN2K_XP. If the installer starts, click [Cancel] to quit.

For Windows XP Professional and Windows Server 2003/2003 R2:

1. On the Start menu, click [Printers and Faxes].

2. Click [Add a printer].

3. Follow the instructions in Add Printer Wizard.

• If the printer driver is on a CD-ROM, the location of the RPCS printer driver is \DRIVERS\RPCS
\WIN2K_XP. If the installer starts, click [Cancel] to quit.

For Windows XP Home Editions:

1. On the Start menu, click [Control Panel].

2. Click [Printers and Other Hardware].

3. Click [Printers and Faxes].

4. Click [Install Printer].

5. Follow the instructions in Add Printer Wizard.

• If the printer driver is on a CD-ROM, the location of the RPCS printer driver is \DRIVERS\RPCS
\WIN2K_XP. If the installer starts, click [Cancel] to quit.

For Windows Vista:

1. On the [Start] menu, click [Control Panel].

2. Click [Hardware and Sound].

3. Click [Printers].
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4. Click [Add a printer].

5. Follow the instructions in Add Printer Wizard.

If the printer driver is on a CD-ROM, the location of the driver is \DRIVERS\(RPCS, PCL6, or PCL5C)
\WIN2K_XP\(language)\DISK1. If the installer starts, click [Cancel] to quit.

6. Specify a port.

• Available ports vary according to your Windows operating system or the type of interface. For details,
see "Using the SmartDeviceMonitor Port", "Using the Standard TCP/IP Port", "Using the LPR Port".

• p.23 "Using the SmartDeviceMonitor Port"

• p.40 "Using the Standard TCP/IP Port"

• p.45 "Using the LPR Port"
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Making Option Settings for the Printer
Make option settings for the printer using the printer driver when bidirectional communication is disabled.

Conditions for Bidirectional Communication

Bidirectional communication allows information about paper size and feed direction settings to be
automatically sent to the printer. You can check printer status from your computer.

• Bidirectional communication is supported by Windows 95/98/Me/2000/XP/Vista, Windows
Server 2003/2003 R2, and Windows NT 4.0.

• If you use the RPCS printer driver and bidirectional communication is enabled under Windows 2000,
the [Change Accessories] tab is unavailable.

• The RPCS printer driver supports bidirectional communications and updates the printer status
automatically.

• The PCL printer driver supports bidirectional communications. You can update printer status manually.

• The PostScript 3 printer driver does not support bidirectional communications.

To support bidirectional communication, the following conditions must be met:

When connected with parallel cables

• The computer must support bidirectional communication.

• The printer must support bidirectional communication.

• The interface cable must support bidirectional communication.

• The printer must be connected to the computer using the standard parallel cables and parallel
connectors.

• Under Windows 2000, [Enable bidirectional support] must be selected, and [Enable printer
pooling] must not be selected on the [port] tab with the RPCS printer driver.

When connected with the network

• The printer must support bidirectional communication.

• SmartDeviceMonitor for Client included on the CD-ROM must be installed, and TCP/IP must be
used.

• Under Windows 2000/XP/Vista and Windows Server 2003/2003 R2, [Enable bidirectional
support] must be selected, and [Enable printer pooling] must not be selected on the [port] tab
with the RPCS printer driver.

• In addition to the above, one of the following conditions must also be met:

• The SmartDeviceMonitor for Client port and the TCP/IP protocol must be used.
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• The standard TCP/IP port must be used without changing the default port name (for
Windows 2000/XP/Vista and Windows Server 2003/2003 R2).

• Microsoft TCP/IP print IPv4 address must be specified for use (for Windows NT 4.0).

• IPP port name must include the IPv4 address when using the IPP protocol.

When connected with USB

The printer must be connected to the computer's USB port using the USB interface cable.

The computer must support bidirectional communication.

• Install SmartDeviceMonitor for Client from the CD-ROM provided.

If Bidirectional Communication is Disabled

Set up option settings when bidirectional communications are disabled.

• Under Windows 2000/XP/Vista and Windows Server 2003/2003 R2, Manage Printers permission
is required to change the printer properties in the [Printers] folder. Log on as an Administrators or
Power Users group member.

• Under Windows NT 4.0, Full Control permission is required to change the printer properties in the
[Printers] folder. Log on as an Administrators or Power Users group member.

1. On the Start menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

When using Windows 2000, point to [Settings] on the [Start] menu, and then click [Printers]. The
[Printers] window appears.

When using Windows Vista, click [Control Panel] on the [start] menu, and then click [Printer]. The
[Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the File menu, click [Properties].

When using Windows Vista, right-click the icon of the printer you want to use, and then click the
[Properties].

4. Click the [Change Accessories] tab.

If options in the [Change Accessories] tab are disabled, bidirectional connection is enabled. In this
case, no change is necessary for option settings.

If you are using the RPCS printer driver, click the [Change Accessories] tab.

If you are using the PS printer driver, click the [Device Settings] tab.

5. Select options installed from the Option area, and then make the necessary settings.

Making Option Settings for the Printer
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6. Select the total amount of the memory in [Total Memory:], when the optional SDRAM module
is added.

7. Under [Paper source tray settings:], click and highlight the tray to be used, and then select
the appropriate size, position, and type for the tray. Select the [Tray locking] check box to
exclude the tray from the targets of automatic tray selection.

8. Click [OK] to close the printer properties dialog box.
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2. Setting Up the Printer Driver

PCL - Accessing the Printer Properties

Windows 95/98/Me - Accessing the Printer Properties

There are two methods to open the [Printer Properties] dialog box.

Making Printer Default Settings

To make the printer default settings, open the [Printer Properties] dialog box from the [Printers] window.

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

4. Make the necessary settings, and then click [OK].

• With some applications, the printer driver settings are not used, and the application's own default
settings are applied.

• For details about settings, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application. To make printer settings for a specific application,
open the [Printer Properties] dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 95/98/Me.

1. On the [File] menu, click [Print].

The [Print] dialog box appears.

2. Select the printer you want to use in the [Name] list, and then click [Properties].

The [Printer Properties] dialog box appears.
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3. Make the necessary settings, and then click [OK].

4. Click [OK] to start printing.

• The procedure to open the [Printer Properties] dialog box may vary depending on the application.
For details, see the manuals provided with the application you use.

• With some applications, the printer driver settings are not used, and the application's own default
settings are applied.

• Any settings you make in the following procedure are valid for the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used as defaults when printing from this application.

• For details about settings, see the printer driver Help.

Windows 2000 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

• To change the printer default settings including option configuration settings, log on using an account
that has Manage Printers permission. Members of the Administrators and Power Users groups have
Manage Printers permission by default.

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• Do not make a setting for [Form to Tray Assignment].

• For details about settings, see the printer driver Help.
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Making Printer Default Settings - Printing Preferences

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• For details about settings, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application. To make printer settings for a specific application,
open the [Printing Preferences] dialog box from that application. The following explains how to make
settings for the WordPad application provided with Windows 2000.

1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. Select the printer you want to use in the [Select Printer] list.

3. Make the necessary settings, and then click [Print] to start printing.

• The procedure to open the [Printing Preferences] dialog box may vary depending on the application.
For details, see the manuals provided with the application you use.

• Any settings you make in the following procedure are valid for the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used as defaults when printing from this application.

• For details about settings, see the printer driver Help.

PCL - Accessing the Printer Properties
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Windows XP, Windows Server 2003/2003 R2 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

• To change the printer default settings including option configuration settings, log on using an account
that has Manage Printers permission. Members of the Administrators and Power Users groups have
Manage Printers permission by default.

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• Do not make a setting for [Form to Tray Assignment].

• For details about settings, see the printer driver Help.

Making Printer Default Settings - Printing Preferences

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

4. Make the necessary settings, and then click [OK].
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• Settings you make here are used as the default settings for all applications.

• For details about settings, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application. To make printer settings for a specific application,
open the [Printing Preferences] dialog box from that application. The following explains how to make
settings for the WordPad application provided with Windows XP

1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. Select the printer you want to use in the [Select Printer] list, and then click [Preferences].

3. Make the necessary settings, and then click [Print] to start printing.

• The procedure to open the [Printing Preferences] dialog box may vary depending on the application.
For details, see the manuals provided with the application you use.

• Any settings you make in the following procedure are valid for the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used as defaults when printing from this application.

• For details about settings, see the printer driver Help.

Windows Vista - Accessing the Printer Properties

Making printer default settings - the printer properties

• To change the printer's default settings (including settings for options), log on using an account that
has Manage Printers permission. Members of the Administrators group have Manage Printers
permission by default.

• You cannot change the printer default settings for individual users. Settings made in the [Printer
Properties] dialog box are applied to all users.

1. On the [Start] menu, click [Control Panel].

The [Control Panel] window appears.

PCL - Accessing the Printer Properties
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2. In "Hardware and Sound", click [Printer].

3. Right-click the icon of the printer you want to use, and then click [Properties].

The [Printer Properties] dialog box appears.

4. Make the settings you require, and then click [OK].

• The settings you make here are used as the default settings for all applications.

• For details, see the printer driver Help.

Making printer default settings - printing preferences

• You cannot change the printer default settings for individual users. Settings made in the [Printing
Preferences] dialog box are applied to all users.

1. On the [Start] menu, click [Control Panel].

The [Control Panel] window appears.

2. In "Hardware and Sound", click [Printer].

3. Right click the icon of the printer you want to use, and then click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

4. Make the settings you require, and then click [OK].

• The settings you make here are used as the default settings for all applications.

• For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences] dialog box from that
application. The following procedure explains how to make printer settings for a specific application using
Windows Vista Wordpad as an example.

1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. In the [Select Printer] list, select the printer you want to use.

3. Click [Preferences].

The [Printing Preferences] dialog box appears.
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4. Make the settings you require, and then click [OK].

• Procedures for opening the [Printing Preferences] dialog box vary depending on the application. For
details, see the manuals provided with the application.

• Any settings you make using this procedure apply to the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used the defaults when printing from the application.

• For details, see the printer driver Help.

Windows NT 4.0 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

• To change the printer default settings including option configuration settings, log on using an account
that has Full Control permission. Members of the Administrators, Server Operators, Print Operators,
and Power Users groups have Full Control permission by default.

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• Do not make a setting for [Form to Tray Assignment].

• For details about settings, see the printer driver Help.
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Making Printer Default Settings - Default

• To change the printer default settings including option configuration settings, log on using an account
that has Full Control permission. Members of the Administrators, Server Operators, Print Operators,
and Power Users groups have Full Control permission by default.

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Document Defaults...].

The [Default] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• For details about settings, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application. To make printer settings for a specific application,
open the [Printer Properties] dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows NT 4.0.

1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. Select the printer you want to use in the [Name] list, and then click [Properties].

The [Printer Properties] dialog box appears.

3. Make the necessary settings, and then click [OK].

4. Click [OK] to start printing.

• The procedure to open the [Printer Properties] dialog box may vary depending on the application.
For details, see the manuals provided with the application you use.

• With some applications, the printer driver settings are not used, and the application's own default
settings are applied.
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• Any settings you make in the following procedure are valid for the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used as defaults when printing from this application.

• For details about settings, see the printer driver Help.

PCL - Accessing the Printer Properties

85

2



RPCS - Accessing the Printer Properties

Windows 95/98/Me - Accessing the Printer Properties

There are two dialog box types of the [Printer Properties] dialog box. "Multi-tab" is used as an example in
this manual. For details about changing the dialog box types, see the printer driver Help.

Multi-tab

This dialog box type is designed for users who often change print settings to perform various printing
operations.

Custom Setting

This dialog box type is designed for users who rarely change print settings. This type of dialog box
may vary depending on the installed options.

Making Printer Default Settings

To make the printer default settings, open the [Printer Properties] dialog box from the [Printers] window.

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

When you open the [Printer Properties] dialog box initially after installing the RPCS printer driver, a
confirmation message appears. After clicking [OK], the [Printer Properties] dialog box appears.

4. Make the necessary settings, and then click [OK].

• With some applications, the printer driver settings are not used, and the application's own default
settings are applied.

• For details about settings, see the printer driver Help.

2. Setting Up the Printer Driver

86

2



Making Printer Settings from an Application

You can make printer settings for a specific application. To make printer settings for a specific application,
open the [Printer Properties] dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 95/98/Me.

1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. Select the printer you want to use in the [Name:] list, and then click [Properties...].

The [Printer Properties] dialog box appears.

3. Make the necessary settings, and then click [OK].

4. Click [OK] to start printing.

• The procedure to open the [Printer Properties] dialog box may vary depending on the application.
For details, see the manuals provided with the application you use.

• With some applications, the printer driver settings are not used, and the application's own default
settings are applied.

• Any settings you make in the following procedure are valid for the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used as defaults when printing from this application.

• For details about settings, see the printer driver Help.

Windows 2000 - Accessing the Printer Properties

This describes how to launch printer driver's properties.

Making Printer Default Settings - The Printer Properties

• To change the printer default settings including option configuration settings, log on using an account
that has Manage Printers permission. Members of the Administrators and Power Users groups have
Manage Printers permission by default.

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.
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2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

When you open the [Printer Properties] dialog box initially after installing the RPCS printer driver, a
confirmation message appears. After clicking [OK], the [Printer Properties] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• Do not make a setting for [Form to Tray Assignment].

• For details about settings, see the printer driver Help.

Making Printer Default Settings - Printing Preferences

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• For details about settings, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application. To make printer settings for a specific application,
open the [Printing Preferences] dialog box from that application. The following explains how to make
settings for the WordPad application provided with Windows 2000.
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1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. Select the printer you want to use in the [Select Printer] list.

3. Make the necessary settings, and then click [Print] to start printing.

• The procedure to open the [Printing Preferences] dialog box may vary depending on the application.
For details, see the manuals provided with the application you use.

• Any settings you make in the following procedure are valid for the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used as defaults when printing from this application.

• For details about settings, see the printer driver Help.

Windows XP, Windows Server 2003/2003 R2 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

• To change the printer default settings including option configuration settings, log on using an account
that has Manage Printers permission. Members of the Administrators and Power Users groups have
Manage Printers permission by default.

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

When you open the [Printer Properties] dialog box initially after installing the RPCS printer driver, a
confirmation message appears. After clicking [OK], the [Printer Properties] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• Do not make a setting for [Form to Tray Assignment].
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• For details about settings, see the printer driver Help.

Making Printer Default Settings - Printing Preferences

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• For details about settings, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application. To make printer settings for a specific application,
open the [Printing Preferences] dialog box from that application. The following explains how to make
settings for the WordPad application provided with Windows XP.

1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. Select the printer you want to use in the [Select Printer] list.

3. Make the necessary settings, and then click [Print] to start printing.

• The procedure to open the [Printing Preferences] dialog box may vary depending on the application.
For details, see the manuals provided with the application you use.

• Any settings you make in the following procedure are valid for the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used as defaults when printing from this application.
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• For details about settings, see the printer driver Help.

Windows Vista - Accessing the Printer Properties

Making printer default settings - the printer properties

• To change the printer's default settings (including settings for options), log on using an account that
has Manage Printers permission. Members of the Administrators group have Manage Printers
permission by default.

• You cannot change the printer default settings for individual users. Settings made in the [Printer
Properties] dialog box are applied to all users.

1. On the [Start] menu, click [Control Panel].

The [Control Panel] window appears.

2. In "Hardware and Sound", click [Printer].

3. Right click the icon of the printer you want to use, and then click [Properties].

The [Printer Properties] dialog box appears.

When you open the [Printer Properties] dialog box for the first time after installing the RPCS printer
driver, a confirmation message appears. After you click [OK], the [Printer Properties] dialog box
appears.

4. Make the settings you require, and then click [OK].

• The settings you make here are used as the default settings for all applications.

• For details, see the printer driver Help.

Making printer default settings - printing preferences

• You cannot change the printer default settings for individual users. Settings made in the [Pinter
Preferences] dialog box are applied to all users.

1. On the [Start] menu, click [Control Panel].

The [Control Panel] window appears.

2. Click [Printer] in "Hardware and Sound".
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3. Right-click the icon of the printer you want to use, and then click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

4. Make the settings you require, and then click [OK].

• The settings you make here are used as the default settings for all applications.

• For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences] dialog box from that
application. The following procedure explains how to make printer settings for a specific application using
Windows Vista Wordpad as an example.

1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. In the [Select Printer] list, select the printer you want to use.

3. Click [Preferences].

The [Printing Preferences] dialog box appears.

4. Make the settings you require, and then click [OK].

• Procedures for opening the [Printing Preferences] dialog box vary depending on the application. For
details, see the manuals provided with the application.

• Any settings you make using this procedure apply to the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used the defaults when printing from the application.

• For details, see the printer driver Help.

Windows NT 4.0 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

• To change the printer default settings including option configuration settings, log on using an account
that has Full Control permission. Members of the Administrators, Server Operators, Print Operators,
and Power Users groups have Full Control permission by default.

2. Setting Up the Printer Driver
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• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

The printer properties dialog box appears.

When you open the printer properties dialog box initially after installing the RPCS printer driver, a
confirmation message appears. After clicking [OK], the [Printer Properties] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• Do not make a setting for [Form to Tray Assignment].

• For details about settings, see the printer driver Help.

Making Printer Default Settings - Default

• To change the printer default settings including option configuration settings, log on using an account
that has Full Control permission. Members of the Administrators, Server Operators, Print Operators,
and Power Users groups have Full Control permission by default.

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Document Defaults...].

The [Default] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• For details about settings, see the printer driver Help.
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Making Printer Settings from an Application

You can make printer settings for a specific application. To make printer settings for a specific application,
open the [Printer Properties] dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows NT 4.0.

1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. Select the printer you want to use in the [Name] list, and then click [Properties].

The [Printer Properties] dialog box appears.

3. Make the necessary settings, and then click [OK].

4. Click [OK] to start printing.

• The procedure to open the [Printer Properties] dialog box may vary depending on the application.
For details, see the manuals provided with the application you use.

• With some applications, the printer driver settings are not used, and the application's own default
settings are applied.

• Any settings you make in the following procedure are valid for the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used as defaults when printing from this application.

• For details about settings, see the printer driver Help.
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PostScript 3 - Setting Up for Printing

Windows 95/98/Me - Accessing the Printer Properties

There are two methods to open the [Printer Properties] dialog box.

Making Printer Default Settings

To make the printer default settings, open the [Printer Properties] dialog box from the [Printers] window.

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

4. Make the necessary settings, and then click [OK].

• With some applications, the printer driver settings are not used, and the application's own default
settings are applied.

• For details about settings, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application. To make printer settings for a specific application,
open the [Printer Properties] dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 95/98/Me.

1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. Select the printer you want to use in the [Name...] list, and then click [Properties...].

The [Printer Properties] dialog box appears.

3. Make the necessary settings, and then click [OK].
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4. Click [OK] to start printing.

• The procedure to open the [Printer Properties] dialog box may vary depending on the application.
For details, see the manuals provided with the application you use.

• With some applications, the printer driver settings are not used, and the application's own default
settings are applied.

• Any settings you make in the following procedure are valid for the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used as defaults when printing from this application.

• For details about settings, see the printer driver Help.

Windows 2000 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

• To change the printer default settings including option configuration settings, log on using an account
that has Manage Printers permission. Members of the Administrators and Power Users groups have
Manage Printers permission by default.

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• Do not make a setting for [Form to Tray Assignment].

• For details about settings, see the printer driver Help.

2. Setting Up the Printer Driver

96

2



Making Printer Default Settings - Printing Preferences

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• For details about settings, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application. To make printer settings for a specific application,
open the [Printing Preferences] dialog box from that application. The following explains how to make
settings for the WordPad application provided with Windows 2000.

1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. Select the printer you want to use in the [Select Printer] list.

3. Make the necessary settings, and then click [Print] to start printing.

• The procedure to open the [Printing Preferences] dialog box may vary depending on the application.
For details, see the manuals provided with the application you use.

• Any settings you make in the following procedure are valid for the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used as defaults when printing from this application.

• For details about settings, see the printer driver Help.

PostScript 3 - Setting Up for Printing

97

2



Windows XP, Windows Server 2003/2003 R2 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

• To change the printer default settings including option configuration settings, log on using an account
that has Manage Printers permission. Members of the Administrators and Power Users groups have
Manage Printers permission by default.

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• Do not make a setting for [Form to Tray Assignment].

• For details about settings, see the printer driver Help.

Making Printer Default Settings - Printing Preferences

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

4. Make the necessary settings, and then click [OK].
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• Settings you make here are used as the default settings for all applications.

• For details about settings, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application. To make printer settings for a specific application,
open the [Printing Preferences] dialog box from that application. The following explains how to make
settings for the WordPad application provided with Windows XP.

1. On the [File] menu, click [Print...].

The [Print] dialog box appears.

2. Select the printer you want to use in the [Select Printer] list.

3. Make the necessary settings, and then click [Print] to start printing.

• The procedure to open the [Printing Preferences] dialog box may vary depending on the application.
For details, see the manuals provided with the application you use.

• Any settings you make in the following procedure are valid for the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used as defaults when printing from this application.

• For details about settings, see the printer driver Help.

Windows Vista - Accessing the Printer Properties

Making printer default settings - the printer properties

• To change the printer default settings including option configuration settings, log on using an account
that has Full Control permission. Members of the Administrators, Server Operators, Print Operators,
and Power Users groups have Full Control permission by default.

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.
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2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• Do not make a setting for [Form to Tray Assignment].

• For details about settings, see the printer driver Help.

Making printer default settings - default

• To change the printer default settings including option configuration settings, log on using an account
that has Full Control permission. Members of the Administrators, Server Operators, Print Operators,
and Power Users groups have Full Control permission by default.

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Document Defaults...].

The [Default] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• For details about settings, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application. To make printer settings for a specific application,
open the [Printer Properties] dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows Vista.

1. On the [File] menu, click [Print].

The [Print] dialog box appears.
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2. Select the printer you want to use in the [Name:] list, and then click [Properties].

The [Printer Properties] dialog box appears.

3. Make the necessary settings, and then click [OK].

4. Click [OK] to start printing.

• The procedure to open the [Printer Properties] dialog box may vary depending on the application.
For details, see the manuals provided with the application you use.

• With some applications, the printer driver settings are not used, and the application's own default
settings are applied.

• Any settings you make in the following procedure are valid for the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used as defaults when printing from this application.

• For details about settings, see the printer driver Help.

Windows NT 4.0 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

• To change the printer default settings including option configuration settings, log on using an account
that has Full Control permission. Members of the Administrators, Server Operators, Print Operators,
and Power Users groups have Full Control permission by default.

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• Do not make a setting for [Form to Tray Assignment].
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• For details about settings, see the printer driver Help.

Making Printer Default Settings - Default

• To change the printer default settings including option configuration settings, log on using an account
that has Full Control permission. Members of the Administrators, Server Operators, Print Operators,
and Power Users groups have Full Control permission by default.

• You cannot change the printer default settings for each user. Settings made in the [Printer Properties]
dialog box are applied to all users.

1. On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

2. Click the icon of the printer you want to use.

3. On the [File] menu, click [Document Defaults...].

The [Default] dialog box appears.

4. Make the necessary settings, and then click [OK].

• Settings you make here are used as the default settings for all applications.

• For details about settings, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application. To make printer settings for a specific application,
open the [Printer Properties] dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows NT 4.0.

1. On the [File] menu, click [Print].

The [Print] dialog box appears.

2. Select the printer you want to use in the [Name:] list, and then click [Properties].

The [Printer Properties] dialog box appears.

3. Make the necessary settings, and then click [OK].

4. Click [OK] to start printing.
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• The procedure to open the [Printer Properties] dialog box may vary depending on the application.
For details, see the manuals provided with the application you use.

• With some applications, the printer driver settings are not used, and the application's own default
settings are applied.

• Any settings you make in the following procedure are valid for the current application only.

• General users can change the properties displayed in the [Print] dialog box of an application. Settings
made here are used as defaults when printing from this application.

• For details about settings, see the printer driver Help.

Mac OS - Setting Up for Printing

Making Paper Settings from an Application

1. Open the file you want to print.

2. On the [File] menu, click [Page Setup].

3. Check that the printer you want to use is displayed in [Printer:], and then select the paper
size you want to use in [Paper:].

Under Mac OS X, select the paper size in [Paper Size].

If the printer you want to use is not displayed in [Printer:], select the printer you want to use.

4. Configure the settings, and then click [OK].

• The [Page Setup] dialog box varies depending on the application you use. For details, see the manuals
provided with the Mac OS.

Setting up for Printing from an Application

1. Open the file you want to print.

2. On the [File] menu, click [Print].

3. Check that the printer is selected in the [Printer] list, and then make the printer settings.

4. Configure the settings, and then click [OK].
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3. Other Print Operations

Printing a PDF File Directly
You can send PDF files directly to this printer for printing, without having to open a PDF application.

• The function can be used with genuine Adobe PDF files only.

• This function supports version 1.3, 1.4, and 1.5 PDF files.

• Transparency (function of PDF version 1.4) may not be printed.

• PDF files created using Crypt Filter and/or the 16bit color image function of PDF version 1.5 cannot
be printed.

• PDF version 1.6 (Acrobat 7.0) files created without any functions that are exclusive to PDF version
1.6 can be printed.

• Some types of High Compression PDF files may not be printed.

• Paper size errors may occur when printing on custom size paper.

Printing Method

The following procedures explain the two methods of direct PDF printing - using DeskTopBinder Lite or by
entering commands.

Using DeskTopBinder Lite

Installing DeskTopBinder Lite

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

4. Click [DeskTopBinder - SmartDeviceMonitor for Client] , and then click [Next >].

5. Follow the instructions on the display to install DeskTopBinder Lite.

If you are required to restart the computer after installing DeskTopBinder Lite, restart the computer
and continue the configuration.
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• Auto Run may not work under certain operating system settings. In this case, launch "Setup.exe"
located on the CD-ROM root directory.

DeskTopBinder Lite Enhancements

1. On the [Start] menu, click [Programs], [DeskTopBinder], and [Extended Features Wizard].

2. When [Extended Features Wizard] appears, select [Start], and then click [Next >]
repeatedly until the [Printing Functions2] screen appears.

3. On the [Printing Functions2] screen, click [Add...] to display [PDF Direct Print Properties].

4. Select the driver for this printer, click [OK], and then click [Next >] repeatedly until [Finish]
is displayed.

Click [Finish].

Function Palette

1. Right-click the icon that is added to the task bar, and then click [Properties...] to display the
Properties screen.

2. Click the [Contents] tab, select the [PDF Direct Print] check box at the center, and then click
[OK].

The [Properties] screen closes and the [PDF Direct Print] icon is added to the palette.

• The Function palette contains buttons for functions that are already configured through DeskTopBinder
Lite enhancement. Using these buttons, you can print Windows files, preview printouts, convert images,
and register scanners for documents without having to open DeskTopBinder Lite. You can also use
these functions simply by dragging a target file to the button corresponding to the required function
and dropping it there.

PDF Direct Printing

1. Drag the PDF file you want to print to the PDF Direct Printing icon in the palette and drop it
there.

2. [Output File List - PDF Direct Print] is displayed.

Highlight the PDF you want to print, and then click [OK].

The PDF file is printed.

Printing PDF Password-Protected Documents

1. In the Windows [Start] menu, click [Programs], [DeskTopBinder], and [Extended Features
Wizard].
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2. When [Extended Features Wizard] appears, select [Start], and then click [Next >]
repeatedly until the [Printing Functions2] screen appears.

3. On the [Printing Functions2] screen, click [Properties...] to display [PDF Direct Print
Properties].

4. Select the [Use PDF Password] check box at the bottom right of the screen, and then click
[OK].

Click [Next>] repeatedly until [Finish] appears.

Click [Finish] to close the [Extended Features Wizard] screen.

5. Move the PDF file you want to print to the PDF Direct Printing icon on the palette using a
drag-and-drop operation.

6. [Output File List-PDF Direct Print] is displayed.

Select the PDF file you want to output to make it reverse video, and then click [OK].

7. The [PDF Direct Print Properties] screen opens.

Enter the password for the PDF file you want to print in the [PDF Password] field at the bottom right of
the screen, and then click [OK].

The password-protected PDF file is printed.

• Before printing a password-protected PDF file, perform one of the following:

• In the [PDF Direct Print Properties] dialog box, enter the password for the PDF file you want to
print

• Specify a password for the PDF file by selecting [Change PDF Password] in the [PDF Menu] on
the printer's control panel.

• If a [PDF Group Password] for the [PDF Menu] has been specified using DeskTopBinder Lite or the
printer's control panel, the same group password must be set on the other also.

Printing a PDF File Directly
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PDF Direct Print Properties
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1. Setting name:

Displays the plug-in configuration name (up to 63 single byte characters)

2. Change Icon...

Change the icon displayed on the tool bar.

3. Printer:

Displays a list of RPCS drivers that support PDF direct printing.

4. Duplex

Print on both sides of sheets.

5. Layout

Print multiple pages on a single sheet.

6. Punch

Punch holes in output sheets.

7. Staples

Staple together output sheets.

8. Display this dialog box before printing

Appears in PDF direct printing mode if this check box is selected.

9. Orientation

Specify the original's orientation.

10. Number of copies

Specify the number of copies to print.

11. Collate

Use to sort prints.

12. Range

Specify the print area on each page.

3. Other Print Operations

108

3



13. Resolution

Specify a print resolution.

14. PDF Password:

If the PDF file is password-protected, enter the password in this field. Otherwise, the file cannot be printed.

15. Group Password:

If a group password is assigned to DeskTopBinder Lite and this printer, enter the group password in this field.
Otherwise, printing cannot start.

Using Commands

Under Windows and UNIX, you can print PDF files directly, using commands such as "ftp" "sftp" and
"lpr".

• For details about printing using commands under Windows, see p.317 "Printing Files Directly from
Windows".

• For details about UNIX commands, see UNIX Supplement.

Printing a PDF File Directly
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Unauthorized Copy Control
You can embed patterns and text under printed text to prevent unauthorized copying of the document.
Unauthorized Copy Control consists of two functions: [Data security of copying] and [Mask type:].

• This function is designed to discourage copying of confidential documents; it does not prevent
unauthorized use of information.

Opening the Unauthorized Copy Control Window

1. In the RPCS printer driver, open the [Printing Preferences...] window.

2. Click [Add/Change Custom Settings...].

3. Select the [Unauthorized copy...] check box.

4. Click [Control Settings...].

5. A confirmation message appears. Click [OK].

The Unauthorized Copy Control window appears.

• For details, see the printer driver Help.

Using [Data security for copying]

You can embed a pattern by setting it in the printer driver.

Setting [Data security for copying] in the printer driver

• Select the [Data security for copying] checkbox. You can also enter the text in the [Text:] box.

• You cannot select the [Mask type:] checkbox at the same time.

• To print a document protected by gray overprint, the printer must be set up correctly. Consult an
administrator.
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Printing and copying a document using [Data security for copying]

AJL030S
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1. The pattern and text you have set is printed.

2. The document is copied in copiers/multifunction machines which the supplier's optional Copy
Data Security unit is installed.

3. The document is blanked by gray overprint.

• When printing a document that is set with [Data security for copying], the printer does not require the
optional Copy Data Security unit to be installed. The Copy Data Security unit is required when copying
or storing a document protected by gray overprint.

• Only the RPCS printer driver is supported.

• You cannot partially embed a pattern and text in a document.

• Use 182 × 257 mm (71/4×101/2 in.) or larger paper.

• Use ordinary or recycled paper of at least 70% whiteness.

• Duplex printing may interfere with this function as a result of text and patterns being visible through
the paper.

• The optional Copy Data Security Unit is for the supplier's copiers/multifunction machines. It cannot
be installed on this printer.

• For details about setting [Data security for copying], see the printer driver Help.
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Using [Mask type:]

You can embed patterns and text in a document by setting in the printer driver to prevent unauthorized
copying.

Setting [Mask type:] in the printer driver

• Select a pattern from [Mask type:], and then enter text in the [Text:] box.

• You can select overprint color from [Black], [Cyan], or [Magenta] in the [Color:] list.

• You can set only [Text:], but [Mask type:] and [Text:] must be set together.

Printing and copying a document using [Mask type:]

AJL031S

1. The pattern and text you have set is printed palely.

2. The document is copied in copiers/multifunction machines.

3. The pattern and text you have set appear clearly.

• Only the RPCS printer driver is supported.

• You cannot partially embed patterns and text strings in a document.

• To make the embedded pattern clear, set the character size at least 50 pt (preferably 70 to 80 pt)
and character angle to between 30 and 40 degrees.
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• Printing with background patterns and text may be slower than normal printing.

• For details about setting [Mask type:], see the printer driver Help.

Important Notice

• The supplier does not provide warranty regarding the appearance of print patterns and other copy
protection features. The appearance of the print patterns and the performance of Unauthorized Copy
Control may vary depending on the quality of paper used and the printer model and settings.

• The supplier takes no responsibility for any damages sustained in connection with use of or inability
to make use of Unauthorized Copy Control print patterns.
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Using the Print Job Function
This describes how to print or delete files stored in the printer. There are following types of print files: Sample
Print, Locked Print, Hold Print, and Stored Print.

Print files sent from computers can be stored in the hard disk of the printer. Using the Print Job function, you
can print or delete the print files.

Print Job screen

When the printer is turned on, the following screen appears.

If you press [Prt.Jobs] on the initial screen, a screen prompting to select the type of print job appears.

After selecting a type, you can select print files in the list by pressing:

• [Job List]

Displays the Job List screen.

• [User ID]

Displays the User ID screen.

If you select Sample Print, Locked Print, and Hold Print, the print files saved in the printer are deleted after
printing is complet. If you select Stored Print, the files remain in the printer even after printing is finished.

Job List Screen

AQC501S
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1. The type of print jobs

Displays the type of the print job you select.

2. Page number

Displays the current page number. Each time pressing the [ ] or [ ] key, the screen switches.

3. User ID, Date/Time, and File Name display

• User ID shows the user's ID set by the printer driver.

• Date and Time show the time at which the print job was stored in the printer.

• File name shows the name of the file. However, "****" is shown instead of the file name for a Locked Print
file.

4. [Print]

Prints a selected file.

5. [Change]

Changes or clears the password of a file if a password is set. To change the password of a Locked/Stored Print
job, press [Change], enter the current password, and then enter the new password on the confirmation screen.
To clear the password, press [Change], leave the entering/confirming a new password box blank, and then
press the [OK] key.

You can also set passwords to the Stored Print files that do not currently have passwords.

6. [Delete]

Deletes a selected file.

• When you press [Change] to change or clear a password, you must first enter the existing password.
If the password you entered is incorrect, you cannot change or clear any current passwords.

• You can use [Change] to set or clear passwords only Stored Print files are saved in the printer.

User ID Screen

AQC502S

1. The type of print jobs

Displays the type of the print job you select.

2. Page number

Displays the current page number. Each time pressing the [ ] or [ ] key, the screen switches.

3. User ID

• User ID shows the ID of the user who stored the selected type of files.

• User ID set by the printer driver is shown.
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4. [PrintAll]

Prints all files stored by the user whose user ID has been selected.

5. [Job List]

Switches the screen to the [Job List] screen.

Displays the print jobs of the selected user only.

• To cancel selecting a file, press the [Job Reset] key.

• The display is not updated if a new file is stored while the list of stored files is displayed. To update
the display, press the [Menu] key to return to the initial screen, and then press [Prt.Jobs] again.

• If a large number of print jobs are stored in the printer, processing may slow temporarily, depending
on which functions are used.

• For details about printing each type of print job, see the followings:

• p.117 "Sample Print"

• p.120 "Locked Print"

• p.123 "Hold Print"

• p.126 "Stored Print"
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Printing from the Print Job Screen
This section gives instruction about Sample Print, Locked Print, Hold Print, and Stored Print.

Sample Print

Use this function to print only the first set of a multiple-set print job. After you have checked the result,
remaining sets can be printed or canceled using the printer's control panel. This can reduce misprints due
to mistakes in content or settings.

• A Sample Print file cannot be stored if:

• the total number of Sample Print, Locked Print, Hold Print, and Stored Print files in the printer is
over 100. (The maximum number varies depending on the volume of data in files.)

• the file contains over 1,000 pages.

• sent or stored files in the printer contain over 9,000 pages in total.

• If a Sample Print file has not been stored properly, check the error log on the control panel.

• Even after you turn off the printer, stored documents in the printer remain. However, the [Auto Delete
Temporary Jobs] or [Auto Delete Stored Jobs] settings are applied first.

• If the application has a collate option, make sure it is not selected before sending a print job. By
default, Sample Print jobs are automatically collated by the printer driver. If a collate option is selected
from the application's Print dialog box, more prints than intended may be produced.

• If the first set of the Sample Print files is not as you expected and you do not want to print remaining
sets, delete the Sample Print file using the display panel. If you print the remaining sets of the Sample
Print file, the job in the printer is deleted automatically.

• Sample Print files printed or deleted using Web Image Monitor, after you select [Sample Print] using
the control panel will appear on the display panel. However, an error message will appear if you try
to print or delete those Sample Print files.

• If stored files have similar and long file names, recognizing the file you want to print on the display
panel may be difficult. Print the file you want to print either by checking the user ID or the time the file
is sent, or by changing the file name to something that can be recognized easily.

• For details about the error log on the display panel, see p.139 "Checking the Error Log".

• For details about the [Auto Delete Temporary Jobs] and [Auto Delete Stored Jobs], see p.188 "System
Menu".
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Printing a Sample Print File

The following procedure describes how to print a Sample Print file with the PCL 6/5c, RPCS and PostScript
3 printer driver.

• Applications with their own drivers, such as PageMaker, do not support this function.

1. From an application, select a command to print.

The Print dialog box appears.

2. Select the printer you want to use in the [Name] list, and then click [Properties].

The printer properties dialog box appears.

3. In the [Job Type:] box, click [Sample Print].

When printing with the PostScript 3 printer driver, click [Sample Print] in the [Job Type:] box on the
[Job Log] tab.

4. In the [User ID:] box, enter a user ID using up to eight alphanumeric characters.

This is used to identify the user. The user ID can be entered using up to eight alphanumeric (a-z, A-Z,
0-9) characters.

5. Click [Details...], and then enter a User ID in the [User ID:] box.

This is used to identify the user. The user ID can be entered using up to eight alphanumeric (a-z, A-Z,
0-9) characters.

6. Execute a command to print.

Make sure to set more than two copies.

The Sample Print job is sent to the printer, and the first set is printed.

7. On the printer's control panel, press [Prt.Jobs].

8. Select [Sample Print Jobs] using the [ ] or [ ] key, and then press [Job List].

A list of Sample Print files stored in the printer appears.

Depending on the security settings, certain print jobs may not be displayed.
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You can print files also by pressing [User ID].

9. Select the file you want to print using the [ ] or [ ] key, and then press [Print].

Enter the new number of sets using the scroll keys. You can enter up to 999 sets.

Press the [Escape] key to correct any entry mistakes.

10. Press [Print].

The remaining sets are printed.

Press [Cancel] to cancel printing.

• When the number of set quantity is changed, the changed quantity is applied to all selected files.

• When printing is completed, the stored file will be deleted.

• To stop printing after printing has started, press the [Job Reset] key. The file will be deleted.

• For details about [User ID], see p.131 "Printing from the User ID Screen".

Deleting Sample Print Files

If you are not satisfied with the sample printout, you can delete the Sample Print file, revise it and print it
again until the settings are suitable.

1. Press [Prt.Jobs].

2. Select [Sample Print Jobs] using the [ ] or [ ] key, and then press [Job List].

Printing from the Print Job Screen

119

3



A list of Sample Print files stored in the printer appears.

Depending on the security settings, certain print jobs may not be displayed.

3. Select the file you want to delete using the [ ] or [ ] key, and then press [Delete].

The delete confirmation screen will appear.

4. Press [Delete].

The selected file is deleted.

If you do not want to delete the file, press [Cancel].

Locked Print

Use this function to maintain privacy when printing confidential documents on the printer over a shared
network. Usually, it is possible to print data using the display panel once it is stored in this printer. When
using Locked Print, it is not possible to print unless a password is entered on the printer's display panel.
Your confidential documents will be safe from being viewed by other people.

• A Locked Print file cannot be stored if:

• the total number of Sample Print, Locked Print, Hold Print, and Stored Print files in the printer is
over 100. (The maximum number varies depending on the volume of data in files.)

• the file contains over 1,000 pages.

• sent or stored files in the printer contain over 9,000 pages in total.

• If a Locked Print file has not been stored properly, check the error log on the control panel.

• Even after you turn off the printer, stored documents remain. However, the [Auto Delete Temporary
Jobs] or [Auto Delete Stored Jobs] settings are applied first.

• If the application has a collate option, make sure it is not selected before sending a print job. Locked
Print jobs are automatically collated by the printer driver as default. If a collate option is selected in
the application print dialog box, more sets than intended may be printed.

• After the Locked Print file is printed, the job is automatically deleted.

• Locked Print files printed or deleted using Web Image Monitor, after you select [Locked Print] using
the control panel will appear on the display panel. However, an error message will appear if you try
to print or delete those Locked Print files.
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• For details about the error log on the display panel, see p.139 "Checking the Error Log".

• For details about the [Auto Delete Temporary Jobs] and [Auto Delete Stored Jobs], see p.188 "System
Menu".

Printing a Locked Print File

The following procedure describes how to print a Locked Print file with the PCL 6/5c, RPCS and PostScript
3 printer driver.

• Applications with their own drivers, such as PageMaker, do not support this function.

1. Configure the Locked Print in the printer driver's properties.

For details about configuring the printer drivers, see the corresponding Help files.

2. Start printing from the application's Print dialog box.

The Locked Print job is sent to the printer.

3. On the printer's control panel, press [Prt.Jobs].

4. Select [Locked Print Jobs] using the [ ] or [ ] key, and then press [Job List].

A list of Locked Print files stored in the printer appears.

Depending on the security settings, certain print jobs may not be displayed.

You can print files also by pressing [User ID].

5. Select the file you want to print using the [ ] or [ ] key, and then press [Print].
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The password screen appears.

6. Enter the password using the [ ], [ ],[ ] or [ ] key, and then press the [OK] key.

The print confirmation screen appears.

A confirmation screen will appear if the password is not entered correctly. Press [Clear] to enter the
password again.

If you forget your password, ask your network administrator for help.

7. Press [Print].

The remaining sets are printed.

Press [Cancel] to cancel printing.

• When printing is completed, the stored file will be deleted.

• To stop printing after printing has started, press the [Job Reset] key. The file will be deleted.

• For details about [User ID], see p.131 "Printing from the User ID Screen".

Deleting Locked Print Files

1. Press [Prt.Jobs].

2. Select [Locked Print Jobs] using the [ ] or [ ] key, and then press [Job List].

A list of Locked Print files stored in the printer appears.
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Depending on the security settings, certain print jobs may not be displayed.

3. Select the file you want to delete using the [ ] or [ ] key, and then press [Delete].

The password screen appears.

4. Enter the password using the [ ], [ ], [ ] or [ ] key, and then press the [OK] key.

The delete confirmation screen appears.

A confirmation screen will appear if the password is not entered correctly. Press [Clear] to enter the
password again.

If you forget your password, ask your network administrator for help.

5. Press [Delete].

The selected file is deleted.

If you do not want to delete the file, press [Cancel].

Hold Print

Use this function to temporarily hold a file in the printer, and print it from the computer or the printer's control
panel later.

• A Hold Print file cannot be stored if:

• the total number of Sample Print, Locked Print, Hold Print, and Stored Print files in the printer is
over 100. (The maximum number varies depending on the volume of data in files.)

• the file contains over 1,000 pages.

• sent or stored files in the printer contain over 9,000 pages in total.

• If a Hold Print file has not been stored properly, check the error log on the control panel.
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• Even after you turn off the printer, stored documents in the printer remain. However, the [Auto Delete
Temporary Jobs] or [Auto Delete Stored Jobs] settings are applied first.

• If the application has a collate option, make sure it is not selected before sending a print job. By
default, Hold Print jobs are automatically collated by the printer driver. If a collate option is selected
from the application's Print dialog box, more prints than intended may be produced.

• Hold Print files printed or deleted using Web Image Monitor, after you select [Hold Print] using the
control panel will appear on the display panel. However, an error message will appear if you try to
print or delete those Hold Print files.

• If stored files have similar and long file names, recognizing the file you want to print on the display
panel may be difficult. Print the file you want to print either by checking the user ID or the time the file
is sent, or by changing the file name to something that can be recognized easily. If you enter the
document name on the printer driver's [Details...], that name appears on the display panel.

• It is possible, but not required, to set a file name or a password to a Hold Print file.

• For details about the error log on the display panel, see p.139 "Checking the Error Log".

• For details about the [Auto Delete Temporary Jobs] and [Auto Delete Stored Jobs], see p.188 "System
Menu".

Printing a Hold Print File

The following procedure describes how to print a Hold Print file with the PCL 6/5c and the RPCS printer
driver. For information about how to print a Hold Print file with the PostScript 3 printer driver, see Postscript
3 Supplement.

• Applications with their own drivers, such as PageMaker, do not support this function.

1. Configure Hold Print in the printer driver's properties.

For details about configuring the printer drivers, see the relevant Help files.

2. Click [Details...], and then enter a User ID in the [User ID:] box.

You can also set a file name. The file name you set will be displayed on the printer's Job List screen.

3. Start printing from the application's Print dialog box.

The Hold Print job is sent to the printer and stored.

4. On the printer's control panel, press [Prt.Jobs].
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5. Select [Hold Print Jobs] using the [ ] or [ ] key, and then press [Job List].

A list of Hold Print files stored in the printer appears.

Depending on the security settings, certain print jobs may not be displayed.

You can print files also by pressing [User ID].

6. Select the file you want to print using the [ ] or [ ] key, and then press [Print].

The confirmation screen appears.

7. Press [Print].

The Hold Print file is printed.

Press [Cancel] to cancel printing.

• When printing is completed, the stored file will be deleted.

• To stop printing after printing has started, press the [Job Reset] key. The file will be deleted.

• For details about setting printer drivers, see the printer driver Help. You can also print or delete a Hold
Print file from Web Image Monitor. For details, see Web Image Monitor Help.

• For details about [User ID], see p.131 "Printing from the User ID Screen".

Deleting Hold Print Files

1. Press [Prt.Jobs].
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2. Select [Hold Print Jobs] using the [ ] or [ ] key, and then press [Job List].

A list of Hold Print files stored in the printer appears.

Depending on the security settings, certain print jobs may not be displayed.

3. Select the file you want to delete using the [ ] or [ ] key, and then press [Delete].

The confirmation screen appears.

4. Press [Delete].

The selected file is deleted.

If you do not want to delete the file, press [Cancel].

Stored Print

Use this function to store a file in the printer, and then print it from the computer or the printer's control panel
later.

Jobs are not deleted after they are printed, so the same job need not be resent in order to print multiple
copies.

• A Stored Print file cannot be stored if:

• the total number of Sample Print, Locked Print, Hold Print, and Stored Print files in the printer is
over 100. (The maximum number varies depending on the volume of data in files.)

• the file contains over 1,000 pages.

• sent or stored files in the printer contain over 9,000 pages in total.

• If a Stored Print file has not been stored properly, check the error log on the control panel.

• Even after you turn off the printer, stored documents in the printer remain. However, the [Auto Delete
Temporary Jobs] or [Auto Delete Stored Jobs] settings are applied first.
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• If the application has a collate option, make sure it is not selected before sending a print job. By
default, Stored Print jobs are automatically collated by the printer driver. If a collate option is selected
from the application's Print dialog box, more prints than intended may be produced.

• Stored Print files printed or deleted using Web Image Monitor, after you select [Stored Print Jobs]
using the control panel will appear on the display panel. However, an error message will appear if
you try to print or delete those Stored Print files.

• If stored files have similar and long file names, recognizing the file you want to print on the display
panel may be difficult. Print the file you want to print either by checking the user ID or the time the file
is sent, or by changing the file name to something that can be recognized easily.

• If you enter the document name on the printer driver's [Details...], that name appears on the display
panel.

• For details about the error log on the display panel, see p.139 "Checking the Error Log".

• For details about the [Auto Delete Temporary Jobs] and [Auto Delete Stored Jobs], see p.188 "System
Menu".

Printing a Stored Print File

The following procedure describes how to print a Stored Print file with the PCL 6/5c and the RPCS printer
driver. For information about how to print a Stored Print file with the PostScript 3 printer driver, see Postscript
3 Supplement.

• Applications with their own drivers, such as PageMaker, do not support this function.

1. Configure the Stored Print in the printer driver's properties.

You can select two ways for Stored Print:

• [Stored Print]

Stores the file in the printer and print it later using the control panel.

• [Store and Normal Print] (or [Store and Print])

Prints the file at once and also stores the file in the printer.

For details about configuring the printer drivers, see the relevant Help files.

2. Click [Details...], and then enter a User ID in the [User ID:] box.

You can also set a password. The same password must be entered when printing or deleting.

You can also set a file name. The file name you set will be displayed on the printer's Job List screen.

3. Start printing from the application's Print dialog box.

The Stored Print job is sent to the printer.
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4. On the printer's control panel, press [Prt.Jobs].

5. Select [Stored Print Jobs] using the [ ] or [ ] key, and then press [Job List].

A list of Stored Print files stored in the printer appears.

You can print files also by pressing [User ID].

6. Select the file you want to print using the [ ] or [ ] key, and then press [Print].

The confirmation screen appears.

If you set a password in the printer driver, a password confirmation screen appears. Enter the
password.

7. Press [Print].

The Stored Print file is printed.

Press [Cancel] to cancel printing.

• When multiple files are selected without setting a quantity, one set less than the minimum number of
all settings is applied. If the least number of settings is one set, all selected files will be printed at one
set.

• When the number of set quantity is changed, the changed quantity is applied to all selected files.

• To stop printing after printing has started, press the [Job Reset] key. A Stored Print file is not deleted
even if [Job Reset] is pressed.

• The Stored Print file that sent to the printer is not deleted unless you delete a file or select [Auto Delete
Stored Jobs].
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• You can set or delete a password after sending files to the printer. Select the file and press [Change]
in the Print Job List screen. To set a password, enter the new password. To delete the password, leave
the password box blank on entering or confirming the new password, and press the [OK] key.

• For details about setting printer drivers, see the printer driver Help. You can also print or delete a
Stored Print file from Web Image Monitor. For details, see Web Image Monitor Help.

• For details about the [Auto Delete Stored Jobs], see p.188 "System Menu".

• For details about [User ID], see p.131 "Printing from the User ID Screen".

Deleting Stored Print Files

1. Press [Prt.Jobs].

2. Select [Stored Print Jobs] using the [ ] or [ ] key, and then press [Job List].

A list of Stored Print files stored in the printer appears.

Depending on the security settings, certain print jobs may not be displayed.

3. Select the file you want to delete using the [ ] or [ ] key, and then press [Delete].

The delete confirmation screen will appear.se

If you set the password in the printer driver, enter the password to delete.

If you forget your password, ask your network administrator for help.

4. Press [Delete].

The selected file is deleted.
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If you do not want to delete the file, press [Cancel].
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Printing from the User ID Screen
This describes how to print the files saved in the printer from the User ID screen.

Printing the Selected Print Job

• If you print a Sample, Locked, or Hold Print file, the print file saved in the printer is deleted after printing
is complet.

1. On the initial screen, press [Prt.Jobs].

2. Press [User ID].

A list of user IDs whose files are stored in the printer appears.

3. Select the user ID whose file you want to print using the [ ] or [ ] key, and then press [Job
List].

The print job list of the selected user ID appears.

4. Select the file you want to print using the [ ] or [ ] key, and then press [Print].
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The confirmation screen appears.

5. Press [Print].

The selected file is printed.

Press [Cancel] to cancel printing.

• For details about printing each type of print job, see the followings:

• p.117 "Sample Print"

• p.120 "Locked Print"

• p.123 "Hold Print"

• p.126 "Stored Print"

Printing All Print Jobs

1. On the initial screen, press [Prt.Jobs].

2. Select a type of print jobs you want to print using the [ ] or [ ] key, and then press [User
ID].

A list of user IDs whose files are stored in the printer appears.

3. Select the user ID whose file you want to print using the [ ] or [ ] key, and then press
[PrintAll].

The confirmation screen appears.
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4. Press [Print].

The selected files are printed.

To cancel printing, press [Cancel].

• After printing is completed, Sample Print, Locked Print, and Hold Print files are deleted.

• You cannot select a print job that is not stored under the selected user ID.

• When printing multiple Sample Print files without specifying the number of sets on the confirmation
screen, one set less than the least number of set specified on the computer is applied for every selected
document. If the number of sets specified on the computer is "1", one set each is printed for every
document.

• When printing multiple Stored Print files without specifying the number of sets on the confirmation
screen, the least number of set specified on the computer is applied for every selected document.

• If you select [Locked Print], enter the correct password. If there are multiple passwords, the printer
prints only files that correspond to the entered password.

• If you select Stored Print files, and some of these require a password, the printer prints files that
correspond to the entered password and files that do not require a password.

• For details about printing each type of print job, see the followings:

• p.117 "Sample Print"

• p.120 "Locked Print"

• p.123 "Hold Print"

• p.126 "Stored Print"
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Form Feed
This section gives instructions for operating the printer when there is no tray for the selected paper size or
type, or when paper loaded in the printer has run out.

• The tray cannot be changed if the following functions are set:

• Duplex Print to a tray that does not support duplex printing

• Cover Sheet

• Slip Sheet

• If form feed is selected for a tray with the following settings, you can change the tray by canceling
the settings:

• Duplex Print

• Staple

• If [Auto Continue] is selected, form fed paper is printed after a set interval. For details, see p.188
"System Menu".

Printing from a Selected Tray

If the printer does not have a tray for the selected paper size or paper type, or if the selected paper loaded
in the printer has run out, a caution message appears. If this message appears, do the following procedure.

1. When the caution message appears, press [FormFeed].

A confirmation message appears.

2. Press the [OK] key.
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3. Select the tray for form feed using the [ ] or [ ] key from those that appear on the display
panel, and then press the [OK] key.

The printer prints using the selected tray.

• If a tray with a smaller paper size is selected, the print job may be cut short, or other problems may
occur.

Canceling a Print Job

Follow this procedure for canceling the print job if the message prompting form feed appears.

1. Press [JobReset].

2. Press [Current].

The confirmation message appears.

To resume printing jobs, press [Resume].

3. Press [Yes] to cancel the print job.

Press [No] to return to the previous display.
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• If the printer is shared by multiple computers, be careful not to accidentally cancel someone else's
print job.

• Under Windows, If the printer is connected to the computer using a parallel cable, sent print jobs may
be canceled if [JobReset] is pressed while "Waiting..." is displayed on the control panel. After the
interval set in [I/O Timeout] in Printer Features has passed, the next print job can be sent. A print job
sent from a different client computer will not be canceled in this case.

• You cannot stop printing data that has already been processed. For this reason, printing may continue
for a few pages after you press [JobReset].

• A print job containing a large volume of data may take considerable time to stop.

• To stop data printing, see p.137 "Canceling a Print Job".
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Canceling a Print Job
You can cancel printing from either the printer or a client computer. Since canceling procedures vary
depending on the print job status, check the job status and cancel printing according to the following
procedure.

Canceling a Print Job Using the Control Panel

1. Press [JobReset].

A confirmation message appears.

2. Press [Current].

To resume printing jobs, press [Resume].

3. Press [Yes] to cancel the print job.

Press [No] to return to the previous display.

Windows - Canceling a Print Job from the computer

You can cancel a print job from the computer if transferring print jobs is not completed.

1. Double-click the printer icon on the Windows task tray.

A window appears, showing all print jobs currently queued for printing. Check the current status of
the job you want to cancel.

2. Select the name of the job you want to cancel.

3. On the [Document] menu, click [Cancel Printing].
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• If the printer is shared by multiple computers, be careful not to accidentally cancel someone else's
print job.

• If the printer is connected to the computer using a parallel cable, sent print jobs may be canceled if
[JobReset] is pressed while "Waiting..." is displayed on the control panel. After the interval set in [I/
O Timeout] in Printer Features has passed, the next print job can be sent. A print job sent from a different
client computer will not be canceled in this case.

• In Windows XP/Vista, Windows Server 2003/2003 R2, and Windows NT 4.0, click [Cancel] on
the [Document] menu.

• In Windows 95/98/Me/2000 or Windows NT 4.0, you can also open the print job queue window
by double-clicking the printer icon in the [Printers] printer window (the [Printers and Faxes] window
under Windows XP and Windows Server 2003/2003 R2).

• You cannot stop printing data that has already been processed. For this reason, printing may continue
for a few pages after you press [JobReset].

• A print job containing a large volume of data may take considerable time to stop.

Mac OS - Canceling a Print Job from the computer

1. Double-click the printer icon on the desktop.

A window appears showing all print jobs that are currently queuing to be printed. Check the current
status of the job you want to cancel.

Under Mac OS X, start Print Center.

2. Select the name of the job you want to cancel.

3. Click the pause icon, and then click the trash icon.

• If the printer is shared by multiple computers, be careful not to accidentally cancel someone else's
print job.

• If the printer is connected to the computer using a parallel cable, sent print jobs may be canceled if
[JobReset] is pressed while "Waiting..." is displayed on the control panel. After the interval set in [I/
O Timeout] in Printer Features has passed, the next print job can be sent. A print job sent from a different
client computer will not be canceled in this case.

• You cannot stop printing data that has already been processed. For this reason, printing may continue
for a few pages after you press [JobReset].

• A print job containing a large volume of data may take considerable time to stop.
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Checking the Error Log
If files could not be stored due to printing errors, identify the cause of the errors by checking the error log
on the control panel.

• The most recent 30 errors are stored in the error log. If a new error is added when there are 30 errors
already stored, the oldest error is deleted. However, if the oldest error belongs to one of the following
print jobs, it is not deleted. The error is stored separately until the number of those errors reaches 30.
You can check any of these print jobs for error log information.

• Sample Print

• Locked Print

• Hold Print

• Stored Print

• If the main power switch is turned off, the log is deleted.

1. Press [Option].

2. Select [Show Error Log] using the [ ] or [ ] key, and then press the [OK] key.

3. Select a type of print jobs using the [ ] or [ ] key, and then press the [OK] key.

If you select [All], all error logs appears.
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4. Select the error log you want to check using the [ ] or [ ] key.

• Press the [Menu] key until the initial screen appears after checking the log.

• To print files that appear in the error log, resend them after stored files have been printed or deleted.
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Collate
The Collate function allows you to print while sorting printouts into page-ordered sets, such as when printing
multiple copies of meeting materials.

Up to 1,000 pages can be sorted.

Collate

Output can be assembled as sets in sequential order.

• If Auto Continue occurs on the first set, Collate will be canceled.

• If forced printing occurs on the first set, Collate will be canceled.

• When setting Collate in the printer driver settings, make sure that a collate option is not selected in
the application's print settings. If a collate option is selected, printing will not be as intended.

• For details about printing method, see the printer driver Help.

Shift Collate

The optional finisher is required for this function. The finisher shift tray moves backward or forward when
a job or set is output, causing the next to shift, so you can separate them.

AEU018S
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Spool Printing
With Spool Printing, the print data is saved in the hard disk before printing. To use this function, set it from
the menu. See p.240 "Remote Maintenance by telnet".

• Use the "spoolsw clear job" telnet command to clear a spooled print job. Do not turn off the printer
or computer while a print job is being spooled and the Data In is flashing. Print jobs that are interrupted
in this way remain on the printer's hard disk and will finish printing out when the printer is turned back
on.

• The Spool Printing function is available for data received using diprint, lpr, ipp, ftp, and sftp (TCP/IP
(IPv6)).

• When using diprint, the Spool Printing function cannot be used with bidirectional communication.

• The domain reserved for spool printing is about 1 GB.

• When Spool Printing is on, the size of a single print job cannot exceed 500 MB.

• When receiving jobs from multiple computers, the printer can spool a maximum of ten lpr jobs, and
only one diprint, ipp, ftp, sftp, or smb job. If the printer's spooling capacity is exceeded, newer jobs
cannot be printed. You must wait before sending further jobs.

• Printing the first page with Spool Printing will be slow.

• The computer requires less print processing time when large amounts of data are spooled.

• Stored spool jobs can be viewed or deleted using Web Image Monitor.

• The list of spool jobs cannot be viewed from the printer's control panel.

• For information about the "spoolsw clear job" command on the telnet, see p.240 "Remote
Maintenance by telnet".

Setting Spool Printing

Spool printing settings can be made using telnet or Web Image Monitor.

• Using Web Image Monitor

In [System] on the [Configuration] menu, click [Enable] in [Spool Printing].

• Using telnet

Enter "spoolsw spool on".

• For details about Web Image Monitor, see Web Image Monitor Help.
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• For details about "spoolsw spool on", see p.240 "Remote Maintenance by telnet".

Viewing or Deleting spooled jobs using Web Image Monitor

Follow the procedure below to check or delete spooled jobs using Web Image Monitor.

1. Open a Web browser.

2. Enter "http://(printer's address)/" in the address bar to access the printer whose settings
you want to change.

Top Page of Web Image Monitor appears.

3. Click [Login].

The window for entering the login user name and password appears.

4. Enter the login user name and password, and then click [Login].

Contact your administrator for information about the settings.

5. In the menu area, click [Job].

A submenu will appear.

6. On the [Printer] menu, click [Spool Printing].

A list of spooled jobs appears.

7. To delete a job, select the check box of the job you want to delete, and then click [Delete].

The selected job is deleted.

8. Click [Logout].

9. Quit Web Image Monitor.

• For details, see Web Image Monitor Help.

Spool Printing
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Cover
Using this function, you can insert cover and back sheets fed from a different tray to that of the main paper,
and print on them.

• To use this function, Collate must be set.

• The cover sheets should be the same size and orientation as the body of the paper.

• If Auto Tray Select is set for the body paper feed tray, body paper will be delivered from a tray that
contains paper set in portrait orientation. Therefore, if the cover paper is set to landscape orientation,
the orientation of the cover and body paper will be different.

• For printing methods, see the printer driver Help.
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Printing with the Finisher
You can staple or punch holes in printed paper by installing the optional finisher. Make sure you read the
following precautions when using the optional finisher.

• Make option settings for the printer using the printer driver when bidirectional communication is
disabled.

• Be sure to set the paper size and paper orientation in the printer driver when using duplex printing,
staple and punch functions.

• When printing restarts after removing jammed paper, the printing position may be different,
depending on the location of the jam.

• If the paper jam occurred in the optional finisher, printing will restart from the top page of the
data currently being printed, or from the page where the paper jam occurred.

• If the paper jam occurred in the printer, printing will restart from the page where the paper jam
occurred.

• Even if the paper jam occurred in the printer, the error will not be cleared unless the cover of the
finisher is opened and closed.

• For information about optional finishers, see Hardware Guide.

Staple

With the optional Booklet Finisher SR3000 or Finisher SR3030 installed, sets can be stapled individually
when printing multiple sets.

Staple Position

The specified staple position varies depending on paper size, type, quantity and feed orientation. The
following table shows staple positions:
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Staple Position

ATU401S

• When two-sided printing is selected, adjust the staple position to the binding direction.

• If you are punching at the same time, specify the same side.

Staple Capacity (Booklet Finisher SR3000)

Paper Size Staple Capacity

A3 , B4 JIS , 11×17 , 81/2×14 , 8×13
, 81/2×13 , 81/4×13 , 8K

30

A4 , B5 JIS , 81/2×11 , 71/4×101/

2 , 16K
50

Booklet Staple:

A3 , B4 JIS , A4 , B5 JIS , 11×17 ,
81/2×14 , 81/2×11

10
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Staple Capacity (Finisher SR3030)

Paper Size Staple Capacity

A3 , B4 JIS , 11×17 , 81/2×14 , 8×13
, 81/2×13 , 81/4×13 , 8K

30

A4 , B5 JIS , Letter , 71/4×101/2
, 16K

50

Mixed Size (Finisher SR3030)

Mixed Paper Size Staple Capacity

A3  and A4 30

B4 JIS  and B5 JIS 30

11×17  and 81/2×11 30

• For printing methods, see the printer driver Help.

Stapling Precautions

• Stapling can be done only with the optional finisher installed.

• Staple printing will be canceled under the following conditions:

• If the number of pages to staple exceeds maximum.

• If a paper size that cannot be stapled is selected.

• If a paper type that cannot be stapled is selected.

• If positions other than those fixed for stapling are specified.

• If there are inconsistencies between the orientation in the duplex mode and the staple position.

• If there are inconsistencies between the orientation in letterhead mode and the staple position.

• When staples have run out and Auto Continue is set (Printing will continue without stapling after
the message has been displayed).

• When only 1 page is printed when staples have run out.

• If paper sizes are mixed when a different paper size is specified during a print job.
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• When printing on letterhead, stapling may not be at the specified position.

• If you cannot make staple settings even with Finisher installed, options may not be set correctly in the
printer driver. Correct option settings in the printer driver. For details, see the printer driver Help.

• When duplex printing is selected, adjust staple positions to the binding orientation.

• Depending on the software you are using, print settings may not be saved and the printed result may
not be as expected.

• When setting Staple in the printer driver settings, make sure that a collate option is not selected in the
print settings of the application. If a collate option is selected in the application, printing will not be
as intended.

• When using tracing paper, the vertical/horizontal position of the staples is opposite to the vertical/
horizontal position specified in the printer driver settings.

• Also, staples on the front cover sheet come out reversed.

Punch

By installing an optional punch unit to an optional finisher, Booklet Finisher SR3000 or Finisher SR3030,
holes can be punched into printed output.

Punch Position

The specified punch position varies depending on paper feed and print data orientation. The following
table shows punch positions:
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Punch Position

AST201S

• Punch positions will vary slightly from page to page as holes are punched into each sheet individually.

• For printing methods, see the printer driver Help.

Holes Type (Booklet Finisher SR3000 and Finisher SR3030)

Type Paper Size

2 holes
A3 , B4 JIS , A4 , B5 JIS , A5 , 11×17 , 81/2×14 , 81/

2×11 , 71/4×101/2 , 81/2×13 , 81/4×13 , 8×13 , 8K ,
16K

3 holes
A3 , B4 , A4 , B5 JIS , 11×17 , 81/2×11 , 71/4×101/2 , 8K

, 16K

EU 4 holes
A3 , B4 , A4 , B5 JIS , 11×17 , 81/2×11 , 71/4×101/2 , 8K

, 16K

Northern EU 4 holes
A3 , B4 JIS , A4 , B5 JIS , A5 , 11×17 , 81/2×14 , 81/

2×11 , 71/4×101/2 , 8×13 , 81/2×13 , 81/4×13 , 8K ,
16K

Punching Precautions

Follow these precautions when using the punch function.
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• To use this function, an optional punch unit must be installed to the optional Finisher attached to the
printer.

• Punch printing will be canceled under the following conditions:

• When a paper type that cannot be punched is selected.

• When a paper size that cannot be punched is selected.

• If positions other than those fixed for punching are specified.

• If there are inconsistencies between the orientation in duplex mode and the punch position.

• If there are inconsistencies between the orientation in letterhead mode and the punch position.

• When the punch receptacle has become full and Auto Continue is set (Printing will continue
without punching after the message appears).

• If there are inconsistencies between the staple position and the punch position, when using with
staple function.

• Punching might not be in the specified position when printing on letterhead paper.

• If you cannot make punch settings even with the optional finisher installed, options may not be set
correctly in the printer driver. Correct option settings in the printer driver. For details, see the printer
driver Help.

• When duplex print is selected, adjust the punch position to the binding direction.

• Be sure to set the punch position the same as the staple position when using it with the staple function.

• Be sure to set paper size and orientation in the printer driver when punching.

• Depending on the application, print settings may not be enabled and printed output may not be as
expected.

• When setting Punch in the printer driver settings, make sure that a collate option is not selected in the
print settings of the application.

• If a collate option is selected in the application, printing will not be as intended.

• When using tracing paper, the vertical/horizontal position of the punches is opposite to the vertical/
horizontal position specified in the printer driver settings.
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Memory Capacity and Paper Size
Additional memory apart from standard memory may be required depending on the paper size and data
type.

• When printing from bypass tray, duplex printing will not be supported regardless of the memory
capacity, and only one-side will be printed.

One-sided printing (600 × 600 dpi)

256 MB (standard)

• 12"×18", A3, B4, A4, B5 JIS, A5, 11"×17", 81/2"×14", 81/2"×11" and Postcard sized paper
can be printed.

• 305 mm × 600 mm (12.2 in. × 24 in.) and 305 mm × 1260 mm (12.2 in. × 50.4 in.) sized
paper may not be printed, depending on the printing data.

384 MB (standard and 128 MB)

• 12"×18", A3, B4, A4, B5 JIS, A5, 11"×17", 81/2"×14", 81/2"×11", Postcard sized paper,
and 305 mm × 600 mm (12.2 in. × 24 in.) sized paper can be printed.

• 305 mm × 1260 mm (12.2 in. × 50.4 in.) sized paper may not be printed, depending on the
printing data.

512 MB (standard and 256 MB)

• 12"×18", A3, B4, A4, B5 JIS, A5, 11"×17", 81/2"×14", 81/2"×11", Postcard sized paper,
305 mm × 600 mm (12.2 in. × 24 in.) sized paper, and 305 mm × 1260 mm (12.2 in. × 50.4
in.) sized paper can be printed.

Duplex printing (600 × 600 dpi)

256 MB (standard)

• A4, B5 JIS, A5, and 81/2"×11" can be printed.

• A3, B4, and 81/2"×14" may not be printed, depending on the printing data.

384 MB (standard and 128 MB)

• A3, B4, A4, B5 JIS, A5, 81/2"×14", and 81/2"×11" can be printed.

512 MB (standard and 256 MB)

• A3, B4, A4, B5 JIS, A5, 81/2"×14", and 81/2"×11" can be printed.

Memory Capacity and Paper Size
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4. Direct Printing from a Digital Camera
(PictBridge)

What is PictBridge?
You can connect a PictBridge-compatible digital camera to this printer using a USB cable. This allows you
to print photographs taken using the digital camera directly by operating the digital camera.

ASZ051S

Before you can use this function, the printer requires the following options:

• USB host interface board

• Camera direct print card

• Check your digital camera is PictBridge-compatible.

• Up to 999 images can be sent from the digital camera to the printer during one print transaction. If
an attempt is made to send more images, an error message is sent to the camera and printing fails.

• Since printing conditions are specified on the digital camera, specifiable parameters depend on the
particular digital camera. For details, see your digital camera's manual.

• This function is compatible with USB 1.1.
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PictBridge Printing
Follow the procedure below to start PictBridge printing on this printer.

• Do not disconnect the USB cable while data is being sent. If you do, printing will fail.

• The USB host interface board is supplied with a USB cable and a hook onto which you can roll up
and hang the cable.

1. Check the printer and the digital camera are both switched on.

2. Connect a USB cable between the optional USB host interface board installed on the printer
and the digital camera.

The Data In indicator on the printer blinks for several seconds, and “PctBrdg” is displayed on the
printer. This indicates that the printer has correctly recognized the digital camera.

3. On your digital camera, select the images you want to print, and specify the printing
conditions.

4. The printer receives settings from the digital camera and starts printing.

• Since printing conditions are specified on the digital camera, specifiable parameters depend on the
particular digital camera. For details, see the digital camera's manual.

• Some digital cameras require settings for manual PictBridge operation. For details, see your digital
camera's manual.

• For details about connection instructions, see Hardware Guide.

• To cancel printing, see p.137 "Canceling a Print Job".
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What Can Be Done on This Printer
This printer can perform the following functions using its PictBridge feature.

The settings available for these functions are as follows:

• Single image printing

• Selected image printing

• All image printing

• Index printing

• Trimming

• Date and file name printing

• Paper size

• Image print size

• Multi-Image-Layout

• Printing quality

• Color matching

• Paper type specification

• Form printing

• Camera memo printing

• This printer does not support the following settings:

• DPOF printing

• Margin-less printing

• The setting parameters and their names may vary depending on the digital camera. For details, see
your digital camera's manual.

Index Printing

A3 (297 × 420)

Horizontal images × vertical images (in) Paper orientation

12 × 16

What Can Be Done on This Printer

155

4



A4 (210 × 297)

Horizontal images × vertical images (in) Paper orientation

8 × 12

12 × 8

A5 (148 × 210)

Horizontal images × vertical images (in) Paper orientation

5 × 8

8 × 5

Letter (81/2"×11")

Horizontal images × vertical images (in) Paper orientation

8 × 10

10 × 8

• Index printouts vary depending on the orientation of the paper placed on the specified size tray.

• Depending on the digital camera, a form feed may be inserted after one set of images belonging to
one type ends.

• The number of images in each size of paper is fixed.

Trimming

Use this function to print only the inside of the trimming area specified on the digital camera.
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AGZ007S

-- indicates the trimming area.

Date and File Name Printing

Use this function to print the date and/or file name under the image.

AGZ005S

In the above figure, "aaaaa" indicates the file name and "bbbbb" indicates the date.

Paper Size

Use this function to print on paper with the size specified on the digital camera.

Paper size name Actual size

Postcard 148 mm × 100 mm

Letter (81/2"×11") 279.4 mm × 216 mm (8 1/2 × 11)

A3 420 mm × 297 mm

A4 297 mm × 210 mm

What Can Be Done on This Printer
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Paper size name Actual size

A5 210 mm × 148 mm

A6 148 mm × 105 mm

B4 257 mm × 364 mm

B5 257 mm × 182 mm

B6 182 mm × 128 mm

• For details about specifying custom sizes, see Hardware Guide.

Image Print Size

Use this function to print images with the size specified on the digital camera.

AGZ008S

indicates the image size specified on the camera.

You can specify the following image print sizes:

Fixed size

• 3.25" × 2.5"

• 5" × 2.5"

• 6" × 4"

• 7" × 5"

• 10" × 8"

• 254 mm × 178 mm

• 110 mm × 74 mm

• 89 mm × 55 mm
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• 148 mm × 100 mm

• 8 cm × 6 cm

• 10 cm × 7 cm

• 13 cm × 9 cm

• 15 cm × 10 cm

• 18 cm × 13 cm

• 21 cm × 15 cm

• 24 cm × 18 cm

• An error occurs if the specified size is larger than the actual paper size.

Multi-Image-Layout

Use this function to print multiple images on the specified paper.

AGZ002S

The number of images that can be printed on one page is as follows:

Paper size Number of images that can be specified

Postcard 2, 4

Letter (81/2"×11") 2, 4, 8, 9, 16, 25, 32

A3 2, 4, 8, 9, 16, 25, 32, 36, 49, 64

A4 2, 4, 8, 9, 16, 25, 32

A5 2, 4, 8, 9, 16

A6 2, 4, 8

B4 2, 4, 8, 9, 16, 25, 32, 36, 49

What Can Be Done on This Printer
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Paper size Number of images that can be specified

B5 2, 4, 8, 9, 16, 25

B6 2, 4, 8, 9

The number and arrangement of images that can be specified are as follows:

Number of images
Vertical images × horizontal

images
Paper orientation

2 2 × 1

4 2 × 2

8 4 × 2

9 3 × 3

16 4 × 4

25 5 × 5

32 8 × 4

36 6 × 6

49 7 × 7

64 8 × 8

• A form feed may be inserted between images depending on the digital camera in use.

• Printing in the specified way may not be possible depending on the specification for the number of
images to be printed.

Printing Quality

Use this function to print images at the selected printing quality.

If you select [Default] or [Normal], the printer prints in normal quality; if you select [Fine], the printer prints
in the best quality.
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Color Matching

Use this function to optimize colors when printing images.

If you select [Default] or [OFF], the printer prioritizes gradation for color matching, if you select [ON], the
printer prioritizes saturation.

Paper Type Specification

This function sends the printer's paper type information to the digital camera. The names of paper types
displayed on the digital camera's screen are different to the names displayed on the printer. Use the table
below to match the paper types.

To display a paper type name on the digital camera's screen, use the printer's control panel to set the paper
type of the printer correctly.

The paper type detected by the digital camera The paper type of the printer

Default All type of paper

Plain Paper Plain or recycled paper

Fast Photo Paper Grossy paper

Form Printing

Use this function to print images in a predetermined layout format.

AGZ009S

Camera Memo Printing

Use this function to print text data together with an image if it is attached to the image.

What Can Be Done on This Printer
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Exiting PictBridge
Follow the procedure below to quit the PictBridge mode.

• Do not disconnect the USB cable while data is being sent to the printer. If you do, printing will fail.

1. Check that "Ready" is displayed on the printer’s control panel.

2. Disconnect the USB cable from the printer.

4. Direct Printing from a Digital Camera (PictBridge)
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When PictBridge Printing Does Not Work
This section explains likely causes and possible solutions for problems that can occur when PictBridge
printing.

Problem Cause Solution

PictBridge is not available. There is a problem with the USB
connection or the PictBridge
settings.

Use the following procedure to
check the connection and
settings:

1. Disconnect and then
reconnect the USB cable.

2. Check the PictBridge
settings are enabled.

3. Disconnect the USB cable,
and then turn off the printer.
Turn the printer back on.
When the printer has fully
booted up, reconnect the
USB cable.

When two or more digital
cameras are connected, the
second and subsequent cameras
are not recognized.

You have connected multiple
digital cameras.

Connect one digital camera only.

Do not connect multiple cameras.

Printing is disabled. The number of originals exceeds
the maximum number of pages
that can be printed at a time.

The maximum specifiable print
quantity at a time is 999.
Respecify the quantity to 999 or
less, and then retry printing.

Printing is disabled. There is no paper of the specified
size remaining.

There is no paper of the specified
size remaining.

If you have to use paper that is
not of the specified size, perform
Form Feed. To cancel printing,
perform Job Cancel.

Printing is disabled. The paper size setting for this tray
cannot be printed on the printer.

Select the paper size setting that
can be printed on the printer.

When PictBridge Printing Does Not Work
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Other Reference Information
For further details about printing on this printer, see the following:

• Fore details about paper size, paper type, or tray settings, see Hardware Guide.

4. Direct Printing from a Digital Camera (PictBridge)
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5. Making Printer Settings Using the
Control Panel

Menu Chart
This section explains how to change the default settings of the printer and provides information about the
parameters included in each menu.

Memory Erase Status

Displays data status inside the memory.

• This menu can be selected only when the optional security card is installed.

Paper Input

Menu

Paper Size: Bypass Tray

Paper Size: Tray 2

Paper Size: Tray 3

Paper Size: Tray 4

Paper Size: Tray 5

Paper Type: Bypass Tray

Paper Type: Tray 1

Paper Type: Tray 2

Paper Type: Tray 3

Paper Type: Tray 4

Paper Type: Tray 5

Auto Tray Select

Tray Priority
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Maintenance

Menu

Quality Maintenance

General Settings

Timer Settings

HD Management

List/Test Print

Menu

Multiple Lists

Config. Page

Error Log

Network Summary

Supply Info List

Menu List

Color Demo Page

PCL Config./Font Page

PS Config./Font Page

PDF Config./Font Page

Hex Dump

Operations Test

System

Menu

Print Error Report

Auto Continue

Memory Overflow
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Menu

Printer Language

Sub Paper Size

Default Printer Lang.

Energy Saver 1

Energy Saver 2

Memory Usage

B&W Page Detect

Spool Printing

Notify by Email

Print Settings

Menu

Machine Modes

PCL Menu

PS Menu

PDF Menu

Security Options

Menu

Extended Security

Service Mode Lock

Firmware Version

Network Security Level

Auto Erase Memory Setting

Erase All Memory

Transfer Log Setting

Menu Chart
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• Service Mode Lock may not appear depending on the setting of the printer.

• Auto Erase Memory Setting and Erase All Memory appear when the optional security card is installed.

Host Interface

Menu

I/O Buffer

I/O Timeout

Network

IEEE 802.11b

USB Setting

• IEEE 802.11b appears when the optional IEEE 802.11b interface unit is installed.

Language

Menu

English

Français

Deutsch

Italiano

Español

Nederlands

Norsk

Dansk

Svenska

Polski

Português

Magyar
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Menu

Čeština

Suomi

*1

*1 Chinese only

Menu Chart
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Memory Erase Status Menu
Displays data status inside the memory.

• Memory Erase Status Menu appears only when the optional security card is installed.

1. Press the [Menu] key.

ATU050S

The menu screen appears.

2. Press the [ ] or [ ] key to display [Memory Erase Status], and then press the [OK] key.

3. Displays [Data to erase remaining.] if there is data remaining inside the memory, displays
[Currently no data to erase.] if there is no data inside the memory, and displays [Erasing
Data...] when the data is being deleted.

4. Press the [OK] key.

The menu screen appears.

5. Press the [Online] key.

The initial screen appears.
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Paper Input Menu
This section explains about paper settings on the Paper Input menu such as paper sizes and types on each
tray.

Changing the Paper Input Menu

Automatic Tray Selection

Follow the procedure below to change the automatic tray selection setting.

1. Press the [Menu] key.

ATU050S

The menu screen appears.

2. Press the [ ] or [ ] key to display [Paper Input], and then press the [OK] key.

3. Press the [ ] or [ ] key to display [AutoTray Select], and then press the [OK] key.

4. Press the [ ] or [ ] key to display the tray you want to select, and then press the [OK] key.

5. Press the [ ] or [ ] key to display [On], and then press the [OK] key.

Wait for one second. The [Auto Tray Select] screen appears.

6. Press the [Online] key.

The initial screen appears.

Tray Priority

Follow the procedure below to change the tray priority.

Paper Input Menu
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1. Press the [Menu] key.

ATU050S

The menu screen appears.

2. Press the [ ] or [ ] key to display [Paper Input], and then press the [OK] key.

3. Press the [ ] or [ ] key to display [Tray Priority], and then press the [OK] key.

4. Press the [ ] or [ ] key to select a tray you want to use, and then press the [OK] key.

Wait for one second. The [Paper Input] screen appears.

5. Press the [Online] key.

The initial screen appears.

Paper Input menu parameters

This section explains about parameters that can be set on the Paper Input menu.

Paper Size: Bypass Tray

You can specify the paper size for Bypass Tray.

• : Auto Detect, A4 , A5 , B4 JIS , B5 JIS , B6 JIS , C5 Env. , C6 Env. , DL
Env. , 12 × 18 , 11 × 17 , 81/2 × 14 , 81/2 × 13 , 81/2 × 11 , 81/4 × 13 , 8 ×
13 , 71/4 × 101/2 , 71/4 × 101/2 , 51/2 × 81/2 , 41/8 × 91/2 , 37/8 × 71/2 , 8K

, 16K , Custom Size

• : Auto Detect, 12 × 18 , 81/2 × 14 , 81/2 × 13 , 81/2 × 11 , 81/4 × 13
, 8 × 13 , 71/4 × 101/2 , 41/8 × 91/2 , 37/8 × 71/2 , A3 , A4 , A5 , A6
, B4 JIS , B5 JIS , B6 JIS , C5 Env. , C6 Env. , DL Env. , 8K , 16K , Custom Size

• Default:

• : Auto Detect

• : Auto Detect
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Paper Size: Tray 2 to 5

You can specify the paper size for Tray 2 to 5.

• : Auto Detect, 11 × 17 , 81/2 × 14 , 81/2 × 13 , 81/2 × 11 , 81/4 × 13
, 8 × 13 , 71/4 × 101/2 , 8K , 16K , Custom Size

• : Auto Detect, 81/2 × 13 , 81/4 × 13 , 8 × 13 , 71/4 × 101/2 , A3 , A4
, B4 , B5 JIS , 8K , 16K , Custom Size

• Default:

• : Auto Detect

• : Auto Detect

Paper Type: Bypass Tray

No Display (Plain Paper), Recycled Paper, Special Paper 1, Special Paper 2, Special Paper 3, Color
Paper, Letterhead, Label Paper, OHP (Transparency), Envelope, Glossy Paper, Coated Paper,
Preprinted Paper, Bond Paper, Cardstock, Thin Paper, Middle Thick, Thick Paper 1, Thick Paper 2,
Thick Paper 3, Thick 1: Dup.Back, Thick 2: Dup.Back, Thick 3:Dup.Back

• Default : No Display (Plain Paper)

• For details about the types of paper that can be loaded in the Bypass Tray, see Hardware Guide.

• Be sure to set a paper type using the control panel. If you do not set it, the printing result might
not be proper.

Paper Type: Tray 1 to 5

No Display (Plain Paper), Recycled Paper, Special Paper 1, Special Paper 2, Special Paper 3, Color
Paper, Letterhead, Glossy Paper, Coated Paper, Preprinted Paper, Bond Paper, Cardstock, Thin
Paper, Middle Thick, Thick Paper 1, Thick Paper 2, Thick 1:Dup.Back, Thick 2:Dup.Back

• Default : No Display (Plain Paper)

• For details about the types of paper that can be loaded in each tray, see Hardware Guide.

• Be sure to set a paper type using the control panel. If you do not set it, the printing result might
not be proper.

AutoTray Select

You can select whether to assign each tray to automatically print the paper size and type set by printer
driver.

• Default : On

Paper Input Menu
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• When using custom size paper, if automatic tray selection is enabled, the size selected on the
control panel has priority. If this setting is disabled, the size selected from the printer driver has
priority.

• Only installed trays appear on the display panel.

• You can select multiple trays.

• If you need to have a tray locked, you must select the tray using both printer driver and control
panel.

Tray Priority

You can set a tray to be checked first when automatic tray selection is enabled from the printer driver.
The tray selected here is used when no tray is selected for a print job.

• Default : Tray 1

• Only installed trays appear on the display panel.

• It is recommended that you load paper of the size and orientation you use most frequently in the
tray selected in this setting.

• JIS stands for "Japanese Industrial Standard".
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Maintenance Menu
You can set printing conditions such as density and calibration, and printer management such as deleting
temporary print jobs from the hard disk.

Changing the maintenance menu

This section explains changing the maintenance menu using examples.

Automatic deletion of temporary jobs in the hard disk

Follow the procedure below to set automatic deletion of temporary jobs stored in the hard disk.

1. Press the [Menu] key.

ATU050S

The menu screen appears.

2. Press the [ ] or [ ] key to display [Maintenance], and then press the [OK] key.

3. Press the [ ] or [ ] key to display [HD Management], and then press the [OK] key.

4. Press the [ ] or [ ] key to display [Auto Delete Temporary Jobs], and then press the [OK]
key.

5. Press the [ ] or [ ] key to select [On], and then press the [OK] key.

6. Press the [ ] or [ ] key to set automatic deletion timer in hours between 1 through 200.

7. Press the [OK] key.

Wait for one second. The hard disk management screen appears.

8. Press the [Menu] key.

The initial screen appears.
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Maintenance menu parameters

This section explains about parameters that can be set on the Maintenance menu.

Quality Maintenance

Color Registration

You can perform automatic adjustment of color registration.

Color Calibration

You can adjust the gradation of bright (highlighted parts) and medium areas (middle parts) for printing.

• Adjust Auto Density

You can print the gradation of auto density.

• Print Sheet 1

You can print gradation correction sheet 1.

• Print Sheet 2

You can print gradation correction sheet 2.

• Reset Setting

You can reset the gradation correction value to default.

• For details, see Hardware Guide.

Registration

You can adjust the starting position of the printing page.

• Print Test Sheet

You can print the registration test sheet.

Tray 3, Tray 4, Tray 5

• Only the installed trays appear on the display panel.

• Adjustment

You can select the start position for printing on a page.

Horizontal:Tray3, Horizontal:Tray4, Horizontal:Tray5

• Only the installed trays appear on the display panel.
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4 Color Graphic Mode

This mode adjusts levels of toner color overlap. If characters or lines blur, setting priority on text may
make them clearer. Under normal conditions, set priority on photo.

• Text Priority

• Photo Priority

• Default: Photo Priority

Image Area

You can select whether or not to enlarge print image to edges of paper.

• Do not enlarge

• Enlarge

• Default: Do not enlarge

General Settings

Thick Paper 3 Setting

You can select the type of thick paper 3.

• Thick Paper 3

• Thick Paper 3 (Longer)

• Default: Thick Paper 3

Letterhead Setting

You can select the letterhead printing mode.

• Tray 1

Letterhead 1, Letterhead 2, Letterhead 3

• Tray 2

Letterhead 1, Letterhead 2, Letterhead 3

• Tray 3

Letterhead 1, Letterhead 2, Letterhead 3

• Tray 4

Letterhead 1, Letterhead 2, Letterhead 3

• Tray 5

Letterhead 1, Letterhead 2, Letterhead 3
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• Bypass Tray

Letterhead 1, Letterhead 2, Letterhead 3

• Default: Letterhead 1

Glossy Paper Setting

You can select the glossy paper printing mode.

• Tray 1

Glossy Paper 1, Glossy Paper 2

• Tray 2

Glossy Paper 1, Glossy Paper 2

• Tray 3

Glossy Paper 1, Glossy Paper 2

• Tray 4

Glossy Paper 1, Glossy Paper 2

• Tray 5

Glossy Paper 1, Glossy Paper 2

• Bypass Tray

Glossy Paper 1, Glossy Paper 2

• Default: Glossy Paper 1

Coated Paper Setting

You can select the coated paper printing mode.

• Tray 1

Coated Paper 1, Coated Paper 2, Coated Paper 3, Coated Paper 4, Coated Paper 5, Coated
Paper 6, Coated Paper 7

• Tray 2

Coated Paper 1, Coated Paper 2, Coated Paper 3, Coated Paper 4, Coated Paper 5, Coated
Paper 6, Coated Paper 7

• Tray 3

Coated Paper 1, Coated Paper 2, Coated Paper 3, Coated Paper 4, Coated Paper 5, Coated
Paper 6, Coated Paper 7

• Tray 4

Coated Paper 1, Coated Paper 2, Coated Paper 3, Coated Paper 4, Coated Paper 5, Coated
Paper 6, Coated Paper 7
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• Tray 5

Coated Paper 1, Coated Paper 2, Coated Paper 3, Coated Paper 4, Coated Paper 5, Coated
Paper 6, Coated Paper 7

• Bypass Tray

Coated Paper 1, Coated Paper 2, Coated Paper 3, Coated Paper 4, Coated Paper 5, Coated
Paper 6, Coated Paper 7

• Default: Coated Paper 1

Label Paper Setting

You can select the label paper printing mode.

• Label Paper 1, Label Paper 2, Label Paper 3

• Default: Label Paper 1

Envelope Setting

You can select the envelope printing mode.

• Bypass Tray

Envelope 1, Envelope 2, Envelope 3

• Default: Envelope 1

Replacement Alert

Use this function to specify the timing to notify user when supplies need to be replaced. Settings can
be made separately for photo conductor unit, intermediate transfer unit, or fusing unit.

• Photoconductor Unit

Notify Sooner, Normal, Notify Later

• Default: Normal

• Intermediate Transfer Unit

Notify Sooner, Normal, Notify Later

• Default: Normal

• Fusing Unit

Notify Sooner, Normal, Notify Later
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• Default: Normal

Supply End Option

Use this function to specify the whether or not to continue printing when the following supplies end:
photo conductor unit, intermediate transfer unit, fusing unit.

• Continue Printing

• Stop Printing

• Default: Continue Printing

Display Supply Info

You can select whether or not to display the amount of toner on the initial screen.

• On

• Off

• Default: On

Menu Protect

You can select whether or not to protect menu. When you enable this setting, specify protection level.

• Level 1

• Level 2

• Off

• Default: Level 2

• If you would like to lower the protection level, disable this setting or select Level 1.

• You may not be able to change this setting depending on the setting of the printer.

List/Test Print Lock

You can select whether or not to prohibit List/Test printing.

• On

• Off

• Default: Off

• You may not be able to change this setting depending on the setting of the printer.

Unit of Measure

You can select whether to use "mm" or "inch" when specifying the size of custom sized paper.
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• mm

• inch

• Default:

• : mm

• : inch

Panel Key Sound

You can select whether or not to sound the beeper when the control panel is pressed.

• On

• Off

• Default: Off

Warm-up Beeper

You can select whether or not to sound the beeper when the printer has completed a warm-up process.

• On

• Off

• Default: On

Display Contrast

You can specify the density of the display.

Key Repeat

You can specify whether or not to scroll the display panel when the [ ] or [ ] key is held down. When
you enable this setting, specify the scroll speed. (If repeat time is set to "Long", scroll speed becomes
slow.)

• Do not Repeat

• Normal

• Repeat Time: Medium

• Repeat Time: Long

• Default: Off
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Timer Settings

Auto Reset Timer

Specify whether or not to cancel settings made if no operation has been performed for a certain period
of time while changing configuration using the control panel. When set to on, specify how long the
printer is to wait before resetting configuration.

• On

• Off

• Default: On

Set Date

You can set the date of the printer’s internal clock using the [ ] or [ ] key.

Set Time

You can set the time of the printer’s internal clock using the [ ] or [ ] key.

HD Management

Specify the settings related to deletion of data saved on the hard disk.

Delete All Temporary Jobs

Use this function to delete all temporary documents saved on the hard disk (Sample Print, Locked Print
and Hold Print data) at once.

Delete All Stored Jobs

Use this function to delete all Stored Print data saved on the hard disk at once.

Auto Delete Temporary Jobs

Specify whether or not to automatically delete temporary documents saved on the hard disk (Sample
Print, Locked Print and Hold Print data). When set to on, specify how long the printer is to wait before
deleting the documents.

• On

• Off

• Default: Off

• If you enable this setting, specify the timer in hours. (Default: 8 hours)

Auto Delete Stored Jobs

Specify whether or not to automatically delete Stored Print data saved on the hard disk. When set to
on, specify how long the printer is to wait before deleting the documents.

• On
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• Off

• Default: On

• If you enable this setting, specify the timer in days. (Default: 3 days)
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List/Test Print Menu
You can print lists showing configurations on printer or the paper printings.

Also, you can check the types and characters of all the printable fonts.

Printing a configuration page

Follow the procedure below to print the configuration page.

• The configuration page is printed on A4 or Letter (81/2"×11") size paper, so load them in the same
paper tray.

1. Press the [Menu] key.
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The menu screen appears.

2. Press the [ ] or [ ] key to display [List/Test Print], and then press the [OK] key.

3. Press the [ ] or [ ] key to display [Config. Page], and then press the [OK] key.

After the configuration page is printed out, the screen returns to List/Test print menu.

4. Press the [Online] key.

The initial screen appears.

Interpreting the configuration page

System Reference

Unit Number

Shows the serial number assigned to the board by its manufacturer.

Pages Printed

Shows the total number of pages printed by the printer to date.
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Firmware Version

• Printer

Shows the version number of the printer controller firmware.

• Engine

Shows the version number of the printer engine firmware.

• NIB

Shows the version number of the network interface board.

Device Connection

Shows the names of device options installed in the printer.

HDD:Font / Macro Download

Shows the hard disk status

Printer Language

Shows the version number of the printer language.

Connection Equipment

Shows the options attached to the printer.

Paper Input

Shows the current Paper Input settings.

• For details, see p.171 "Paper Input Menu".

Maintenance

Shows the current Maintenance settings.

• For details, see p.175 "Maintenance Menu".

System

Shows the current System settings.

• For details, see p.188 "System Menu".

Machine Modes

Shows the current Machine Modes settings.

• For details, see p.193 "Print Settings Menu".

PCL Menu

Shows the current PCL settings.
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• For details, see p.193 "Print Settings Menu".

PS Menu

Shows the current PS settings.

• For details, see p.193 "Print Settings Menu".

PDF Menu

Shows the current PDF settings.

• For details, see p.193 "Print Settings Menu".

Host Interface

Shows the current Host Interface settings.

When DHCP is active on the network, the IPv4 address, subnet mask and gateway address appear
in parentheses.

• For details, see p.206 "Host Interface Menu".

Interface Information

Interface information is displayed.

List/Test Print menu parameters

This section explains about parameters that can be set on the List/Test Print menu.

Multiple Lists

You can print the configuration page and error log, network summary and supply list.

Config. Page

You can print the current configuration of the printer.

Error Log

You can print an error report.

Network Summary

You can print the network device status.

Supply Info List

You can print the supply status.
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Menu List

You can print a menu list showing all available menus.

Color Demo Page

You can print a color demonstration page.

PCL Config. Page

You can print the current configuration and installed PCL font list.

PS Config. Page

You can print the current configuration and installed PostScript font list.

PDF Config. Page

You can print the current configuration and installed PDF font list.

Hex Dump

You can print the data sent by the computer using Hex Dump.

Operations Test

Use this to check the printer and its options for operability, including paper feed and output, punching
and stapling. Only settings of installed options are displayed. If a specified function fails, the printer
displays a message and stops printing. If the test is successful, the printer prints black frames.
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System Menu
The System Menu allows you to set the printer's basic functions. Although you can operate the printer using
the default settings, you can also change its settings to better suit your printing needs. Changes made to
settings remain effective after power off.

Changing the system menu

Follow the procedure below to change the settings for Energy Saver Timer.

1. Press the [Menu] key.

ATU050S

The menu screen appears.

2. Press [ ] or [ ] key to display [System], and then press the [OK] key.

3. Press [ ] or [ ] key to display [Energy Saver 2], and then press the [OK] key.

4. Press the [ ] or [ ] key to select [Energy Saver Timer], and then enter the [OK] key.

5. Press the [ ] or [ ] key to select the lead time needed to switch to the Energy Saver mode.

6. Press the [OK] key.

Wait for one second. The Energy Saver 2 screen appears.

7. Press the [Online] key.

The initial screen appears.

System menu parameters

This section explains about parameters that can be set on the System menu.

Print Error Report

Select whether or not to print an error report when a printer error or memory error occurs.

• Off
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• On

• Default: Off

Auto Continue

Specify whether or not to continue printing after a system error. When you enable this setting, specify
how long the printer is to display error before resuming print.

• Off

• Immediate

• 1 minute

• 5 minutes

• 10 minutes

• 15 minutes

• Default: Off

• When this setting is set to on, and a certain error occurs in the printer while printing out, the job
might be cancelled. When a job is cancelled due to error, the printer automatically begins the
next job in the queue.

Memory Overflow

You can specify whether or not to print a memory overflow error report.

• Do not print

• Error Report

• Default: Do not print

Printer Language

You can specify the printer language.

• Auto

• PCL

• PS

• PDF

• Default: Auto
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Sub Paper Size

Specify whether or not to use paper of the alternate size automatically, if paper of the specified size
is not loaded. When this setting is set to off, the printer uses paper of any size loaded in the specified
tray.

• Auto

• Off

• Default: Off

Default Printer Lang.

Select the printer language to use when the printer fails to detect the printer language.

• PCL

• PS

• PDF

• Default: PCL

Energy Saver 1

Select whether or not to switch to Energy Saver 1 mode.

• On

• Off

• Default: Off

• When set to on, the printer switches to Energy Saver 1 mode after printing is complete. Electric
power consumption is greater than in Energy Saver 2 mode, but the printer returns to Ready
mode in about 10 seconds.

Energy Saver 2

In Energy Saver mode, electric power consumption is reduced.

Energy Saver On/Off

Select whether or not to switch to Energy Saver 2 mode.

• On

• Off

• Default: On

• When the printer switches to Energy Saver 2 mode, the Power indicator is unlit, but the
Online indicator remains lit.

5. Making Printer Settings Using the Control Panel

190

5



Energy Saver Timer

Specify the lead time needed to switch to Energy Saver mode.

• 1 minute

• 5 minutes

• 15 minutes

• 30 minutes

• 45 minutes

• 60 minutes

• Default: 5 minutes

Memory Usage

Select memory to be used from Font Priority or Frame Priority.

• Font Priority

• Frame Priority

• Default : Frame Priority

B&W Page Detect

Specify whether to recognize black-and-white images by page or by document. Black-and-while
recognition function allows the printer to print monochrome images in monochrome mode even if
color printing is specified.

• Per Page

• Per Job

• Default: Per Job

Spool Printing

Specify whether or not to complete spooling before starting to print.

• On

• Off

• Default: Off

• Spooling stores a sent print job temporarily in the printer, and then prints it.
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Notify by Email

Specify whether or not to send an error message to a preset e-mail address when an error occurs in
the printer.

• Off

• On

• After changing the setting, turn off the power of the printer briefly, and then turn it on again.

• Default: On

• For information, see Web Image Monitor Help.
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Print Settings Menu
The System Menu allows you to set conditions for printing.

Changing the Print Settings menu

Follow the procedure below to change the Bypass Tray Priority.

1. Press the [Menu] key.
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The menu screen appears.

2. Press [ ] or [ ] key to display [Print Settings], and then press the [OK] key.

3. Press [ ] or [ ] key to display [Machine Modes], and then press the [OK] key.

4. Press the [ ] or [ ] key to select [Bypass Tray Priority], and then enter the [OK] key.

5. Press the [ ] or [ ] key to select the desired setting item, and then press the [OK] key.

Wait for one second. The Machine Modes screen appears.

6. Press the [Menu] key.

The initial screen appears.

Print Settings menu parameters

This section explains about parameters that can be set on the Print Settings menu.

Machine Modes

Copies

Specify the number of copies to print.

If the number of copies to print is specified by command or the printer driver, this setting is
overridden.

• 1 to 999
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Page Size

Specify the default paper size.

: A3, A4, A5, A6, B4 JIS, B5 JIS, B6 JIS, C5 Env., C6 Env., DL Env., 12 × 18, 11
× 17, 81/2 × 14, 81/2 × 13, 81/2 × 11, 81/4 × 13, 8 × 13, 71/4 × 101/2, 51/2 × 81/2,
41/8 × 91/2, 37/8 × 71/2, 8K, 16K, Custom Size

: 12 × 18, 11 × 17, 81/2 × 14, 81/2 × 13, 81/2 × 11, 81/4 × 13, 8 × 13, 71/

4 × 101/2, 51/2 × 81/2, 41/8 × 91/2, 37/8 × 71/2, A3, A4, A5, A6, B4 JIS, B5 JIS, B6 JIS,
C5 Env., C6 Env., DL Env., 8K, 16K, Custom Size

• Default:

• : A4

• : 81/2 × 11

• The default paper size is used when the paper size is not specified in the print data.

Edge to Edge Print

Select to whether or not to print using the whole area of paper, leaving no edge borders.

• Off

• On

• Default: Off

Duplex

Select whether or not to print on both sides of a sheet. When set to on, specify the binding method.

• Off

• Long Edge Bind

• Short Edge Bind

• Default: Off

Output Tray

Specify output tray to be used when the output tray is not specified in the print data.

• Standard Tray

• Finisher Upper Tray

• Finisher Shift Tray

• Default: Standard Tray

• Finisher trays appear only when an optional finisher is attached.
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Job Separation

Select whether to use job separation function when paper is output to an output tray capable of
job separation.

• On

• Off

• Default: Off

Rotate by 180 Degrees

Select whether or not to rotate image by 180 degrees when printing.

• On

• Off

• Default : Off

Blank Page Print

Select whether or not to print blank pages.

• On

• Off

• Default: On

Letterhead Setting

Specify the letterhead printing mode.

• Off

• Auto Detect

• On (Always)

• Default: Off

Bypass Tray Priority

When paper size/type setting does not match between the printer driver and the printer, you
can select which setting is used.

• Driver/Command

• Machine Settings

• Default: Driver/Command
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Tray Switching

Select whether or not to automatically switch to a suitable tray, when the setting of the current
tray does not match the paper size/type specified by the printer driver.

• Off

• On

• Default: Off

PCL Menu

You can set conditions when using PCL for printing.

Orientation

Select the page orientation.

• Portrait

• Landscape

• Default: Portrait

Form Lines

Specify the number of lines per page between 5 and 128.

• Default:

• : 60

• : 64

• The default paper size is used when the paper size is not specified in the print data.

Font Source

Specify the location of the default font.

• Resident

• RAM

• HDD

• SD

• Default: Resident

• When you select RAM, you can select only fonts downloaded to the printer RAM.

• When you select HDD, you can select only fonts downloaded to the optional hard disk.

• When you select SD, you can select only fonts downloaded to the SD card.
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Font Number

Specify the ID of the default font you want to use.

• 0 to 63 (Internal)

• 1 to X (Download; “X” is the number of downloaded fonts)

• Default: 0

Point Size

Specify the point size you want to use for the default font between 4 and 999.75 in 0.25
increments.

• Default: 12.00 points

• This setting is effective only for a variable-space font.

Font Pitch

Specify the number of characters per inch you want to use for the default font between 0.44 and
99.99 in 0.01 increments.

• Default: 10.00 pitch

• This setting is effective only for fixed-space fonts.

Symbol Set

You can specify the character set for the default font. Available sets are as follows:

Roman-8, ISO L1, ISO L2, ISO L5, PC-8, PC-8 D/N, PC-850, PC-852, PC8-TK, Win L1, Win
L2, Win L5, Desktop, PS Text, VN Intl, VN US, MS Publ, Math-8, PS Math, VN Math, Pifont,
Legal, ISO 4, ISO 6, ISO 11, ISO 15, ISO 17, ISO 21, ISO 60, ISO 69, Win 3.0

• Default: PC-8

Courier Font

Select the type of courier font.

• Regular

• Dark

• Default: Regular

Ext. A4 Width

Select whether or not to extend the width of the printable area of A4 sheets, by reducing side
margins.
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• On

• Off

• Default: Off

Append CR to LF

Select whether or not to append a CR code to each LF code to print text data clearly.

• Off

• On

• Default: Off

Resolution

You can specify the print resolution in dots per inch.

• 300 dpi

• 600dpi Fast

• 600dpi Standard

• 600dpi High Quality

• Default: 600dpi Standard

PS Menu

You can set conditions when using PostScript for printing.

Data Format

Select the data format from Binary Data or TBCP.

This setting is effective when using a parallel, USB, or EtherTalk connection.

When using a parallel or USB connection, the print job is canceled if binary data is sent from
the printer driver.

When using an Ethernet connection, the print job is canceled if:

• The printer driver data format is TBCP and the data format selected using the control panel
is Binary Data.

• The printer driver data format is binary and the data format selected using the control panel
is TBCP.

• Default: TBCP
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Resolution

Select the resolution.

• 600dpi Fast

• 600dpi Standard

• 600dpi High Quality

• Default: 600dpi Standard

Color Setting

Specify the RGB setting.

• None

• Fine

• Super Fine

• Default: Super Fine

Color Profile

Specify the color profile.

• Auto

• Presentation

• Solid Color

• Photographic

• User Setting

• Default: Auto

PDF Menu

You can set conditions when using PDF for printing.

Change PDF Password

Specify the password for the PDF file executing PDF Direct Print.

• If you do not set a PDF password, this menu does not appear.

• The password can be set using Web Image Monitor, but must be sent through the network.
For increased security, use this menu on the control panel to set the password directly.

PDF Group Password

Specify a group password specified using DeskTopBinder Lite.
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• If you do not set a PDF group password, this menu does not appear.

• When you use a group password, the optional data protection unit must be installed.

• The password can be set using Web Image Monitor, but must be sent through the network.
For increased security, use this menu on the control panel to set the password directly.

• Default: no password set

Resolution

Specify the resolution for the PDF file executing PDF Direct Print.

• 600dpi Fast

• 600dpi Standard

• 600dpi High Quality

• Default: 600dpi Standard

Color Setting

Specify the RGB setting for the PDF file executing PDF Direct Print.

• None

• Fine

• Super Fine

• Default: Super Fine

Color Profile

Specify the color profile for the PDF file executing PDF Direct Print.

• Auto

• Presentation

• Solid Color

• Photographic

• User Setting

• Default: Auto
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Security Options Menu
The System Menu allows you to set conditions for printing.

Changing the Security Options menu

Follow the procedure below to erase data inside memory.

• This setting appears only when the optional security card is installed.

1. Press the [Menu] key.
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The menu screen appears.

2. Press [ ] or [ ] key to display [Security Options], and then press the [OK] key.

3. Press [ ] or [ ] key to display [Extended Security], and then press the [OK] key.

4. Press the [ ] or [ ] key to select [Erase All Memory], and then enter the [OK] key.

5. Press the [ ] or [ ] key to select the erase method, and then press the [OK] key.

When you select [Random Numbers], enter overwrite times.

All memories will be erased.

6. When the confirmation screen appears, press the [Exit] key.

7. Turn off the power of the printer.

Security Options menu parameters

This section explains about parameters that can be set on the security options menu.

Extended Security

Depending on the setting of the printer, some of the settings listed below may not appear.
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Driver Encryption Key

Specify the driver encryption key.

Encrypt Address Book

Select whether or not to encrypt the printer’s address book data.

• On

• Off

• Default: Off

Restrict User Info.Display

Select whether or not to display user information as “********” when checking job information
without being authenticated through user authentication.

• On

• Off

• Default: Off

Enhance File Protection

Select whether or not to automatically lock password-protected print files if an invalid password
is entered ten times. When a file is locked, you cannot select them even if the correct password
is entered.

• On

• Off

• Default: Off

Settings by SNMP v1 and v2

Select whether or not to prohibit changes to the printer settings through access using SNMPv1,
v2 protocol.

• Prohibit

• Do not prohibit

• Default: Do not prohibit

Simple Encryption

Select whether or not to use simple, or restricted, encryption when enhanced encryption cannot
be used.

• Restrict
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• Do not Restrict

• Default: Do not Restrict

Authenticate Current Job

Select whether or not authentication is required for operations such as canceling jobs. If set to
Login Privilege, only authorized users or machine administrator can operate the printer. If set to
Access Privilege, users who sent a print job or the machine administrator can operate the printer.

• Login Privilege

• Access Privilege

• Off

• Default: Off

Password Policy

Specify the format of passwords: types of characters to be used and minimum length.

Valid characters for passwords are upper-case letters, lower-case letters, decimal numbers, and
symbols such as #. If complexity is set to Level 1, passwords must use two types of these
characters; if set to Level 2, three types.

• Complexity Setting

Level 1, Level 2, Do not Restrict

• Default: Do not Restrict

• Minimum Character No.

Between 0 to 32

• Default: 0

• If set to 0, minimum length is not specified.

@Remote Service

Select whether or not to prohibit @Remote service.

• Prohibit

• Do not prohibit

• Default: Do not prohibit

• If you would like to set to Prohibit, contact your service representative.
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Service Mode Lock

Select whether or not to prohibit entering Service mode.

• On

• Off

• Default: Off

• This setting may not appear depending on the setting of the printer.

Firmware Version

Displays the firmware version of the printer.

Network Security Level

Specify the network security level.

• Level 0

• Level 1

• Level 2

• Default: Level 0

Auto Erase Memory Setting

Select whether or not to automatically delete memory. When set to on, select the deletion method. If
the deletion method is Random Numbers, also specify the overwrite times.

• On

HD Erase Method: NSA, DoD, Random Numbers

No. of Overwrites: Between 1 to 9

• Off

• Default: Off

• This setting appears only when the optional security card is installed.

Erase All Memory

Select to delete all data inside the memory. When deleting memory, select the deletion method. If the
deletion method is Random Numbers, also specify the overwrite times.

• HD Erase Method

NSA, DoD, Random Numbers

• No. of Overwrites

Between 1 to 9
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• This setting appears only when the optional security card is installed.

Transfer Log Setting

You can select whether or not to send log information to the log collection server.

• On (Only available from the log collection server.)

• Off

• Default: Off

Security Options Menu
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Host Interface Menu
You can set configurations about network connections and communication when using parallel connection
between the printer and the computer. The changed configuration holds even if the printer is turned off.

Changing the Host Interface menu

Follow the procedure below to change the I/O Timeout setting.

1. Press the [Menu] key.

ATU050S

The menu screen appears.

2. Press the [ ] or [ ] key to display [Host Interface], and then press the [OK] key.

3. Press the [ ] or [ ] key to display [I/O Timeout], and then press the [OK] key.

4. Press the [ ] or [ ] key to select the lead time needed to end a printing operation, and then
press the [OK] key.

Wait for one second. The Host Interface menu appears.

5. Press the [Menu] key.

The initial screen appears.

Host Interface menu parameters

This section explains parameters that can be set on the Host Interface menu.

I/O Buffer

Select the size of I/O Buffer. Normally it is not necessary to change this setting.

• 128 KB

• 256 KB
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• Default: 128 KB

I/O Timeout

Specify how many seconds the printer should wait before ending a print job. If printing operation is
frequently interrupted by data from other ports, you can increase the timeout period.

• 10 seconds

• 15 seconds

• 20 seconds

• 25 seconds

• 60 seconds

• Default: 15 seconds

Network

You can make network-related settings.

• This menu appears only when the optional IEEE 802.11b interface unit is installed.

• For details, see Hardware Guide.

Machine IPv4 Address

Select whether to set the IPv4 address automatically or manually.

• Auto-Obtain (DHCP)/Specify (Default: Auto-Obtain (DHCP))

When DHCP is set to on, the IPv4 address, subnet mask address, and gateway address
cannot be changed. To change them, set DHCP to off. Contact your administrator for
information about the network configuration.

• IP Add.

Manually specify the IPv4 address.

• Default: 011.022.033.044

• Subnet M

Manually specify the subnet mask.

• Default: 0.0.0.0

• Gateway

Host Interface Menu
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Manually specify the gateway address.

• Default: 0.0.0.0

IPv6 Stateless Setting

Select whether to enable or disable IPv6.

• Active

• Inactive

• Default: Active

NW Frame Type

Specify the frame type for NetWare.

• Auto Select

• Ethernet II

• Ethernet 802.2

• Ethernet 802.3

• Ethernet SNAP

• Default: Auto Select

Effective Protocol

Specify the effective protocol.

• IPv4

Active, Inactive

• Default: Active

• IPv6

Active, Inactive

• Default: Inactive

• NetWare

Active, Inactive

• Default: Active
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• SMB

Active, Inactive

• Default: Active

• AppleTalk

Active, Inactive

• Default: Active

Ethernet Speed

Specify the network speed to operate the printer.

• Auto Select

• 10Mbps Half Duplex

• 10Mbps Full Duplex

• 100Mbps Half Duplex

• 100Mbps Full Duplex

• Default: Auto Select

LAN Type

Select Ethernet or IEEE 802.11b wireless LAN.

• Ethernet

• IEEE 802.11b

• Default: Ethernet

• This menu appears only when the optional 802.11b interface unit is installed.

IEEE 802.11b

Configure settings for wireless LAN. This menu appears only when the optional 802.11b
interface unit is installed.

Communication Mode

Specify the transmission mode for IEEE 802.11b.

• 802.11 Ad hoc

• Infrastructure

• Ad hoc

Host Interface Menu
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• Default: 802.11 Ad hoc

• Transmission mode can also be set using a Web Image Monitor. For details, see Web
Image Monitor Help.

SSID Setting

Specify the SSID in the infrastructure mode and the 802.11 Ad hoc modes.

• Default: blank (ASSID)

• Select [?] to enter [/] for the SSID. Also, [¥] appears when printing the configuration page,
read it as [/].

• Characters used are ASCII 0x20-0x7e (32 bytes).

• An SSID is set automatically to the nearest access point if no SSID has been set.

• If no SSID has been set for the 802.11 Ad hoc mode, an SSID is set automatically and the
same SSID is used for the 802.11 Ad hoc mode and the infrastructure mode.

• If blank is specified in SSID for 802.11b Ad hoc mode or Ad hoc mode, “ASSID” appears.

• An SSID can also be set using Web Image Monitor. For details, see Web Image Monitor
Help.

Channel

Select channels: 1-13 ( )/1-11 ( ).

• Default: 11 (  and )

Security Type

Select whether to enable or disable encryption. When encryption is enabled, specify the security
type.

• Off

• WEP

Hex:10/26,ASCII:5/13 Digits

• WPA

Encrypt Method (TKIP, CCMP(AES), Authentication Method (WPA-PSK, WPA(802.1x))

• Default: Off

• The WEP key can be entered using a hexadecimal number or an ASCII character sequence.

• The WPA-PSK can be entered using an ASCII character sequence.
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• When using 64 bit WEP, up to 10 hexadecimal or 5 ASCII characters can be entered.
When using 128 bit WEP, up to 26 hexadecimal or 13 ASCII characters can be entered.

• The WEP key can also be set using Web Image Monitor. For details, see Web Image
Monitor Help.

Wireless LAN Signal

You can check the signal strength when using wireless LAN.

Communication Speed

You can select the transmission speed for IEEE 802.11b.

• Auto

• 11 Mbps

• 5.5 Mbps

• 2 Mbps

• 1 Mbps

• Default: Auto

Restore Defaults

Reset the wireless LAN to default.

USB Setting

Select speed for USB interface.

• Auto

• Full Speed

• Default: Auto
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Language Menu
You can set language displayed on the menu.

Changing the language menu

Follow the procedure below to change the interface language.

1. Press the [Menu] key.

ATU050S

The menu screen appears.

2. Press the [ ] or [ ] key to display [Language], and then press the [OK] key.

3. Press the [ ] or [ ] key to select the language, and then press the [OK] key.

Wait for one second. The language menu screen appears.

4. Press the [Menu] key.

The initial screen appears.

Language menu parameters

You can select the language you use. Available languages are as follows:

English, German, French, Italian, Dutch, Swedish, Norwegian, Danish, Spanish, Finnish, Portuguese,
Czech, Polish, Hungarian, Russian, Chinese*1.

*1 Chinese only

• Default: English
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6. Monitoring and Configuring the
Printer

Using Web Image Monitor
Using Web Image Monitor, you can check the printer status and change settings.

Available operations

The following operations can be remotely performed using Web Image Monitor from a client
computer.

• Displaying printer status or settings

• Checking the print job status or history

• Interrupting currently printing jobs

• Resetting the printer

• Managing the Address Book

• Making printer settings

• Making e-mail notification settings

• Making network protocol settings

• Making security settings

Configuring the printer

To perform the operations from Web Image Monitor, TCP/IP is required. After the printer is configured
to use TCP/IP, operations from Web Image Monitor become available.

Recommended Web browser

• Windows:

Internet Explorer 5.5 SP2 or higher

Firefox 1.0 or higher

• Mac OS:

Firefox 1.0 or higher

Safari 1.0, 1.2, 2.0(412.2) or higher

• Safari cannot be used on Mac OS X 10.4.1.

• Display and operation problems can occur if you do not enable JavaScript and cookies, or if you are
using a non-recommended Web Browser.
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• If you are using a proxy server, change the Web browser settings. Contact your administrator for
information about the settings.

• If you click your browser's back button but the previous page does not appear, click the browser's
refresh button and try again.

• Printer information is not automatically updated. To perform an update, click [Refresh] in the display
area.

• We recommend using Web Image Monitor in the same network.

• You cannot access to the printer from outside the firewall.

• When using the printer under DHCP, the IPv4 address may be automatically changed by the DHCP
server settings. Enable DDNS setting on the printer, and then connect using the printer's host name.
Alternatively, set a static IPv4 address to the DHCP server.

• If the HTTP port is disabled, connection to the printer using the printer's URL cannot be established.
SSL setting must be enabled on this printer. For details, consult your administrator.

• When using the SSL encryption protocol, enter "https://(printer's address)/". Internet Explorer must
be installed on your computer. Use the most recent available version. We recommend Internet Explorer
6.0 or later.

• When you are using Firefox, fonts and colors may be different, or tables may be out of shape.

Displaying Top Page

This section explains the Top Page and how to display Web Image Monitor.

1. Start your Web browser.

2. Enter "http://(printer's address)/" in the address bar of a Web browser.

Top Page of Web Image Monitor appears.

If the printer's host name has been registered on the DNS or WINS server, you can enter it.

When setting SSL, a protocol for encrypted communication, under environment which server
authentification is issued , enter "https://(printer's address)/".

Every Web Image Monitor page is divided into the following areas:

6. Monitoring and Configuring the Printer
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ATU402S

1

2 3

4

5

1. Menu area

If you select menu, it's content will be shown on the work area, or the sub area.

2. Tab area

Details about each menu appears.

3. Header area

The dialog box for switching to the user mode and administrator mode appears, and each mode's menu will be
displayed.

The link to help and dialog box for keyword search appears.

4. Help

Use Help to view or download Help file contents.

5. Display area

Displays the contents of the item selected in the menu area.

Machine information in the display area is not automatically updated. Click [Refresh] at the upper right in the
display area to update the machine information. Click the Web browser's [Refresh] button to refresh the entire
browser screen.

• For details the printer's host name has been registered on the DNS or WINS server, see p.373
"Cautions to Take When Using in a network".

When User Authentication is Set

Login (using Web Image Monitor)

Follow the procedure below to log on when user authentication is set.

1. Click [Login].

Using Web Image Monitor
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2. Enter a login user name and pass word, and then click [Login].

For details about the login user name and password, consult your network administrator.

• For user code authentication, enter a user code in [User Name], and then click [OK].

• The procedure may differ depending on the Web browser used.

Log Off (using Web Image Monitor)

Follow the procedure below to log on when user authentication is set.

Click [Logout] to log off.

• After you log on and change configurations, make sure to always log off..

About Menu and Mode

There are two modes available with Web Image Monitor: guest mode and administrator mode.

Displayed items may differ depending on the printers.

About Guest Mode

In the guest mode, printer status, settings, and print job status can be viewed, but the printer settings
cannot be changed.

1

3
2

4

ATU403S

1. Home

The [Status], [Device Info], and [Counter] tab are displayed. Details of the tab menu are displayed on the work
area.

2. Printer: Print Jobs

Allows you to display list of Sample Print, Locked Print, Hold Print, and Stored Print jobs.
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3. Job

Display all print files.

4. Configuration

Display current printer and network settings.

Administrator Mode

In the administrator mode, you can configure various printer settings.

ATU404S

1
2

4

7

3

5

6

1. Home

The [Status], [Device Info], and [Counter] tab are displayed. Details of the tab menu are displayed on the work
area.

2. Printer: Print Jobs

Allows you to display list of Sample Print, Locked Print, Hold Print, and Stored Print jobs.

3. Job

Display all print files.

4. Address Book

User information can be registered, displayed, changed, and deleted.

5. Configuration

Make system settings for the printer, interface settings, and security.

6. Reset Device

Click to reset the printer. If a print job is being processed, the printer will be reset after the print job is completed.
This button is located on Top Page.

7. Reset Print Job

Click to reset current print jobs and print jobs in queue. This button is located on Top Page.

Access in the Administrator Mode

Follow the procedure below to access Web Image Monitor in the administrator mode.

Using Web Image Monitor
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1. On Top Page, click [Login].

The dialog box for entering the user name and password appears.

2. Enter your login user name and password, and then click [Login].

For details about the login user name and password, consult your administrator.

Displaying Web Image Monitor Help

When using Help for the first time, clicking either [Help] in the header area or the icon marked "?" in the
display area makes the following screen appear, in which you can view Help in two different ways, as
shown below:

Viewing Help on our Web site

Downloading Help to your computer

Downloading and Checking Help

You can download Help to your computer. To view Help without connecting to the Internet, enter the
path to your local Help files in your browser's URL bar.

• By clicking [Help] in the header area, the contents of Help appear.

• You can view Help for a setting by clicking "?", the Help icon, in the display area.

Downloading Help

1. In the [OS] list, select the operating system.

2. In the [Language] list, select the language.

3. Click [Download].

4. Download Help by following the instructions on the screen.

5. Store the downloaded compressed file in a location, and then decompress the file.

To view the downloaded Web Image Monitor Help, set the path to the location of the decompressed
file.

Linking the URL of the Help File to the Help Button

You can link the URL of the help file on a computer or Web server to the [Help] button.

1. Log on to Web Image Monitor in the administrator mode.

2. In the menu area, click [Configuration].

3. Click [Webpage].
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4. In the [URL] box, enter the URL of the help file.

For example, if you saved the file to a Web server, and the URL of the index file is "http://a.b.c.d/
HELP/EN/index.html", enter "http://a.b.c.d/HELP/".

5. Click [OK].

Using Web Image Monitor

219

6



Using SmartDeviceMonitor for Admin
Using SmartDeviceMonitor for Admin, you can monitor the network printers. Also, you can change the
configuration of the network interface board using TCP/IP or IPX/SPX.

• IPv6 cannot be used on this function.

Protocol stack provided with Operating System

• Windows 95/98/Me

TCP/IP

IPX/SPX

NetWare

NetWare Client32 for Windows 95

IntraNetWare Client for Windows 95

Novell Client for Windows 95/98/Me

• Windows 2000

TCP/IP

IPX/SPX

NetWare

Novell Client for Windows NT/2000/XP

• Windows Server 2003

TCP/IP

IPX/SPX

• Windows XP

TCP/IP

IPX/SPX

Novell Client for Windows NT/2000/XP

• Windows NT 4.0

TCP/IP

IPX/SPX

Client Service for NetWare

NetWare Client32 for Windows NT

IntraNetWare Client for Windows NT

Novell Client for Windows NT/2000/XP
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Available operations

The following functions are available:

• Printer Information function

• Display the network settings and detailed information of the printer.

• Display the number of pages printed under each user code.

• Display the status of print jobs sent from computers.

• Change the printer network settings.

• Device Settings function

• Lock some of the setting items on the control panel so that they cannot be changed using
the control panel.

• Select type of paper loaded in the paper trays.

• Energy Saver function

• Enable or disable the Energy Saver mode.

• System Status function

• Display the information such as when paper is depleted during printing on a computer.

• Groups function

• Monitor multiple printers at the same time. When there are multiple printers to manage, you
can create groups and classify the printers to facilitate management.

• You can customize printer status according to groups, and send status notification e-mail
to a computer.

Installing SmartDeviceMonitor for Admin

Follow the procedure below to install SmartDeviceMonitor for Admin.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Select an interface language, and then click [OK].

The default interface language is English.

4. Click “SmartDeviceMonitor for Admin” installation, and then click [Next>].

5. The software license agreement appears in the [License Agreement] dialog box.

After reading through its contents, click [Yes] if you agree, and then click [Next >].

6. Follow the instructions on the screen.

A message appears when the installation is complete.

Using SmartDeviceMonitor for Admin
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7. Click [OK].

• Auto Run may not work under certain operating system settings. In this case, launch "Setup.exe"
located on the CD-ROM root directory.

• If you are required to restart the computer after installing SmartDeviceMonitor for Admin, restart the
computer and continue the configuration.

• SmartDeviceMonitor for Admin supports following languages: Czech, Danish, German, English,
Spanish, French, Italian, Hungarian, Dutch, Norwegian, Polish, Portuguese , Finnish, Swedish,
Chinese Simple and Chinese Traditional.

Changing the Network Interface Board Configuration

Follow the procedure below to change the network interface board configuration using
SmartDeviceMonitor for Admin.

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [TCP/IP], [IPX/SPX] or [TCP/
IP SNMPv3]. A list of printers using the selected protocol appears.Select the protocol of the
printer whose configuration you want to change.

If you are using TCP/IP SNMPv3, enter the user authentication.

3. In the list, select a printer whose configuration you want to change.

4. On the [Tools] menu, click [NIB Setup Tool].

A Web browser opens and the dialog box for entering the user name and password for the Web
Image Monitor administrator appears.

NIB Setup Tool starts when the network interface board is default. Follow the instruction on the screen.

5. Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your administrator.

6. Configure settings using Web Image Monitor.

7. Click [Logout].

8. Quit Web Image Monitor.

9. Quit SmartDeviceMonitor for Admin.

• For details about Web Image Monitor, see p.213 "Using Web Image Monitor".

6. Monitoring and Configuring the Printer

222

6



Locking the Menus on the Printer's Control Panel

Follow the procedure below to lock the menus on the printer's control panel.

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [TCP/IP], [IPX/SPX] or [TCP/
IP SNMPv3].

A list of printers using the selected protocol appears.

Select the protocol of the printer whose configuration you want to change.

If you are using TCP/IP SNMPv3, enter the user authentication.

3. Select a printer.

4. On the [Tools] menu, point to [Device Settings], and then click [Lock Operation Panel Menu].

A Web browser opens and the dialog box for entering the password for the Web Image Monitor
administrator appears.

5. Enter the user name and password, and then click [Login].

For details about the user name and password, consult your administrator.

The [System] page of Web Image Monitor appears.

6. Enter required setting items, and then click [OK].

7. Click [Logout].

8. Quit Web Image Monitor.

9. Quit SmartDeviceMonitor for Admin.

• For details about setting items, see Help in the [Device Settings] on [Configuration] page.

Changing the Paper Type

Follow the procedure below to change the paper type.

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [TCP/IP], [IPX/SPX] or [TCP/
IP SNMPv3].

A list of printers using the selected protocol appears.

Select the protocol of the printer whose configuration you want to change.

If you are using TCP/IP SNMPv3, enter the user authentication.

3. In the list, select a printer whose configuration you want to change.

Using SmartDeviceMonitor for Admin
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4. On the [Tools] menu, point to [Device Settings], and then click [Select Paper Type].

A Web browser opens and the dialog box for entering the password for the Web Image Monitor
administrator appears.

5. Enter the user name and password, and then click [Login].

For details about the login user name and password, consult your administrator.

The [Paper] page appears.

Select a paper type in the [Paper Type] list for each tray.

6. Enter required setting items, and then click [OK].

7. Click [Logout].

8. Quit Web Image Monitor.

9. Quit SmartDeviceMonitor for Admin.

• For details about setting items, see Help in the [Device Settings] on [Configuration] page.

Managing User Information

Follow the procedure below to manage the user's information using SmartDeviceMonitor for Admin.

Prints jobs can be managed and functions restricted by user codes.

Starting User Management Tool

Follow the procedure below to start User Management Tool.

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [TCP/IP], [IPX/SPX] or [TCP/
IP SNMPv3].

A list of printers using the selected protocol appears.

Select the protocol of the printer whose configuration you want to change.

If you are using TCP/IP SNMPv3, enter the user authentication.

3. In the list, select a printer you want to manage.

4. On the [Tools] menu, click [User Management Tool].

The dialog box for entering the user name and password appears.

5. Enter the user name and password, and then click [OK].

Enter the same user name and password you enter to log on to the Web Image Monitor. For details
about the user name and password, consult your administrator.

User Management Tool starts.
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• For details about User Management Tool, see SmartDeviceMonitor for Admin Help.

Displaying the Number of Sheets Printed

Follow the procedure below to display the number of sheets printed under each user code.

1. Start SmartDeviceMonitor for Admin.

2. Click the [User Counter Information] tab of User Management Tool.

The number of pages printed under each user code appears.

3. Click [Exit] on the [File] menu to quit User Management Tool.

Exporting the information about the number of pages printed

Follow the procedure below to export the information of the number of pages printed under each user
code as a ".csv" file.

1. Start SmartDeviceMonitor for Admin.

2. Click the [User Counter Information] tab of User Management Tool.

3. On the [File] menu, click [Export User Statics List].

4. Specify the save location and file name, and then click [Save].

5. Click [Exit] on the [File] menu to quit User Management Tool.

Resetting the number of pages printed to 0

Follow the procedure below to reset the number of pages printed under each user code to 0.

1. Start SmartDeviceMonitor for Admin.

2. Click the [User Counter Information] tab of User Management Tool.

3. Click the user whose information you want to reset.

4. On the [Edit] menu, click [Reset User Counters].

5. Select the check box of the items you want to reset, and then click [OK].

A confirmation message appears.

6. Click [OK].

7. On the [Edit] menu, click [Apply Settings].

Changes are applied to information on the [User Counter Information] tab.

8. Click [Exit] on the [File] menu to quit User Management Tool.
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Restricting Functions

Follow the procedure below to restrict use of individual functions.

1. Start SmartDeviceMonitor for Admin.

2. Click the [User Counter Information] tab of User Management Tool.

3. On the [Edit] menu of User Management Tool, click [Restrict Access To Device].

4. Select the check box of the functions you want to restrict.

5. Click [OK].

A confirmation message appears.

6. Click [Yes].

The settings are applied.

Setting Applicable Functions to New Users

Follow the procedure below to add new users and set functions applicable to them.

1. Start SmartDeviceMonitor for Admin.

2. Click the [Access Control List] tab of [User Management Tool].

3. On the [Edit] menu, click [Add New User].

4. Enter the user code and user name.

5. Select the check box of the functions applicable to the new user.

If the check boxes are unavailable, there is no restriction to use that function. For details, see
SmartDeviceMonitor for Admin Help.

6. Click [OK].

The new user is added.

7. On the [Edit] menu, click [Apply Settings].

The settings are applied.

8. Click [Exit] on the [File] menu to quit User Management Tool.

• For details about setting restrictions, see SmartDeviceMonitor for Admin Help.

Configuring the Energy Saver Mode

Follow the procedure below to configure Energy Saver mode.

1. Start SmartDeviceMonitor for Admin.
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2. On the [Group] menu, point to [Search Device], and then click [TCP/IP], [IPX/SPX] or [TCP/
IP SNMPv3].

A list of printers using the selected protocol appears.

Select the protocol of the printer whose configuration you want to change.

If you are using TCP/IP SNMPv3, enter the user authentication.

3. Select the printer whose settings you want to make.

To make settings for all printers in the selected group, select no printer.

4. On the [Group] menu, point to [Energy Save Mode], point to [Set Individually] to make the
settings for only the selected printer or point to [Set By Group] to make the settings for all
printers in the selected group, and then click [On] or [Off].

5. Quit SmartDeviceMonitor for Admin.

• For details about the setting value for Energy Saver mode, see SmartDeviceMonitor for Admin Help.

Setting a Password

Follow the procedure below to set a password.

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [TCP/IP], [IPX/SPX] or [TCP/
IP SNMPv3].

A list of printers using the selected protocol appears.

Select the protocol of the printer whose configuration you want to change.

If you are using TCP/IP SNMPv3, enter the user authentication.

3. In the list, select a printer whose configuration you want to change.

4. On the [Tools] menu, click [NIB Setup Tool].

A Web browser opens and the dialog box for entering the password for the Web Image Monitor
administrator appears.

NIB Setup Tool starts when the network interface board is default. Follow the instruction on the screen.

5. Enter the login user name and password, and then click [Login].

For details about the user name and password, consult your administrator.

Top Page of Web Image Monitor appears.

6. Click [Configuration].

7. On the [Device Settings], click [Program/Change Administrator], and then change the
settings.

8. Click [OK].
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9. Quit Web Image Monitor.

10. Quit SmartDeviceMonitor for Admin.

Checking the Printer Status

Follow the procedure below to check printer status.

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [TCP/IP], [IPX/SPX] or [TCP/
IP SNMPv3].

The status of printers is indicated by icons in the list.

If you are using TCP/IP SNMPv3, enter the user authentication.

3. To obtain status details, click the printer in the list, and then click [Open] on the [Device]
menu.

The printer status appears in the dialog box.

4. Click [System] or[ Printer].

The printer status appears in the dialog box.

5. Quit SmartDeviceMonitor for Admin.

• For details about status icons and items in the dialog box, see SmartDeviceMonitor for Admin Help.

Changing Names and Comments

Follow the procedure below to change the names and comments of the printer.

1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [TCP/IP], [IPX/SPX] or [TCP/
IP SNMPv3]. A list of printers using the selected protocol appears.

Select the protocol of the printer whose configuration you want to change.

The status of printers is indicated by icons in the list.

If you are using TCP/IP SNMPv3, enter the user authentication.

3. Select a printer in the list.

4. On the [Tools] menu, click [NIB Setup Tool].

A Web browser opens and the dialog box for entering the password for the Web Image Monitor
administrator appears.

NIB Setup Tool starts when the network interface board is default. Follow the instruction on the screen.
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5. Enter the user name and password, and then click [Login].

Top Page of Web Image Monitor appears.

For details about the login user name and password, consult your administrator.

6. Click [Configuration].

7. Click [System] on the [Device Settings] area, and then change the settings.

8. Click [OK].

• In the [Device Name] box, enter a device name on the printer using up to 31 characters.

• In the [Comment] box, enter a comment on the printer using up to 31 characters.

9. Quit Web Image Monitor.

10. Quit SmartDeviceMonitor for Admin.
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Viewing and Deleting Spool Print Jobs
1. Start SmartDeviceMonitor for Admin.

2. On the [Group] menu, point to [Search Device], and then click [TCP/IP], [IPX/SPX] or [TCP/
IP SNMPv3].

A list of printer using the selected protocol appears.

Select the protocol of the printer whose configuration you want to change.

If you are using TCP/IP SNMP v3, enter the user authentication.

3. Select a printer in the list, and then click [Spool Printing Job List(Printer)] on the [Tools] menu.

A Web browser opens and the dialog box for entering the login user name and password for the
Web Image Monitor administrator appears.

4. Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your administrator.

[Spool Printing Job List] appears in the Web Image Monitor.

To delete the Spool Printing Job, select the document you want to delete and then click [Delete].

• To display [Spool Printing Job List], spool must be set to [Enable] on Web Image Monitor in advance.

• For details, see Help in the [Spool Printing Job List] area.
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Using SmartDeviceMonitor for Client
To view the status of printers using SmartDeviceMonitor for Client, configure SmartDeviceMonitor for
Client beforehand.

Monitoring Printers

Follow the procedure below to monitor the printer using SmartDeviceMonitor for Client.

1. Right-click the SmartDeviceMonitor for Client icon, point to [Properties], and then click
[Option...].

The [SmartDeviceMonitor for Client –Options] dialog box appears.

2. Select the printer you want to monitor, and then select the [To be Monitored] check box in
the Monitoring Information Settings area.

To display the printer status in the task tray using the SmartDeviceMonitor for Client icon, select the
[Displayed on Task Bar] check box.

3. Click [OK].

The dialog box closes and the configured printer is monitored.

• For details about status icons, see SmartDeviceMonitor for Client Help.

Checking the Printer Status

Follow the procedure below to check printer status using SmartDeviceMonitor for Client.

1. Start SmartDeviceMonitor for Client.

2. For status details, right-click the SmartDeviceMonitor for Client icon, and then click the
printer.

The printer status appears in the dialog box.

• For details about items in the dialog box, see SmartDeviceMonitor for Client Help.

When Using IPP with SmartDeviceMonitor for Client

When using IPP with SmartDeviceMonitor for Client, note the following:
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• The network printer can only receive one print job from SmartDeviceMonitor for Client at a time. While
the network printer is printing, another user cannot access it until the job is finished. In this case,
SmartDeviceMonitor for Client tries to access the network printer until the retry interval expires.

• If SmartDeviceMonitor for Client cannot access the network printer and times out, it will stop sending
the print job. In this case, you should cancel the paused status from the print queue window.
SmartDeviceMonitor for Client will resume access to the network printer. You can delete the print job
from the print queue window, but canceling a print job printed by the network printer might cause the
next job sent from another user to be incorrectly printed.

• If a print job sent from SmartDeviceMonitor for Client is interrupted and the network printer cancels
the job because something went wrong, send the print job again.

• Print jobs sent from another computer do not appear in the print queue window, regardless of protocol.

• If various users send print jobs using SmartDeviceMonitor for Client to network printers, the printing
order might not be the same as that in which the jobs were sent.

• An IP address cannot be used for the IPP port name because the IP address is used for the
SmartDeviceMonitor for Client port name.

• When setting SSL, a protocol for encrypted communication, under environment which server
authentification is issued, enter "https://(printer's address)/". Internet Explorer must be installed on
your computer. Use the highest version. Internet Explorer 6.0 or higher is recommended.

• If the [Security Alert] dialog box appears when accessing the printer using IPP to create or configure
an IPP port, or when printing, install the certificate. To select the certificate store location when using
Certificate Import Wizard, click [Place all certificates in the following store], and then click [Local
Computer] under [Trusted Root Certification Authorities].
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Printer Status Notification by E-Mail
Whenever a paper tray becomes empty or paper jams, a notification e-mail is sent to the registered
addresses.

You can make the timing and content settings for notification e-mail.

• Service call.

• Toner is empty.

• Toner is nearly empty.

• Paper has jammed.

• Cover is open.

• Paper tray is empty.

• Paper tray is nearly empty.

• Paper tray error.

• Output paper tray is full.

• Unit connection error.

• Duplex unit error.

• Photoconductor unit needs replacing.

• Photoconductor unit needs replacing soon.

• Waste toner bottle is full.

• Waste toner bottle is nearly full.

• Stapler has no staples.

• Fusing unit needs replacing.

• Fusing unit needs replacing soon.

• Intermediate transfer unit needs replacing.

• Intermediate transfer unit needs replacing soon.

• Punch waste receptacle is full.

• Memory for file storage is full soon.

• Log error.

1. Open a Web browser, and then enter "http://(printer's address)/" in the address bar.

Top Page of Web Image Monitor appears.

When setting SSL, a protocol for encrypted communication, under environment which server
authentication is issued, enter "https://(printer's address)/".
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2. Click [Login] on Top Page of Web Image Monitor.

The window for entering the login user name and password appears.

3. Enter the user name and password, and then click [Login].

For details about the login user name and password, consult your administrator.

4. In the menu area, click [Configuration].

5. On the [Device Settings] area, click [E-mail].

6. Make the following settings:

• Items in the Reception column: Make the necessary settings for sending and receiving e-mail.

• Items in the SMTP column: Configure the SMTP server. Check your mailing environment, and
then specify the necessary items. You can also perform mail authentication for the SMTP server.

• Items in the POP before SMTP column: Configure the POP server. Check your mailing
environment, and then specify the necessary items. You can also perform mail authentication for
the POP server.

• Items in the POP3/IMAP4 column: Configure the POP3 or IMAP4 server. Check your mailing
environment, and then specify the necessary items.

• Items in the E-mail Communication Port column: Configure the port to be used for access to the
mail server.

• Items in the E-Mail Notification Account column: Specify these items if you want to use on-demand
e-mail notification.

7. Click [OK].

Auto E-mail Notification

1. Click [Configuration] in the menu area, and then click [Auto E-mail Notification] on the
[Device Settings] area.

The dialog box for making notification settings appears.

2. Make the following settings:

• Items in Notification Message column: You can set this according to your needs, for example,
the printer's location, service representative contact information.

• Items in the Groups to Notify column: E-mail notification addresses can be grouped as required.

• Items in the Select Groups/Items to Notify column: Select groups for each notification type, such
as printer status and error.

To make detailed settings for these items, [Edit] next to [Detailed Settings of Each Item].

3. Click [OK].

4. Click [Logout].

5. Quit Web Image Monitor.
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On-demand E-mail Notification

1. Click [Configuration] in the menu area, and then click [On-demand E-mail Notification] on
the [Device Settings] area.

The dialog box for making notification settings appears.

2. Make the following settings:

• Notification Subject: Enter a text string to be added to the subject line of return e-mails.

• Items in Notification Message column: You can set this according to your needs, for example,
the printer's location, service representative contact information.

• Items in the Access Restriction to Information column: Select whether to restrict accesses based
on a specific category of information.

• Items in the Receivable E-mail Address/Domain Name Settings column: Enter an e-mail address
or domain name to use for requesting information by e-mail and to receive its return e-mail.

3. Click [OK].

4. Click [Logout].

5. Quit Web Image Monitor.

Mail authentication

You can configure mail authentication to prevent illegal use of the mail server.

SMTP Authentication

Specify SMTP authentication.

When mail is sent to the SMTP server, authentication is performed using the SMTP AUTH protocol by
prompting the mail originator to enter the user name and password. This prevents illegal use of the
SMTP server.

1. In the menu area, click [E-mail]

2. Make the following settings:

• SMTP Authentication: Enable or disable SMTP authentication.

• SMTP Auth. E-mail Address: Enter the e-mail address.

• SMTP Auth. User Name: Enter the SMTP account name.

• SMTP Auth. Password: To set or change the password for SMTP AUTH.

• SMTP Auth. Encryption: Select whether to encrypt the password or not.

[Auto Select]: If the authentication method is PLAIN, LOGIN, CRAM-MD5, or DIGEST-
MD5.

[Enable]: If the authentication method is CRAM-MD5 or DIGEST-MD5.
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[Disable]: If the authentication method is PLAIN or LOGIN.

3. Click [OK].

4. Click [Logout].

5. Quit Web Image Monitor.

POP before SMTP Authentication

Select whether to log on to the POP3 server before sending e-mail.

1. In the menu area, click [E-mail].

2. Make the following settings:

• POP before SMTP: Enable or disable POP before SMTP.

• POP E-mail Address: Enter the e-mail address.

• POP User Name: Enter the POP account name.

• POP Password: To set or change the POP password.

• Timeout setting after POP Auth.: Enter the time available before connecting to the SMTP
server after logging on to the POP server.

3. Click [OK].

4. Click [Logout].

5. Quit Web Image Monitor.

Sending On-demand E-mail

To use on-demand e-mail notification, perform the following configuration tasks in Web Image Monitor.

1. In the menu area, click [E-mail].

2. Make the following settings:

• E-mail Notification E-mail Address: Enter the address using alphanumeric characters.

• Receive E-mail Notification: Specify whether to use on-demand e-mail notification.

• E-mail Notification User Name: Enter the administrator's user name as the mail originator name.

• E-mail Notification Password: Enter the password of the mail notification user.

3. Click [OK].

4. Click [Logout].

5. Quit Web Image Monitor.

Format of on-demand e-mail messages

To use mail notification, you need to send an on-demand e-mail message to this printer.

Using your mail software, enter the following:
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Item Description

Subject (Referred to as Subject) Enter a request regarding the device. For details,
see the table below.

From (Referred to as From) Specify a valid mail address. The device
information will be sent to the address specified
here.

• A mail message must be within 1 MB in size.

• E-mail may be incomplete if sent immediately after power on.

Subject field

Format: devicestatus?parametername=parameter[&=parameter][& =parameter]...

• The Subject field is case-insensitive.

• Parameter names can be written in any order.

Subject field coding examples

Coding example Action

devicestatus?request=sysconfig& format=text&
lang=en

The device's system configuration information
will be sent in an English text format.

devicestatus?request=sysconfig The device's system configuration information
will be sent in a preset format and language.

Parameters

Parameter Meaning Default

request Information to be obtained Mandatory

format Mail format Mail will be sent in the format
preset for each mail address.

lang Language for mail body Mail will be sent in the
language preset for each mail
address.
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Parameters specifying the information to be obtained

Information to be obtained Parameter

System configuration information sysconfig

Network configuration information netconfig

Printer configuration information prtconfig

Supplies information supply

Device status information status

Parameters specifying the mail format

Mail format Parameter

Text text

HTML html

XML xml

• HTML and XML can be selected for subject field, but output is text only.

Parameters specifying the language for mail body

Language for mail body Parameter

English en

French fr

German de

Italian it

Spanish es

Dutch nl

Danish da

Finnish fi

Norwegian no
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Language for mail body Parameter

Portuguese pt

Swedish sv

Czech cs

Polish pl

Hungarian hu
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Remote Maintenance by telnet

• Remote Maintenance should be password-protected so that access is allowed to administrators only.

• The password is the same as the one of Web Image Monitor administrator. When the password is
changed using "mshell", other passwords change also.

• Some commands cannot be used depending on your printer.

Using telnet

Follow the procedure below to use telnet.

• Only one user at a time can log on to perform remote maintenance.

1. Use the IP address or the host name of the printer to start telnet.

% telnet "IP_address"

2. Enter your user name and password.

Contact your administrator for information about the settings.

3. Enter a command.

4. Quit telnet.

msh> logout

The configuration message about saving the changes appears.

5. Enter "yes" to save the changes, and then press the [OK] key.

If you do not want to save the changes, enter "no", and then press the [OK] key. To make further
changes, enter "return" at the command line, and then press the [OK] key.

• If the message "Can not write NVRAM information" appears, the changes are not saved. Repeat the
procedure above.

• When the changes are saved, the network interface board is reset automatically with that changes.

• When the network interface board resets, the print job in print process will be printed. However, print
jobs in queue will be canceled.
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access

Use the "access" command to view and configure access control. You can also specify two or more access
ranges.

View settings

msh> access

IPv4 Configuration

msh> access [×] range "start-address end-address"

• [×] represents a target number between 1 and 5. (Up to five access ranges can be registered
and selected.)

Example: to specify accessible IPv4 addresses between 192.168.0.10 and 192.168.0.20:

msh> access 1 range6 192.168.0.10 192.168.0.20

IPv6 Configuration

msh> access [×] range6 "start-address end-address"

• [×] represents a target number between 1 and 5. (Up to five access ranges can be registered
and selected.)

Example: to specify accessible IPv6 addresses between 2001:DB8::100 and 2001:DB8::200.

msh> access 1 range6 2001:DB8::100 2001:DB8::200

IPv6 access mask Configuration

msh> access [×] mask6 "base-address prefixlen"

• [×] represents a target number between 1 and 5. (Up to five access ranges can be registered
and selected.)

Example: to specify accessible IPv6 addresses to 2001:DB8::/32

msh> access 1 mask6 2001:DB8:: 32

Access control initialization

msh> access flush

• Use the "flush" command to restore the default settings so that all access ranges become "0.0.0.0"
for IPv4, and ":: " for IPv6.

• The access range restricts computers from use of the machine by IP address. If you do not need
to restrict printing, make the setting "0.0.0.0" for IPv4, and "::" for IPv6.

• Valid ranges must be from lower (start address) to higher (end address).

• If you are running IPv4 or IPv6, up to five access ranges can be registered and selected.

• IPv6 can register and select the range and the mask for each access ranges.

• IPv6 mask ranges between 1 - 128 can be selected.
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• Up to five access ranges can be specified. The entry is invalid if the target number is omitted.

• You cannot send print jobs, or access Web Image Monitor and diprint from a restricted IP
address.

appletalk

Use the "appletalk" command to view and configure Appletalk parameters.

View settings

msh> appletalk

• [2] means "active" and [0] means "inactive".

• The default is [2].

Changing PAP timeout configuration

msh> appletalk ptimeout value > 0

• Timeout value becomes effective.

msh> appletalk ptimeout value = 0

• Timeout value becomes ineffective.

autonet

Use the "autonet" command to view and configure AutoNet parameters.

View settings

The following command displays the current AutoNet settings:

msh> autonet

Configuration

You can configure AutoNet settings.

msh> autonet {on|off}

• {on} means "active" and {off} means "inactive".

Current interface priority configuration display

msh> autonet priority

Interface priority configuration

msh> autonet priority "interface_name"

• You can give interface's AutoNet parameter priority.

• Priority settings are available when multiple interfaces are installed.

• wlan can be specified only when the IEEE 802.11b interface unit is installed.
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Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface

• If an interface is not selected, the current interface connection settings remain in effect.

• For details about AutoNet, refer to autonet parameters.

bonjour

Use the "bonjour" command to display bonjour-related settings.

View settings

Bonjour settings are displayed.

msh> bonjour

Bonjour service name setting

You can specify the bonjour service name.

msh> bonjour cname "computer name"

• The computer name can be entered using up to 63 alphanumeric characters.

Bonjour Installation location information setting

You can enter information about the location where the printer is installed.

msh> bonjour location "location"

• Information about location can be entered using up to 32 alphanumeric characters.

Setting order of priority for each protocol

• diprint

msh> bonjour diprint [0-99]

• lpr

msh> bonjour lpr [0-99]

• ipp

msh> bonjour ipp [0-99]

You can specify the order of priority for "diprint", "lpr", and "ipp". Smaller numbers indicate higher
priority.

Remote Maintenance by telnet

243

6



IP TTL setting

msh> bonjour ip ttl {1-255}

You can specify the IP TTL (the number of routers a packet can pass through).

• The default is 255.

Resetting the computer name and location information

You can reset the computer name and location information.

msh> bonjour clear {cname | location}

• cname

Reset the computer name. The default computer name will be displayed when the computer is
restarted.

• location

Reset the location information. The previous location information will be deleted.

Interface configuration

msh> bonjour linklocal "interface_name"

• If many types of interface are installed, configure the interface that communicates with linklocal
address.

• If you do not specify an interface, the Ethernet interface is automatically selected.

• wlan can be specified only when the IEEE 802.11b interface unit is installed.

Interface Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface

btconfig

Use the "btconfig" command to make Bluetooth settings.

View settings

Bluetooth settings are displayed.

msh> btconfig

Printer name configuration

You can set the Bluetooth operation mode to "private" or "public".

msh> btconfig {private | public}

• Default: public
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• Set single names for each printer.

devicename

Use the "devicename" command to display and change the printer name.

View settings

msh> devicename

Printer name configuration

msh> devicename name "string"

• Enter a printer name using up to 31 alphanumeric characters.

• Set single names for each printer.

Printer name initialization

msh> device name clearname

• Reset the printer name to its default.

dhcp

Use the "dhcp" command to configure DHCP settings.

View settings

The following command displays the current DHCP settings.

msh> dhcp

Configuration

You can configure DHCP.

msh> dhcp "interface_name" {on|off}

• Click {on} to enable DHCP. Click {off} to disable DHCP.

• If the DNS server address and domain name are obtained from DHCP, be sure to click {on}.

• wlan can be specified only when the IEEE 802.11b interface unit is installed.

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface

Current interface priority configuration display

msh> dhcp priority
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Interface priority configuration

msh> dhcp priority "interface_name"

• You can select which interface has DHCP parameter priority.

• Priority settings are available when multiple interfaces are installed.

DNS server address selection

msh> dhcp dnsaddr {dhcp | static}

• Specify whether to obtain the DNS server address from the DHCP server or use the address set
by a user.

• To obtain the DNS server address from the DHCP server, specify "dhcp". To use the address set
by a user, specify "static".

Domain name selection

msh> dhcp domainname {dhcp | static}

• Specify whether to obtain the domain name from the DNS server or use the domain name set
by a user.

• To obtain the domain name from the DHCP server, specify "dhcp". To use the domain name set
by a user, specify "static".

diprint

The direct printing port enables direct printing from a network-connected computer.
Use the "diprint" command to change direct printing port settings.

View settings

The following command displays the current direct printing port settings:

msh> diprint

Example output:

port 9100

timeout=300(sec)

bidirect on

con multi

apl async

• The "port" specifies the port number of the direct printing port.

• The "bidirect" setting indicates whether the direct printing port is bidirectional or not.

Setting timeout

msh> diprint timeout [30~65535]

• You can specify the timeout interval to use when the printer is expecting data from the network.
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• The default is 300 seconds.

Specifying the number of concurrent connections

msh> diprint conn {multi | single}

• The above command specifies the number of concurrent diprint connections. Specify "multi" for
multiple connections or "single" for a single connection.

• The default is "multi".

Specifying the timeout and APL termination settings

msh> diprint apl {async | cync}

• Specifies whether or not to synchronize the timeout and APL termination.

dns

Use the "dns" command to configure or display DNS (Domain Name System) settings.

View settings

The following command displays current DNS settings:

msh> dns

IPv4 DNS server configuration

The following command enables or disables the IPv4 DNS server address:

msh> dns "number" server "server address"

The following command displays a configuration using the IP address 192.168.15.16 on a DNS 1
server:

msh> dns 1 server 192.168.15.16

• You can register IPv4 DNS Server address.

• You can register up to three IPv4 DNS server numbers.

• You cannot use "255.255.255.255" as the DNS server address.

IPv6 DNS server configuration

The following command enables or disables the IPv6 DNS server address:

msh> dns "number" server6 "server address"

• You can register IPv6 DNS Server address.

• You can register up to three IPv6 DNS server numbers.

Dynamic DNS function setting

msh> dns "interface_name" ddns {on|off}

• You can set the dynamic DNS function "active" or "inactive".

• {on} means "active" and {off} means "inactive".
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• wlan can be specified only when the IEEE 802.11b interface unit is installed.

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface

Specifying the record overlap operation

msh> dns overlap {update|add}

• You can specify operations performed when records overlap.

• update

To delete old records and register new records.

• add

To add new records and store the old records.

• When CNAME overlaps, it is always changed, irrespective of settings.

CNAME registration

msh> dns cname {on|off}

• You can specify whether to register CNAME.

• {on} means "active" and {off} means "inactive".

• The CNAME registered is the default name beginning with rnp. CNAME cannot be changed.

A records registration

msh> dns arecord {dhcp|own}

• {dhcp}

You can specify the method of registering an A record when the dynamic DNS function is enabled
and DHCP is used.

• {own}

To register an A record using the printer as the DNS client.

The DNS server address and the domain name already designated are used for the registration.

Record updating interval settings

msh> dns interval "time"

• You can specify the interval after which records are updated when using the dynamic DNS
function.

• The updating interval is specified hourly. It can be entered between 1 and 255 hours.

• The default is 24 hours.
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domainname

Use the "domainname" command to display or configure the domain name settings.
You can configure the Ethernet interface or IEEE 802.11b interface.

View settings

The following command displays the current domain name:

msh> domainname

Interface domain configuration

msh> domainname "interface_name"

Setting the Domain Name

msh> domainname "interface_name" name "domain name"

• A domain name can be entered using up to 63 alphanumeric characters.

• The Ethernet interface and IEEE 802.11b interface will have the same domain name.

• wlan can be specified only when the IEEE 802.11b interface unit is installed.

Interface Interface set

ether Ethernet interface

wlan IEEE 802.11b interface

Deleting the Domain Name

msh> domainname "interface_name" clear "name"

help

Use the "help" command to display the available command list and the procedures for using those
commands.

Command list display

msh> help

Display of procedure for using commands

msh> help "command_name"

hostname

Use the "hostname" command to change the printer name.
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View settings

msh> hostname

IPv4 Configuration

msh> hostname "interface_name" "printer_name"

• Enter the printer name using up to 63 alphanumeric characters.

• You cannot use a printer name starting with "RNP" or "rnp"

• The Ethernet interface and IEEE 802.11b interface will have the same printer name.

• wlan can be specified only when the IEEE 802.11b interface unit is installed.

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface

Initializing the printer name for each interface

msh>hostname "interface_name" clear "name"

ifconfig

Use the "ifconfig" command to view and configure TCP/IP (IP address, subnet mask, broadcast address,
default gateway address) for the printer.

View settings

msh> ifconfig

IPv4 Configuration

msh> ifconfig "interface_name" "parameter" "address"

• If you did not enter an interface name, it is automatically set to the Ethernet interface.

• wlan can be specified only when the IEEE 802.11b interface unit is installed.

Interface name Interface configured

ether Ethernet Interface

wlan IEEE 802.11b Interface

The following explains how to configure an IPv4 address 192.168.15.16 on Ethernet interface.

msh> ifconfig ether 192.168.15.16

IPv6 Configuration

msh> ifconfig ether inet6 "interface_name" "prefixlen"
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The following explains how to configure a IPv6 address to 2001:DB8::100 with prefix length 64 on
the Ethernet interface.

msh> ifconfig ether inet6 2001:DB8::100 64

Netmask configuration

msh> ifconfig "interface_name" netmask "address"

The following explains how to configure a subnet mask 255.255.255.0 on Ethernet interface.

msh> ifconfig ether netmask 255.255.255.0

Broadcast address configuration

msh> ifconfig "interface_name" broadcast "address"

Changing the Interface

msh> ifconfig "interface" up

You can specify either the Ethernet interface or IEEE 802.11b interface when using the optional IEEE
802.11b interface unit is installed.

• To get the above addresses, contact your administrator.

• Use the default configuration if you cannot obtain setting addresses.

• The IP address, subnet mask and broadcast address are the same as that for the ethernet interface
and IEEE 802.11b interface.

• TCP/IP configuration is the same for both Ethernet and IEEE 802.11 interface. If interfaces are
changed, the new interface inherits the configuration.

• Use "0x" as the initial two letters of a hexadecimal address.

info

Use the "info" command to display printer information such as paper tray, output tray, and printer language.

Printer information display

msh> info

• For details about displayed contents, see p.274 "Getting Printer Information over the Network" .

ipp

Use the "ipp" command to view and configure IPP settings.

Remote Maintenance by telnet

251

6



Viewing settings

The following command displays the current IPP settings:

msh> ipp

IPP timeout configuration

Specify how many seconds the computer waits before canceling an interrupted print job. The time
can be entered between 30 to 65535 seconds.

msh> ipp timeout [30 - 65535]

IPP user authorization configuration

Use IPP user authorization to restrict users to print with IPP. The default is "off".

msh> ipp auth {basic|digest|off}

• User authorization settings are "basic" and "digest".

• Use "off" to remove a user's authorization.

• If user authorization is specified, register a user name. You can register up to 10 users.

IPP user configuration

Configure IPP users according to the following messages:

msh> ipp user

The following message appears:

msh> Input user number (1 to 10):

Enter the number, user name, and password.

msh> IPP user name:user1

msh> IPP password:*******

After configuring the settings, the following message appears:

User configuration changed.

ipv6

Use the "ipv6" command to display and configure IPv6 settings.

View Setting

msh> ipv6

IPv6 stateless address

msh> ipv6 stateless {on|off}
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lpr

Use the "lpr" command to view and configure LPR settings.

View Setting

msh> lpr

Checking host name when deleting the job

msh> lpr chkhost {on|off}

netware

Use the "netware" command to configure the NetWare settings such as the print server name or file server
name.

Netware Printer Server Names

msh> netware pname "character string"

• Enter the NetWare print server name using up to 47 characters.

Netware File Server Names

msh> netware fname

• Enter the NetWare file server name using up to 47 characters.

Encap type

msh> netware encap {802.3|802.2|snap|ethernet2|auto}

Remote Printer Number

msh> netware rnum {0-254}

Timeout

msh> netware timeout {3-255}

Printer server mode

msh> netware mode pserver

msh> netware mode ps

Remote printer mode

msh> netware mode rprinter

msh> netware mode rp

NDS context name

msh> netware context "character string"

SAP interval

msh> netware "sap_interval"
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Setting login mode for file server

msh> netware login server

Setting login mode for NDS tree

msh> netware login tree

Setting login mode for NDS tree name

msh> netware tree "NDS name"

File transfer protocol

msh> netware trans {ipv4pri|ipxpri|ipv4|ipx}

If you do not specify the protocol, the current setting is displayed.

Protocol Set Protocol

ipv4pri IPv4+IPX(IPv4)

ipxpri IPv4+IPX(IPX)

ipv4 IPv4

ipx IPX

passwd

Use the "passwd" command to change the remote maintenance password.

Changing the Password

msh> passwd

• Enter the current password.

• Enter the new password.

• Renter the new password to confirm it.

Changing the Password of the administrators using the Supervisor

msh> passwd {Administrator ID}

• Enter the new password.

• Renter the new password to confirm it.

• Be sure not to forget or lose the password.

• The password can be entered using up to 32 alphanumeric characters. Passwords are case-sensitive.
For example, "R" is not the same as "r".
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prnlog

Use the "prnlog" command to obtain printer log information.

Print logs display

msh> prnlog

• Displays 16 previous print jobs.

msh> prnlog "ID Number"

• Specify the ID number of the displayed print log information to display additional details about
a print job.

• For details about displayed contents, see p.274 "Getting Printer Information over the Network" .

route

Use the "route" command to view and control the routing table.

All route information display

msh> route get "destination"

• Specify the IPv4 address to destination.

"0.0.0.0" cannot be specified as destination address.

Enabling/disabling Specified IPv4 Destination

msh> route active {host|net} "destination" {on | off}

• You can turn the specified destination on or off. Host becomes the default setting.

Adding IPv4 Routing Table

msh> route add {host|net} "destination" "gateway"

• Adds a host or network route to "destination", and a gateway address to "gateway" in the table.

• Specify the IPv4 address to destination and gateway.

• Host becomes the default setting.

Setting Default IPv4 Gateway

msh> route add default gateway

Deleting specified IPv4 destination from Routing Table

msh> route delete {host|net} "destination"

• Host becomes the default setting.

• IPv4 address of destination can be specified.
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Setting IPv6 Default Gateway

msh> route add6 default gateway

Adding a specified IPv6 destination to Routing Table

msh> route add6 "destination" "prefixlen" "gateway"

• Specify the IPv6 address to destination and gateway.

Deleting a specified IPv6 destination from Routing Table

msh> route delete6 "destination" "prefixlen"

• Specify the IPv6 address to destination and gateway.

Display information about a specified IPv6 route information

msh> route get6 "destination"

• Specify the IPv6 address to destination and gateway.

Enabling/disabling a specified IPv6 destination

msh> route active6 "destination" "prefixlen" {on | off}

Route initialization

msh> route flush

• The maximum number of IPv4 routing tables is 16.

• The maximum number of IPv6 routing tables is 2.

• Set a gateway address when communicating with devices on an external network.

• The same gateway address is shared by all interfaces.

• "Prefixlen" is a number between 1 and 128.

set

Use the "set" command to set the protocol information display "active" or "inactive".

View settings

The following command displays protocol information (active/inactive).

msh> set ipv4

msh> set ipv6

msh> set appletalk

msh> set netware

msh> set smb

msh> set protocol
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• When protocol is specified, information about TCP/IP, AppleTalk, Netware, SCSI print, and
SMB appears.

msh> set parallel

msh> set usb

msh> set bluetooth

msh> set lpr

msh> set lpr6

msh> set ftp

msh> set ftp6

msh> set rsh

msh> set rsh6

msh> set diprint

msh> set diprint6

msh> set web

msh> set snmp

msh> set ssl

msh> set ssl6

msh> set nrs

msh> set rfu

msh> set rfu6

msh> set ipp

msh> set ipp6

msh> set http

msh> set http6

msh> set bonjour

msh> set nbt

msh> set ssdp

msh> set ssh

msh> set sftp

msh> set sftp6

Configuration

• Enter "up" enable protocol, and enter "down" to disable protocol.

You can set the protocol to "active" or "inactive".
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msh> set ipv4 {up | down}

• If you disable IPv4, you cannot use remote access after logging off. If you did this by mistake,
you can use the control panel to enable remote access via IPv4.

• Disabling IPv4 also disables lpr, ftp, rsh, diprint, web, snmp, ssl, ipp, http, bonjour, and sftp.

msh> set ipv6 {up | down}

• If you disable IPv6, you cannot use remote access after logging off. If you did this by mistake,
you can use the control panel to enable remote access via IPv6.

• Disabling IPv6 also disables lpr6, ftp6, rsh6, diprint6, ssl6, ipp6, http6, and sftp6.

msh> set appletalk {up | down}

msh> set netware {up | down}

msh> set smb {up | down}

msh> set lpr {up | down}

msh> set lpr6 {up | down}

msh> set ftp {up | down}

msh> set ftp6 {up | down}

msh> set rsh {up | down}

msh> set rsh6 {up | down}

msh> set diprint {up | down}

msh> set diprint6 {up | down}

msh> set web {up | down}

msh> set snmp {up | down}

msh> set ssl {up | down}

msh> set ssl6 {up | down}

• If Secured Sockets Layer (SSL, an encryption protocol) function is not available for the
printer, you cannot use the function by enabling it.

msh> set nrs {up | down}

msh> set rfu {up | down}

msh> set rfu6 {up | down}

msh> set ipp {up | down}

msh> set ipp6 {up | down}

msh> set http {up | down}

msh> set http6 {up | down}

msh> set bonjour {up | down}

msh> set ssh {up | down}
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msh> set ssdp {up | down}

msh> set nbt {up | down}

msh> set sftp {up | down}

msh> set sftp6 {up | down}

show

Use the "show" command to display network interface board configuration settings.

View settings

msh> show

• If "-p" is added, you can view settings one by one.

• For details about the information displayed, see p.284 "Understanding the Displayed Information".

slp

Use "slp" command to view and configure SLP settings.

msh> slp ttl "ttl_val"

• You can search the NetWare server using SLP in the PureIP environment of NetWare 5/5.1 and
Netware 6/6.5. Using the "slp" command, you can configure the value of TTL which can be used by
SLP multicast packet.

• The default value of TTL is 1. A search is executed only within a local segment. If the router does not
support multicast, the settings are not available even if the TTL value is increased.

• The acceptable TTL value is between 1 and 255.

smb

Use the "smb" command to configure or delete the computer or workgroup name for SMB.

Computer Name settings

msh> smb comp "computer name"

• Set computer name using up to 15 characters. Names beginning with "RNP" or "rnp" cannot be
entered.

Working Group Name settings

msh> smb group "work group name"

• Set workgroup name using up to 15 characters
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Comment settings

msh> smb comment "comment"

• Set comment using up to 31 characters

Notify print job completion

msh> smb notif {on | off}

• To notify print job completion, specify "on". Otherwise, specify "off"

Deleting Computer Nam

msh> smb clear comp

Deleting Group Name

msh> smb clear group

Deleting Comment

msh> smb clear comment

View Protocol

msh> smb protocol

snmp

Use the "snmp" command to display and edit SNMP configuration settings such as the community name.

View settings

msh> snmp

• Default access settings 1 is as follows:

Community name:public

IPv4 address:0.0.0.0

IPv6 address:::

IPX address:00000000:000000000000

Access type:read-only

Effective Protocol:IPv4/IPv6/IPX

• Default access settings 2 is as follows:

Community name:admin

IPv4 address:0.0.0.0

IPv6 address:::

IPX address:00000000:000000000000

Access type:read-write

Effective Protocol:IPv4/IPv6/IPX
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• If "-p" is added, you can view settings one by one.

• To display the current community, specify its registration number.

Display

msh> snmp ?

Community name configuration

msh> snmp "number" name "community_name"

• You can configure ten SNMP access settings numbered 1-10.

• The printer cannot be accessed from SmartDeviceMonitor for Admin or SmartDeviceMonitor for
Client if "public" is not registered in numbers 1-10. When changing the community name, use
SmartDeviceMonitor for Admin and SNMP Setup Tool to correspond with printer settings.

• The community name can be entered using up to 15 characters.

Deleting community name

msh> snmp "number" clear name

Access type configuration

msh> snmp "number" type "access_type"

Access type Type of access permission

no not accessible

read read only

write read and write

trap user is notified of trapmessages

Protocol configuration

msh> snmp {ipv4|ipv6|ipx} {on|off}

• Use the following command to set protocols "active" or "inactive": If you set a protocol "inactive",
all access settings for that protocol are disabled.

• Specify "ipv4" for IPv4, "ipv6" for IPv6, or "ipx" for IPX/SPX.

• {on} means "active" and {off} means "inactive".

• All protocols cannot be turned off concurrently.

Configuration of protocol for each registration number

msh> snmp "number" active {ipv4|ipv6|ipx} {on|off}

• To change the protocol of access settings, use the following command. However, if you have
disabled a protocol with the above command, activating it here has no effect.
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Access configuration

msh> snmp "number" {ipv4|ipv6|ipx} "address"

• You can configure a host address according to the protocol used.

• The network interface board accepts requests only from hosts that have IPv4, IPv6, and IPX
addresses with access types of "read-only" or "read-write". Enter "0" to have network interface
board accept requests from any host without requiring a specific type of access.

• Enter a host address to deliver "trap" access type information to.

• To specify IPv4 or IPv6, enter "ipv4" or "ipv6" followed by a space, and then the IPv4 or IPv6
address.

• To specify IPX/SPX, enter "ipx" followed by a space, the IPX address followed by a decimal,
and then the MAC address of the network interface board.

sysLocation configuration

msh> snmp location

Deleting sysLocation

msh> snmp clear location

sysContact setting

msh> snmp contact

Deleting sysContact

msh> snmp clear contact

SNMP v1v2 function configuration

msh> snmp v1v2 {on|off}

• Specify "on" to enable, and "off" to disable.

SNMP v3 function configuration

msh> snmp v3 {on|off}

• Specify "on" to enable, and "off" to disable.

SNMP TRAP configuration

msh> snmp trap {v1|v2|v3} {on|off}

• Specify "on" to enable, and "off" to disable.

Remote Configuration Authorization configuration

msh> snmp remote {on|off}

• Specify "on" to enable, and "off" to disable the SNMP v1v2 setting.

SNMP v3 TRAP configuration display

msh> snmp v3trap

msh> snmp v3trap {1-5}
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If a number from 1-5 is entered, settings are displayed for that number only.

Configuring a sending address for SNMP v3 TRAP

msh> snmp v3trap {1-5} {ipv4|ipv6|ipx} "address"

Configuring a sending protocol for SNMP v3 TRAP

msh> snmp v3trap {1-5} active {ipv4|ipv6|ipx} {on|off}

Configuring a user account for SNMP v3 TRAP

msh> snmp v3trap {1-5} account "account_name"

Enter an account name using up to 32 alphanumeric characters.

Deleting an SNMP v3 TRAP user account

msh> snmp v3trap {1-5} clear account

Configuring an SNMP v3 encryption algorithm

msh> snmp v3auth {md5|sha1}

Configuring SNMP v3 encryption

msh> snmp v3priv {auto|on}

Set "auto" for automatic encryption configuration

Set "on" for mandatory encryption configuration.

sntp

The printer clock can be synchronized with a NTP server clock using Simple Network Time Protocol (SNTP).
Use the "sntp" command to change SNTP settings.

View settings

msh> sntp

NTP server address configuration

You can specify the IP address of the NTP server.

msh> sntp server "IP_address"

Interval configuration

msh> sntp interval "polling_time"

• You can specify the interval at which the printer synchronizes with the operator-specified NTP
server. The default is 60 minutes.

• The interval can be entered from 0, or between 16 and 10,080 minutes.

• If you set 0, the printer synchronizes with the NTP server only when you turn the printer on. After
that, the printer does not synchronize with the NTP server.
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Time-zone configuration

msh> sntp timezone "+/-hour_time"

• You can specify the time difference between the printer clock and NTP server clock. The values
are between -12:00 and +13:00.

spoolsw

Use the "spoolsw" command to view and configure Job Spool settings.

You can only specify diprint, lpr, ipp, ftp, smb and sftp protocol.

View settings

The Job Spool setting appears.

msh> spoolsw

Job Spool setting

msh> spoolsw spool {on | off}

• Specify "on" to enable Job Spool, or "off" to disable it.

Resetting Job spool setting

msh> spoolsw clear job {on | off}

• When the printer power is cut during job spooling, this determines whether to reprint the spooled
job.

Protocol configuration

msh> spoolsw diprint {on | off}

msh> spoolsw lpr {on | off}

msh> spoolsw ipp {on | off}

msh> spoolsw smb {on | off}

msh> spoolsw ftp {on | off}

msh> spoolsw sftp {on|off}

• You can specify the settings for diprint, lpr, ipp, smb and sftp.

ssdp

Use the "ssdp" command to view and configure SSDP settings.

View settings

msh> ssdp
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Setting effective time

msh> ssdp profile {1801-86400}

The default is 10800 seconds.

Advertise packet TTL settings

msh> ssdp ttl {1-255}

The default is 4.

ssh

Use the "ssh" command to view and configure SSH settings.

View settings

msh> ssh

Data compression communication settings

msh> ssh compression {on|off}

The default is "on".

SSH/SFTP communication port setting

msh> ssh port {22, 1024-65535}

The default is 22.

SSH/SFTP communication timeout setting

msh> ssh timeout {0-65535}

The default is 300.

SSH/SFTP communication login timeout setting

msh> ssh logintimeout {0-65535}

The default is 300.

Setting an open key for SSH/SFTP

msh> ssh genkey {512|768|1024} "character string"

Create an open key for SSH/SFTP communication.

Usable characters are ASCII 0x20-0x7e (32 bytes) other than "0".

The default key length is 1024, and the character string is blank.

Deleting open key for ssh/sftp communication

msh> ssh delkey

• If you do not specify a character string, current setting is displayed.
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status

Use the "status" command to display the printer status.

Messages

msh> status

• For details, see p.274 "Getting Printer Information over the Network".

syslog

Use the "syslog" command to display the information stored in the printer's system log.

View message

msh> syslog

• For details about the information displayed, see p.295 "Message List".

upnp

Use the "upnp" command to display and configure the universal plug and play.

Public URL display

msh> upnp url

Public URL configuration

Msh< upnp url "string"

• Enter the URL string in the character string.

web

Use the "web" command to display and configure parameters on Web Image Monitor.

View Settings

msh> web

URL Configuration

You can set URLs linked by clicking URL on Web Image Monitor.

Specify "1" or "2" for x as the number corresponding to the URL. Up to two URLs can be registered
and specified.
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msh> web url http://"The URL or IP address you want to register"/

Deleting URLs registered as link destinations

msh> web x clear url

Specify "1" or "2" for x as the corresponding number to the URL.

Link name configuration

You can enter the name for URL that appears on Web Image Monitor.

Specify "1" or "2" for x as the corresponding number to the link name.

msh> web name "Name you want to display"

Resetting URL names registered as link destinations

msh> web x clear name

Specify "1" or "2" for x as the number corresponding to the link name.

Help URL Configuration

You can set URLs linked by clicking [Help] or [?] on Web Image Monitor.

msh> web help http://"Help URL or IP address"/help/

Deleting Help URL

msh> web clear help

wiconfig

Use the "wiconfig" command to make settings for IEEE 802.11b.

View settings

msh> wiconfig

View IEEE 802.11b settings

msh> wiconfig cardinfo

• If IEEE 802.11b is not working correctly, its information is not displayed.

Configuration

msh> wiconfig "parameter"

Parameter Value configured

mode {ap|adhoc|802.11adhoc} You can set the infrastructure mode (ap) , the
802.11 ad hoc mode (802.11adhoc), or the ad
hoc mode (adhoc).

The default is ad hoc mode.
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Parameter Value configured

ssid "ID value" You can make settings for the SSID in the
infrastructure mode.

Usable characters are ASCII 0x20-0x7e (32
bytes).

An SSID value is set automatically to the nearest
access point if no setting is made.

If no setting is made for the ad hoc mode, the
same value as for the infrastructure mode or an
ASSID value is automatically set. The default is
blank.

channel frequency "channel no." You can enable or disable the WEP function. To
enable the WEP function, specify [on]; to disable
it, specify [off].

To start the WEP function, enter the correct WEP
key. The default is "11".

key "key value" val {1|2|3|4} You can specify the WEP key when entering in
hexadecimal.

With a 64-bit WEP, you can use 10 digit
hexadecimals. With a 128-bit WEP, you can use
26 digit hexadecimals.

Up to four WEP keys can be registered. Specify
the number to be registered with "val".

When a WEP is specified by key, the WEP
specified by key phrase is overwritten.

To use this function, set the same key number and
WEP key for all ports that transmit data to each
other. Put "0x" on the front of WEP key.

You can omit the numbers with "val". The key
number is set to 1 when making these omissions.
The default is blank.

keyphrase "phrase" val {1|2|3|4} You can specify the WEP key when entering in
ASCII.

With a 64-bit WEP, you can use 10 digit
hexadecimals. With a 128-bit WEP, you can use
26 digit hexadecimals.
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Parameter Value configured

Up to four WEP keys can be registered. Specify
the number to be registered with "val".

When a WEP is specified by key phrase, the
WEP specified by key is overwritten.

To use this function, set the same key number and
WEP key for all ports that transmit data to each
other.

You can omit the numbers with "val". The key
number is set to 1 when making these omissions.

encval {1|2|3|4} You can specify which of the four WEP keys is
used for packet encoding. "1" is set if a number
is not specified.

wepauth [open|shared] You can set an authorization mode when using
WEP. The specified value and authorized mode
are as follows:

open: open system authorized (default)

shared: shared key authorized rate

rate [auto|11m|5.5m|2m|1m] You can set the IEEE 802.11b transmitting
speed.

The speed you specify here is the speed at which
data is sent. You can receive data at any speed.

auto: automatically set (default)

11m: 11 Mbps fixed

5.5m: 5.5 Mbps fixed

2m:2 Mbps fixed

1m: 1 Mbps fixed

security {none|wep|wpa} You can specify the security mode.

none: No encryption(default)S

wep: WEP encryption

wpa: WPA encryption

wpaenc  {tkip|ccmp} You can specify WPA encryption key when using
WPA encryption.

tkip: TKIP (default)
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Parameter Value configured

ccmp: CCMP (AES)

wpaauth {wpapsk | wpa} You can specify the WPA authentication mode
when using WPA encryption.

wpapsk: WPA-PSK authentication(default)

wpa: WPA(802.1X) authentication

psk "character string" You can specify the Pre-Shared key.

Usable characters: ASCII 0x20-0x7e (8 to 63
bytes).

The default is blank.

eap {tls|ttls|leap|peap} {chap|mschap|
mschapv2|pap|md5|tls}

You can specify the EAP authentication type.

tls: EAP-TLS (default)

ttls: EAP-TTLS

leap: LEAP

peap: PEAP

chap, mschap, mschapv2, pap, md5, or tls are
settings for the phase 2 method, and must be set
when using EAP-TTLS or PEAP.

Do not make these settings when using other EAP
authentication types.

If you select EAP-TTLS, you can select chap,
mschap, mschapv2, pap, or md5.

If you select PEAP, you can select mschapv2 or
tls.

username "character string" You can specify the login user name for the
Radius server.

Usable characters: ASCII 0x20-0x7e(31 bytes)
other than "@". The default is blank.

username2 "character string" You can specify the phase 2 username for EAP-
TTLS/PEAP phase 2 authentication.

Usable characters: ASCII 0x20-0x7e (31 bytes)
other than "@". The default is blank.

domain "character string" You can specify the login domain name for the
Radius server.
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Parameter Value configured

Usable characters: ASCII0x20-0x7e (31 bytes)
other than "@". The default is blank.

password "character string" You can specify the login password for the
Radius server.

Usable characters: ASCII 0x20-0x7e(128
bytes). The default is blank.

srvcert {on | off} You can set the server certificate. The default is
"off".

imca {on | off} You can enable or disable the certificate when
the intermediate certificate authority is present.
The default is "off".

srvid "character string" You can set the server ID and subdomain of the
certificate server.

• You can use this command only when the IEEE 802.11b interface unit is installed.

wins

Use the "wins" command to configure WINS server settings.

Viewing settings

msh> wins

• If the IPv4 address obtained from DHCP differs from the WINS IPv4 address, the DHCP address
is the valid address.

Configuration

msh> wins "interface_name" {on | off}

• {on} means "active" and {off} means "inactive".

• Be sure to specify the interface.

• wlan can be specified only when the IEEE 802.11b interface unit is installed.

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface
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Address configuration

Use the following command to configure a WINS server IP address:

msh> wins "interface_name" {primary|secondary} "IP address"

• Use the "primary" command to configure a primary WINS server IPv4 address.

• Use the "secondary" command to configure a secondary WINS server IPv4 address.

• Do not use "255.255.255.255" as the IPv4 address.

NBT (NetBIOS over TCP/IP) Scope ID Selection

You can specify the NBT scope ID.

msh> wins "interface_name" scope "scope ID"

• The scope ID can be entered using up to 31 alphanumeric characters.

• Be sure to specify the interface.

• wlan can be specified only when the IEEE 802.11b interface unit is installed.

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface
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SNMP
The SNMP agent operating on UDP and IPX is incorporated into the built-in Ethernet board and optional
IEEE 802.11b interface unit of this printer.
Using the SNMP manager, you can get information about the printer.

• If you changed the printer's community name, change the configuration of the connected computer
accordingly, using SNMP Setup Tool bundled with SmartDevice Monitor for Client. For details, see
SNMP Setup Tool Help.

The default community names are [public] and [admin].

Start SNMP Setup Tool

• Windows 95/98/Me, Windows 2000, Windows NT 4.0:

Click the [Start] button.

Point to SmartDeviceMonitor for Admin on the [Programs] menu.

Click [SNMP Setup Tool].

• Windows XP/Vista:

Click the [Start] button.

Point to SmartDeviceMonitor for Admin on the [All Programs] menu.

Click [SNMP Setup Tool].
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Getting Printer Information over the Network
This section explains details of each item displayed in the printer status and information.

Current Printer Status

The printer status can be checked using the following commands:

• UNIX: Use the "lpq" command and "rsh", "rcp", "ftp" and "sftp" parameters.

• mshell: Use the "status" command.

Messages Description

Access Restricted The job was canceled because user have no
authority.

Add staples (Booklet: Back) The staple of booklet finisher (back) is
exhausted.

Add staples (Booklet: Both) The staple of booklet finisher is exhausted.

Add staples (Booklet: Front) The staple of booklet finisher (front) is exhausted.

Adjusting... The printer is initializing or calibrating.

Call Service Center There is a malfunction in the printer.

Canceled The job is reset.

Canceling Job... The job is being reset.

Cannot multi-install: SD Card SD card you are trying to install has already
been installed in a different machine.

Card/Counter not inserted The printer is waiting for prepaid card or key.

Coin or amount not inserted The printer is waiting for coin to be inserted.

Coin/Key Counter not inserted The printer is waiting for coin or key counter.

Configuring... Setting is being changed.

Cooling Down Fusing Unit... Fusing unit is cooling down.

Cover Open: Bridge Unit Left The left cover of the Bridge Unit is open.

Cover Open: Bridge Unit Right The right cover of the Bridge Unit is open.
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Messages Description

Cover Open: Duplex Unit The cover of the duplex unit is open.

Cover Open: Duplex Unit Left The left cover of the duplex unit is open.

Cover Open: Duplex Unit Right The right cover of the duplex unit is open.

Cover Open: Finisher The cover of Finisher is open.

Cover Open: Finisher Front The front cover of Finisher is open.

Cover Open: Front Cover The front cover is open.

Cover Open: Upper Right Cover The upper right cover of the duplex unit is open.

Data Size Error The data size error occurred.

Empty: Black Toner The black toner cartridge is almost empty.

Empty: Cyan Toner The cyan toner cartridge is almost empty.

Empty: Magenta Toner The magenta toner cartridge is almost empty.

Empty: Yellow Toner The yellow toner cartridge is almost empty.

Energy Saver Mode The printer is in Energy Saver Mode.

Error An error has occurred.

Error: Address Book An error has occurred in the data of the address
book.

Error: Command Transmission An error has occurred in the printer.

Error: DIMM Value A memory error occurred.

Error: Ethernet Board An Ethernet board error has occurred.

Error: HDD Board A hard disk drive board error has occurred.

Error: Optional Font An error has occurred in the font file of the printer.

Error: Optional RAM An error has occurred in the optional memory
unit.

Error: Parallel I/F Board An error has occurred in the parallel interface.

Error: PDL An error has occurred in the page description
language.
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Messages Description

Error: Rem. Certificate Renewal An error has occurred in the remote certificate
renewal.

Error: USB Board An error has occurred in the USB board.

Error: USB Interface An error has occurred in the USB interface.

Error: Wireless Board An error has occurred in the wireless board.

Error: Wireless Card Wireless card is not inserted during start up, or
the IEEE 802.11b interface unit or the wireless
card is taken out after start up.

Exceed Booklet Stapling Limit The printing has exceeded the stapling limit of
the booklet finisher.

Full: Finisher Finisher tray is full.

Full: Finisher Booklet Tray Finisher booklet tray is full.

Full: Finisher Shift Tray Shift tray of Finisher is full.

Full: Finisher Shift Tray 1, 2 The shift tray 1 and 2 of Finisher are full.

Full: Finisher Upper Tray The upper tray of Finisher is full.

Full: Hole Punch Receptacle Punch Chip receptacle for hole punch is full.

Full: Log Data Capacity Log data capacity is full.

Full: Standard Tray Standard output tray is full.

Full: Waste Toner Waste toner is full.

Hex Dump Mode It is a hex dump mode.

Immed. Trans. not connected It did not connect directly with the other party of
the transmission.

Immediate Transmission Failed An error has occurred while transmitting directly.

Immed. Trans. not connected It did not connect directly with the other party of
the transmission.

Independent-supplier Toner Toner that is not recommended is set.

In Use: Finisher Other functions is using Finisher.
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Messages Description

In Use: Input Tray Other functions is using the input tray.

In Use: Staple Unit Other functions is using the staple unit.

Jobs Suspended All jobs are suspended.

Key Card not inserted The printer is waiting for key card to be inserted.

Key Card/Counter not inserted The printer is waiting for key card or key counter
to be inserted.

Key Counter not inserted The printer is waiting for key counter to be left in
it.

Loading Toner... Toner is being supplied.

Low: Black Toner The black toner cartridge is not set correctly, or
toner is almost running out.

Low: Cyan Toner The cyan toner cartridge is not set correctly, or
toner is almost running out.

Low: Magenta Toner The magenta toner cartridge is not set correctly,
or toner is almost running out.

Low: Toner The black toner cartridge is not set correctly, or
toner is almost running out.

Low: Yellow Toner The yellow toner cartridge is not set correctly, or
toner is almost running out.

Malfunction: Booklet Processor There is a problem with booklet finisher.

Malfunction: Duplex Unit There is a problem with duplex unit.

Malfunction: Finisher There is a problem with Finisher.

Malfunction: LargeCapacity Tray There is a problem with Large Capacity tray.

Malfunction: Output Tray There is a problem with output tray.

Malfunction: Punch Unit There is a problem with Punch Unit.

Malfunction: Staple Unit There is a problem with the staple unit.

Malfunction: Tray 1 There is a problem with tray 1.
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Messages Description

Malfunction: Tray 2 There is a problem with tray 2.

Malfunction: Tray 3 There is a problem with tray 3.

Malfunction: Tray 4 There is a problem with tray 4.

Malfunction: Tray 5 There is a problem with tray 5.

Memory Low: Data Storage Memory shortage has occurred while the
document was being accumulated.

Miscellaneous Error Other error has occurred.

Mismatch: Paper Size Indicated paper tray does not contain paper of
selected size.

Mismatch: Paper Size and Type Indicated paper tray does not contain paper of
selected size and type.

Mismatch: Paper Type Indicated paper tray does not contain paper of
selected type.

Near Replacing: Black PCU Prepare the new black photoconductor unit.

Near Replacing: Color PCU Prepare the new color photoconductor unit.

Near Replacing: Fusing Unit Prepare the new fusing unit.

Near Replacing: Int. Transfer Prepare the new transfer unit.

Nearly Full: Log Data Capacity Log data capacity is nearly full.

Nearly Full: Waste Toner Waste toner bottle is nearly full.

Need more Staples Stapler has almost run out of staples.

No Paper: LCT There is no paper in Large Capacity tray.

No Paper: Selected Tray There is no paper in specified tray.

No Paper: Tray 1 There is no paper in tray 1.

No Paper: Tray 2 There is no paper in tray 2.

No Paper: Tray 3 There is no paper in tray 3.

No Paper: Tray 3 (LCT) There is no paper in tray 3 (LCT).
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Messages Description

No Paper: Tray 4 There is no paper in tray 4.

No Paper: Tray 5 There is no paper in tray 5.

Not Detected: B2 Lever B2 lever is not correctly set.

Not Detected: Black Toner Black toner is not correctly set.

Not Detected: Cyan Toner Cyan toner is not correctly set.

Not Detected: Duplex Feed Unit The duplex feed unit is not correctly set.

Not Detected: Duplex Unit The duplex unit is not correctly set.

Not Detected: Finisher Finisher is not correctly set.

Not Detected: Fusing Unit The fusing unit is not correctly set.

Not Detected: Input Tray The paper feed tray is not correctly set.

Not Detected: Int. Transfer The transfer unit is not correctly set.

Not Detected: Magenta Toner Magenta toner is not correctly set.

Not Detected: PCU (C) The photoconductor unit (cyan) is not correctly
set.

Not Detected: PCU (K) The photoconductor unit (black) is not correctly
set.

Not Detected: PCU (M) The photoconductor unit (magenta) is not
correctly set.

Not Detected: PCU (Y) The photoconductor unit (yellow) is not correctly
set.

Not Detected: Tray 1 Tray 1 is not correctly set.

Not Detected: Tray 2 Tray 2 is not correctly set.

Not Detected: Tray 3 Tray 3 is not correctly set.

Not Detected: Tray 3 (LCT) Tray 3 is not correctly set. (LCT)

Not Detected: Tray 4 Tray 4 is not correctly set.

Not Detected: Tray 5 Tray 5 is not correctly set.
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Messages Description

Not Detected: WasteToner Bottle Waste toner bottle is not correctly set.

Not Detected: Yellow Toner Yellow toner is not correctly set.

Not Reached, Data Deleted Unreached job is deleted.

Not Reached, Data Stored Unreached job is preserved.

Offline Printer is offline.

Online Printer is online.

Operating Thermo-range Error Exceeded appropriate thermo range.

Panel Off Mode The printer is in Panel-Off mode.

Paper in Duplex Unit The paper remains in the duplex unit.

Paper in Finisher The paper remains in Finisher.

Paper Misfeed: Duplex Unit The paper has jammed in the duplex unit.

Paper Misfeed: Finisher The paper has jammed in the finisher.

Paper Misfeed: Input Tray The paper has jammed in the input tray.

Paper Misfeed: Internal/Output The paper has jammed inside the printer.

Paper on Finisher Shift Tray 2 The paper remains in Finisher Shift Tray 2.

Paper on FinisherShiftTray1, 2 The paper remains in Finisher Shift Tray 1 and 2.

Prepaid Card not inserted The printer is waiting for prepaid card to be
inserted.

Print Complete The print was completed.

Printing Printing is in progress.

Processing Data is being processed.

Proxy Address/Port Incorrect Proxy address or Port No. is incorrect.

Proxy User/Password Incorrect Proxy user name or Password is incorrect.

RC Gate Connection Error Failed connection with RC Gate.

Ready The printer is ready to print.
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Messages Description

Renewing Remote Certificate Remote Certificate is Renewing.

Replace Black PCU It is time to replace the black photoconductor
unit.

Replace Fusing Unit It is time to replace the fusing unit.

Replace PCU It is time to replace the photoconductor unit.

Replace PCU (Color) It is time to replace the photoconductor unit
(color).

SD Card Authentication failed SD card authentication failed.

SD Card not inserted SD card is not inserted correctly.

Skipped due to Error Skipped the error.

Storage Complete The storage is complete.

Storage Failed The storage has failed.

Supplies Order Call failed The supply order call has failed.

Suspend/Resume Key Error Finisher stop button was pressed.

Transmission Aborted The transmission was interrupted.

Transmission Complete The transmission completion was completed.

Transmission Failed The transmission has failed.

Tray Error: Duplex Printing Selected paper tray cannot be used for duplex
printing.

Waiting for Job Suspension All jobs are being suspended.

Warming Up... The printer is warming up.

• For details about UNIX commands, see UNIX Supplement.

• Check the error contents that may be printed in the configuration page. For details about printing a
configuration page, see p.184 "List/Test Print Menu".
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Printer configuration

You can check the printer configuration using telnet.
This section explains the checking procedure for input/output tray and printer language.

• UNIX: Use the "info" command and "rsh", "rcp", "ftp" and "sftp" parameters.

• mshell: Use the "info" command.

Input Tray

Item Description

No. ID number of the paper tray

Name Name of the paper tray

PaperSize Size of paper loaded in the paper tray

status Current status of the paper tray

• Normal: Normal

• NoInputTray: No tray

• PaperEnd: No paper

Output Tray

Item Description

No. ID number of the output tray

Name Name of the output tray

status Current status of the output tray

• Normal: Normal

• PaperExist: Paper exist

• OverFlow: Paper is full

• Error: Other errors

Emulation

Item Description

No. ID number of the printer language used by the
printer
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Item Description

Name Name of the printer language used in the printer

Version Version of the printer language

• For details about UNIX commands and parameters, see UNIX Supplement.

• For details about mshell "info" commands, see p.240 "Remote Maintenance by telnet".
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Understanding the Displayed Information
This section explains how to read status information returned by the network interface board.

Print Job Information

Use the following command to display print job information:

• UNIX: Use the "info" command and "rsh", "rcp", and "ftp" parameters.

• mshell: Use the "info" command.

Item Description

Rank Print job status.

Active

Printing or preparing for printing.

Waiting

Waiting to be transferred to the printer.

Owner Print request user name.

Job Print request number.

Files The name of the document.

Total Size The size of the data (spooled).

The default is 0 bytes.

• For details about UNIX commands and parameters, see UNIX Supplement.

• For details about mshell "info" commands, see p.240 "Remote Maintenance by telnet".

Print Log Information

This is a record of the most recent 16 jobs printed.
Use the following command to display print log information:

• UNIX: Use the "prnlog" command and "rsh", "rcp", and "ftp" parameters.

• telnet : Use the "prnlog" command. See p.240 "Remote Maintenance by telnet".
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Item Description

ID Print request ID.

User Print request user name.

Page Number of pages printed

Result

Print Request Result

Communication Result

OK

Print was completed normally. However, the print
result may not be as required due to printer
problems.

NG

Printing was not completed normally.

Canceled

An "rcp", "rsh", or "lpr" command print request was
canceled, possibly due to the printing application.
Not applicable to the "ftp" or "rprinter" command.

Time Time the print requested was received.

Time of print request reception

User ID
Printer driver-configured User ID.

Appears when the print request ID is specified.

JobName
Name of the document for printing

Appears when the print request ID is specified.

• For details about UNIX commands and parameters, see UNIX Supplement.

• For details about mshell prnlog commands, see p.240 "Remote Maintenance by telnet".

Configuring the Network Interface Board

Use the following command to display network interface board settings:

• telnet : Use the "show" command.
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Item Description

Common

Mode

Protocol Up/
Down

Protocol Settings

AppleTalk

NetWare

SMB

SCSI print

PictBridge

Device Up/Down Device Settings

Parallel

USB

Bluetooth

Ethernet interface

Syslog priority

NVRAM version

Device name

Comment

Location

Contact

Soft switch

AppleTalk AppleTalk Settings

Mode

Net

Object
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Item Description

Type

Zone

TCP/IP

Mode (IPv4)

Mode (IPv6)

ftp

lpr

rsh

telnet

diprint

web

http

ftpc

snmp

ipp

autonet

Bonjour

ssl

nrs

rfu

nbt

ssdp

ssh

sftp

IPv4 TCP/IP Settings
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Item Description

DHCP

Address

Netmask

Broadcast

Gateway

IPv6

Stateless Address

Manual

Gateway

EncapType

Host name

DNS Domain

Access Control Access Control
Settings

IPv4

Access Entry [X]
X can be set
between 1 and 5.

IPv6

Access Entry [X]
X can be set
between 1 and 5.

Time server Time Settings

Time Zone

Time server polling
time

SYSLOG server Websys Settings

Home page URL1
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Item Description

Home page link
name1

URL of home page

Home page URL2

Home page link
name2

Help page URL

NetWare

EncapType

RPRINTER number

Print server name

File server name

Context name

Switch

Mode

NDS/Bindery

Packet negotiation

Login Mode

Print job timeout

Protocol

SAP interval time

NDS Tree Name NDS tree name

Transfer Protocol

SMB SMB Settings

Switch

Mode

Direct print
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Item Description

Notification

Workgroup name

Computer name

Comment

Share name[1]

Protocol

SCSI print

Bidi

IEEE 802.11b
IEEE 802.11b
Settings

Host name

Communication
Mode

SSID

Channel range

Channel

TX Rate

Security

WEP
Authentication

WEP Encryption
key number

WEP Encryption
keys[X]

X can be set
between 1 and 5.

WPA Encryption

WPA
Authentication
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Item Description

Pre-Shared Key

User name

Domain name

EAP Type

Password

Phase 2 user name

Phase 2 Method
TTLS

Phase 2 Method
PEAP

Server cert

Intermediate CA

Server ID

DNS DNS Settings

IPv4

Server [X]
X can be set
between 1 and 3.

Select IPv4 DNS
Server

IPv6

Server [X]
X can be set
between 1 and 3.

Domain Name

ether

wlan

DDNS

ether
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Item Description

wlan

WINS WINS Settings

ether

Primary WINS

Secondary WINS

Wlan

Primary WINS

Secondary WINS

Bluetooth Bluetooth Settings

Bluetooth mode

SSDP SSDP Settings

UUID

Profile

TTL

UPnP UPnP Settings

URL

Bonjour Bonjour Settings

Computer Name

Local Hostname

Location

Priority (diprint)

Priority (lpr)

Priority (ipp)

IP TTL
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Item Description

LinkLocal Route for
Multi I/F:

SNMP SNMP Settings

SMNPv1v2

SMNPv3

protocol

v1Trap

v2Trap

v3Trap

SNMPv1v2
Remote Setting

SNMPv3 Privacy

ssh ssh Settings

Compression

Port

Timeout

LoginTimeOut

AuthFree Authfree Settings

IPv4

AuthFree Entry [X] X can be set
between 1 and 5.

IPv6

AuthFree Entry [X] X can be set
between 1 and 5.

Parallel

USB
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Item Description

LPR

Iprm check host

Certificate

Verification

Shell mode
Remote
maintenance tool
mode
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Message List
This is a list of messages that appear in the printer's system log. The system log can be viewed using the
"syslog" command.

System Log Information

Use the following command to display the system log information:

• UNIX: Use the "syslog" command and "rsh", "rcp", "ftp", and "sftp" parameters.

• telnet : Use the "syslog" command.

Message Problem and solutions

Access to NetWare server <file server name>
denied. Either there is no account for this print server
on the NetWare server or the password was
incorrect

(In the print server mode) Login to the file server
failed. Make sure that the print server is registered
on the file server. If a password is specified for the
print server, delete it.

account is unavailable: Same account name be
used.

User account is disabled. This could be because it
use the same account name as the administrator
account.

account is unavailable: The authentication
password is not set up.

User account is disabled. This could be because the
authentication password is not set, and only the
encryption account is set.

account is unavailable: encryption is impossible. Encryption is not possible and account is disabled.
This could be because:

Security option is not installed.

Encryption password has not been specified.

add_sess_IPv4: bad trap<IPv4 address>,
community:<community name>

The IPv4 address (0.0.0.0.) is unavailable when
the community access type is TRAP. Specify the host
IPv4 address for the TRAP destination.

add_sess_IPv6: bad trap<IPv6 address>,
community:<community name>

The IPv6 address [::] is unavailable when the
community access type is TRAP. Specify the host
IPv6 address for the TRAP destination.

add_sess_IPv4: community<community name>
already defined.

The same community name already exists. Use
another community name.
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Message Problem and solutions

add_sess_IPv6: community <community name>
already defined.

The same community name already exists. Use
another community name.

add_sess_IPX: bad trap<IPX address>community
<community name>

The IPX address (00:00:00:00:00:00) is
unavailable when the community access type is
TRAP. Specify the host IPX address for the TRAP
destination.

add_sess_IPX: community <community name>
already defined.

The same community name already exists. Use
another community name.

Attach FileServer= <file server name> Connection to the file server as the nearest server
has been established.

Attach to print queue <print queue name> (In the print server mode) Attached to the print
queue.

Authentication mode mismatch< SSID > Authentication mode is different to the AP. The
required SSID is the SSID of the access point
connected to when in infrastructure mode.

btd is disabled. Communication via Bluetooth is unavailable
because btd is disabled in the security mode.
Enable the btd in the security mode.

centrod is disabled. Communication via parallel connections
unavailable because centrod is disabled in the
security mode.

Enable centrod in the security mode.

Cannot create service connection (In the remote printer mode) Connection to the file
server has not been established. The number of file
server users may have exceeded the maximum
capacity of the file server.

Cannot find rprinter (<print server name>/<printer
number>)

The printer with the number displayed on the print
server does not exist. Make sure that the printer
number is registered on the print server.

Change IP address from DHCP Server. The IP address changes when DHCP lease is
renewed. To always assign the same IP address,
set a static IP address to the DHCP server.
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Message Problem and solutions

child process exec error! (process name) The network service failed to start. Turn the printer
off and then on. If this does not work, contact your
service or sales representative.

Client password rejected The client's password was rejected. Check the client
password.

Client tls certificate rejected The client's TLS certificate was rejected. Check the
certificate.

Connected DHCP Server(<DHCP serveraddress>). The IP address was successfully received from the
DHCP server.

Could not attach to FileServer<error number> (In the remote printer mode) Connection to the file
server has not been established. The file server has
refused the connection. Check the file server
configuration.

Could not attach to PServer<print server> (In the remote printermode) Connection to the print
server has not been established. The print server
has refused the connection. Check the print server
configuration.

Current Interface Speed: xxx Mbps Speed of the network (10Mbps, 100 Mbps, or
1Gbps).

Current IP address <current IP address> Current IPv4 address.

Current IPX address<IPX address> Current IPX address

DHCP lease time expired. DHCP lease time has expired. The printer tries to
discover the DHCP server again. The IP address
until now becomes invalid.

DHCP server not found. The DHCP server was not found. Make sure that the
DHCP is on the network.

dhcpcd start The DHCPCD service (dhcp client service) has
started.

dpsd is disabled. Communication via PictBridge is unavailable
because PictBridge is disabled in the security mode.
Enable PictBridge in the security mode.
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Message Problem and solutions

Duplicate IP=<IP address>(from<MAC address>). The same IP address (IPv4, or IPv6 address) was
used. Each IP address (IPv4, or IPv6 address) must
be unique. Check the address of the device
indicated in [MAC address].

Established SPX Connection with PServer,
(RPSocket=<socketnumber>, connID=<connection
ID>)

(In the remote printer mode) Connection to the print
server has been established.

exiting The lpd service has ended and the system is exiting
the process.

Exit pserver (In the print server mode) The print server function
is disabled because the necessary print server
settings have not been made.

Frametype =<frame typename> The frame type name is configured to be used on
NetWare.

httpd start. The httpd service has started.

IEEE 802.11b <communication mode> mode Displays IEEE 802.11b communication mode.

inetd start. The inetd service has started.

Interface (interface name): Duplicate IP Address (IP
address).

The same IP (IPv4 or IPv6) address was used. Each
IP address must be unique. Check the address of
the device indicated in [IP address].

< Interface > started with IP: < IP address > IP address (IPv4, or IPv4 address) has been set for
the interface and is operating.

< Interface >: Subnet overlap. The same IP address (IPv4, or IPv6 address) and
the subnet mask is used with other device.

IPP cancel-job: permission denied. The printer could not authenticate the name of the
user attempting to cancel a job.

IPP job canceled. jobid=%d. The spooled job was canceled due to error or user
request.

LeaseTime=<lease time>(sec),
RenewTime=<renewtime>(sec).

The resource lease time received from the DHCP
server is displayed in [lease time] in seconds. The
renewal time is displayed in [renew time] in
seconds.
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Message Problem and solutions

Login to fileserver <file server name> (<IPX|IPv4|
IPv6>,<NDS|BINDERY>)

(In the print server mode) Login to the file server is
in the NDS or BINDERY mode.

Memory allocate error. Data cannot be obtained.

Disconnect the USB cable, and then connect it.

Name registration success. WINS Server=<WINS
server address> NetBIOS Name=<NetBIOS
name>

Name registration of <NetBIOS Name> to <WINS
server address> was successful.

Name registration success in Broadcast
name=<NetBIOS Name>

Name registration by Broadcast name of
<NetBIOS Name> was successful.

Name registration failed. name=<NetBIOS name> Name registration of <NetBIOSName> failed.
Change to different NetBIOS name.

nbtd start. The nbtd service has started.

nprinter start (Netware) (In the remote printer mode) The NetWare service
has started.

nwstart start. (NetWare) The service for NetWare protocol stack setting has
started.

Open log file <file name> (In the print server mode) The specified log file has
been opened.

phy release file open failed. Replacing the network interface board is required.
Contact your sales or service representative.

Print queue <print queue name> cannot be serviced
by printer 0, <print server name>

(In the print server mode) The print queue cannot
be established. Make sure that print queue exists
on the specified file server.

Print server <print server name>has no printer. (In the print server mode) The printer is not assigned
to the print server. Using NWadmin, assign the
printer, and then restart it.

print session full No more print jobs can be accepted.

Printer <printer name> has no queue (In the print server mode) The print queue is not
assigned to the printer. Using NWadmin, assign the
print queue to the printer, and then restart it.
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pserver start. (NetWare) (In the print server mode) The NetWare service has
started.

Required file server (<file servername>) not found The required file server is not found.

received EAP Failure EAP reception failed.

restarted. The lpd service has started.

sap enable, saptype=<SAP type>, sapname=<SAP
name>

The SAP function has started. The SAP packet is
issued to advertise the service on the SAP table on
the NetWare server.

server identity invalid The server ID is disabled. Check the server
authentication.

session IPv4 <community name> not defined. The requested community name is not defined.

session IPv6 <community name> not defined. The requested community name is not defined.

session <community name> already defined. The requested community name is not defined.

session_ipx <community name> not defined. The requested community name is not defined.

Set context to <NDS contextname> An NDS context name has been set.

smbd start. (NETBIOS) The smbd service has started.

SMTPC: failed to get smtp server ip-address. The SMTP server IP address could not be obtained.
This could be because:

The specified DNS server could not be found.

No connection to the network has been
established.

The specified DNS server could not be found.

An incorrect DNS server is specified.

The specified SMTP server IP address could not be
found in the DNS server.

SMTPC: failed to connect smtp server. timeout. Connection to the SMTP server failed due to
timeout. This could be because the specified SMTP
server name is incorrect, or no connection to the
network has been established, or the network
configuration is incorrect, so there is no response
from the SMTP server. Check the SMTP server
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name, or the network connection and
configuration.

SMTPC: refused connect by smtp server. Connection to the SMTP server is denied. This could
be because server other than the SMTP server has
been specified, or the specified SMTP server port
number is incorrect. Check the SMTP server name,
port number, or the SMTP server port number.

SMTPC: no smtp server. connection close. Connection to the SMTP server failed due to no
response from SMTP. This could be because a
server other than the SMTP server has been
specified, or the specified SMTP server port number
is incorrect. Check the SMTP server name, port
number, or the SMTP server port number.

SMTPC: failed to connect smtp server. Connection to the SMTP server failed. This could be
because no connection to the network has been
established, or the network configuration is
incorrect, so there is no response from the SMTP
server, or the specified SMTP server name is
incorrect, or the specified SMTP server IP address
could not be found in the DNS server, or a server
other than the SMTP server has been specified, or
the specified SMTP server port number is incorrect.
Check the DNS Server's IP address and SMTP
server's IP address, or the SMTP server name and
SMTP port number, or the SMTP server's SMTP port
number, or the network connection and
configuration.

SMTPC: username or password wasn't correct.
[response code] (information)

Connection to the SMTP server failed, because the
specified SMTP user name is incorrect, or the
specified SMTP password is incorrect. Check the
SMTP user name and password.

Snmp over IPv4 is ready Communication over IPv4 with snmp is available.

Snmp over IPv6 is ready. Communication over IPv6 with snmp is available.

Snmp over IPX is ready. Communication over IPX with snmp is available.

snmpd start. The snmpd service has started.
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started. The direct print service has started.

Started. The bonjour function is enabled.

Terminated. The bonjour function is disabled.

The print server received error <error number>
during attempt to log in to the network. Access to
the network was denied. Verify that the print server
name and password are correct.

Login to the file server failed. The print server is not
registered or a password is specified. Register the
print server without specifying a password.

too many pictures. PictBridge printing failed because too many image
are sent during one print transacation. Reduce
images at one print transaction.

trap account is unavailable. v3Trap cannot be sent. This could be because the
Trap destination account is different from the
account specified by the printer.

usbd is disable. Plug and Play function and printing is disabled
because usbd is disabled in the security mode.

Enable usbd in the security mode.

WINS name registration: No response to
server<WINS server address>

There was no response from the WINS server.
Check the correct WINS server address is entered.
Alternatively, check the WINS server is functioning
properly.

WINS wrong scopeID=<Scope ID> An invalid scope ID was used. Use a valid scope
ID.

wpa authentication Failed WPA authentication failed. Check the WPA
configuration.

wpa authentication started WPA authentication has started.

wpa IEEE802.1X started WPA authentication has started.

wpa connecting to authenticator WPA is connecting to authenticator.

wpa link up WPA key exchange has finished, and
communication has been terminated.

wpa probe response doesn't have IE. WPA probe response does not have IE.
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wpa success authenticated WPA authentication was successful.

wpa success key received WPA key reception was successful.

wpa waiting for key Waiting for WPA key.

wpasupd start wpasupd has started.

wpasupd stop wpasupd has ended.

• For details about UNIX commands and parameters, see UNIX Supplement.

• For details about "syslog" command, see p.240 "Remote Maintenance by telnet".
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7. Using a Printer Server

Preparing Printer Server
This section explains how to configure the printer as a Windows network printer. The printer is configured
to enabling network clients to use it. When the network printer is connected via SmartDeviceMonitor for
Client, you can set the printing notification function to notify clients of the results of their print jobs.

• Under Windows 2000, Windows XP Professional/Vista, or Windows Server 2003/2003 R2, to
change printer properties in the [Printer] folder, you need Printer Management access authentication;
under Windows NT 4.0, Full Control access authentication. Log on to the file server as an Administrator
or member of the PowerUsers group.

1. Open the [Printers] window from the [Start] menu.

The [Printers] window appears.

Preparing Printer Server Server 2003, [Printers and Faxes] window appears.

2. Click the icon of the printer you want to use. On the [File] menu, click [Properties]. The printer
properties appear.

3. On the [Sharing] tab, click [Shared as:].

4. To share the printer with users using a different version of Windows, click [Additional
Drivers...].

If you have installed an alternative driver by selecting [Shared as:] during the printer driver installation,
this step can be ignored.

5. Click [OK], and then close the printer properties.

Printing notification via SmartDeviceMonitor for Client

Follow the procedure below to configure the printer to use the printing notification function of
SmartDeviceMonitor for Client.

Setting the print server

• Under Windows 2000/ XP Professional/Vista, or Windows Server 2003/2003 R2, to change
printer properties in the [Printer] folder, you need Printer Management access authentication; under
Windows NT 4.0, Full Control access authentication. Log on to the file server as an Administrator or
member of the PowerUsers group.

305

7



1. On the [Start] menu, point to [Programs], DeskTopBinder, SmartDeviceMonitor for Client,
and then click [Print Server Setting].

The print server setting dialog box appears.

2. Select the [Notify client PCs of printout/data-transmission] check box, and then click [OK].

After print server setting is made, a dialog box appears. Confirm the dialog box content, and click
[OK].

Click [Cancel] to interrupt the procedure.

A dialog box appears for client setting.

3. A dialog box for specifying clients appears. Click [OK].

The print server setting is complete. Clients must be specified in order to receive notification.

• Current printing jobs restart from the beginning after the spooler pauses briefly.

• When the expansion function is not used, the function is automatically set as available.

• If you log on using an account that does not have Administrator privileges, the client may not be
notified.

Setting a Client

1. On the [Start] menu, point to [Program], DeskTopBinder, SmartDeviceMonitor for Client,
and then click [Extended Features Settings].

A dialog box for setting the expansion function appears.

2. Select the [Notify of printout/data-transmission when using print server] check box.

3. Select the [Notify when using the print server] check box.

4. Click [OK].

The dialog box for setting the expansion function closes.

The client setting is completed.

• Set the printing notification function on the printer driver as well as on SmartDeviceMonitor for
Client.
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Using NetWare
This section describes the setting procedure for network printers in the NetWare environment. In the
NetWare environment, you can connect the printer as a "print server" or "remote printer".

• IPv6 cannot be used on this function.

Setting procedure

• When using the printer as a print server

1. Installing SmartDeviceMonitor for Admin

2. Setting the network interface board.

3. Turning the printer off and then back on.

• When using the printer as a remote printer

1. Installing SmartDeviceMonitor for Admin.

2. Setting the network interface board.

3. Setting NetWare.

4. Starting the print server.

• This procedure assumes an environment is already prepared for normal NetWare running
the printing service setting.

• The procedure is explained with the following example settings:

• File server's name …CAREE

• Print server’s name …PSERV

• Printer’s name …R-PRN

• Queue name …R-QUEUE

Using SmartDeviceMonitor for Admin

To use the printer in a NetWare environment, use SmartDeviceMonitor for Admin to set the NetWare
printing environment.

• The NetWare Client provided by Novell is required to set the printing environment using
SmartDeviceMonitor for Admin under the following environments:

• NDS mode in Windows 95/98/Me

• NDS or Bindery mode in Windows 2000/XP/Vista, Windows NT 4.0
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• For details about installing SmartDeviceMonitor for Admin, see p.220 "Using
SmartDeviceMonitor for Admin" .

Printers listed by SmartDeviceMonitor for Admin

SmartDeviceMonitor for Admin lists printers connected to the network. If you cannot identify the printer
you want to configure, print configuration page, and then check the printer name.

Setting Up as a Print Server (NetWare 3.x)

Follow the procedure below to connect the printer as a print server using NetWare 3.x.

1. Start Web Image Monitor.

2. Click [Login].

A dialog box for entering the login user name and password appears.

3. Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your administrator.

4. Click [Configuration] in the left area, and then click [NetWare Print Settings].

• Print Server Name: Enter the NetWare print server name. To use the interface board as a print
server, enter the name of a print server that is not active on the file server. Use up to 47 characters.

• Logon Mode: Specify whether to designate a file server or NDS tree when logging on to
NetWare.

• File Server Name: When a file server name is entered here, only the specified file server is
searched for. This item is mandatory. Use up to 47 characters.

• NDS Tree: To enable NDS mode, enter the name of the NDS tree you want to log on to. Use up
to 32 alphanumeric characters.

• NDS Context Name: To enable NDS mode, enter the print server context. Use up to 127
characters.

• Operation Mode: Specify whether to use the interface board as a print server or a remote printer.

• Remote Printer No.: This item is effective when the interface board is specified as a remote printer.
Enter the same number as the number of the printer to be created on the print server (0 to 254
characters).

• Job Timeout: When the interface board is used as a NetWare remote printer, the printer cannot
detect when a print job ends. Therefore, the printer terminates printing when a certain period of
time has elapsed since it last received print data (i.e., when it has not received print data for a
certain period of time). Specify here this period of time (3 to 255 seconds). The initial value is
15 (seconds).

• Frame Type: Select the frame type from the drop-down menu.
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• Print Server Protocol: Select the protocol for NetWare from the drop-down menu.

• NCP Delivery Protocol: Select the protocol for NCP delivery.

5. Confirm the settings, and then click [OK].

Configuration is now complete. Wait several before restarting Web Image Monitor.

6. Click [Logout].

• To check that the configuration is made correctly, enter the following from the command prompt.

F:> USERLIST

• If the printer works as configured, the name of the print server appears as a connected user.

• If you cannot identify the printer you want to configure, check the printer name with the
configuration page printed from the printer. For details about printing a configuration page, see
p.184 "List/Test Print Menu" .

• If no printer names appear in the list, match the frame types of IPX/SPXs for the computer and
printer. Use the [Network] dialog box of Windows to change the frame type of the computer.

Setting Up as a Print Server (NetWare 4.x, 5/5.1, 6/6.5)

Follow the procedure below to connect the printer as a print server using NetWare 4.x, NetWare 5/5.1,
or NetWare 6.0.

• When using the printer as a print server in NetWare 4.x, NetWare 5/5.1, or NetWare 6.0, set it to
the NDS mode.

• When using NetWare 5/5.1 or NetWare 6.0, set the printer as a print server.

1. Start Web Image Monitor.

2. Click [Login].

A dialog box for entering the login user name and password appears.

3. Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your administrator.

4. Click [Configuration] in the left area, and then click [NetWare Print Settings].

• Print Server Name: Enter the NetWare print server name. To use the interface board as a print
server, enter the name of a print server that is not active on the file server. Use up to 47 characters.

• Logon Mode: Specify whether to designate a file server or NDS tree when logging on to
NetWare.

• File Server Name: When a file server name is entered here, only the specified file server is
searched for. This item is mandatory. Use up to 47 characters.
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• NDS Tree: To enable NDS mode, enter the name of the NDS tree you want to log on to. Use up
to 32 alphanumeric characters.

• NDS Context Name: To enable NDS mode, enter the print server context. Use up to 127
characters.

• Operation Mode: Specify whether to use the interface board as a print server or a remote printer.

• Remote Printer No.: This item is effective when the interface board is specified as a remote printer.
Enter the same number as the number of the printer to be created on the print server (0 to 254
characters).

• Job Timeout: When the interface board is used as a NetWare remote printer, the printer cannot
detect when a print job ends. Therefore, the printer terminates printing when a certain period of
time has elapsed since it last received print data (i.e., when it has not received print data for a
certain period of time). Specify here this period of time (3 to 255 seconds). The initial value is
15 (seconds).

• Frame Type: Select the frame type from the drop-down menu.

• Print Server Protocol: Select the protocol for NetWare from the drop-down menu.

• NCP Delivery Protocol: Select the protocol for NCP delivery.

5. Confirm the settings, and then click [OK].

Configuration is now complete. Wait several minutes before restarting Web Image Monitor.

6. Click [Logout].

• To check that the configuration is made correctly, enter the following from the command prompt.

F:> NLIST USER/A/B

• If the printer works as configured, the name of the print server appears as a connected user.

• If you cannot identify the printer you want to configure, check the printer name with the
configuration page printed from the printer. For details about printing a configuration page, see
p.184 "List/Test Print Menu" .

• If no printer names appear in the list, match the frame types of IPX/SPXs for the computer and
printer. Use the [Network] dialog box of Windows to change the frame type of the computer.

Using Pure IP in the NetWare 5/5.1 or 6/6.5 Environment

Follow the procedure below to connect the printer as a print server in a pure IP environment of NetWare
5/5.1.

• When creating a queued print server in a pure IP environment of NetWare 5/5.1 or NetWare 6.0,
create a print queue on the file server using NetWare Administrator.
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• This printer is not available as a remote printer for use in a pure IP environment.

• To use the printer in a pure IP environment, set it to TCP/IP.

Setting up using NWadmin

1. From Windows, start NWadmin.

For details about NWadmin, see the NetWare manuals.

2. Select the object in which the print queue is located in the directory tree, and then click
[Create] on the [Object] menu.

3. In the [Class of new object] box, click [Print Queue], and then click [OK].

4. In the [Print Queue Name] box, enter the name of the print queue.

5. In the [Print Queue Volume] box, click [Browse].

6. In the [Available objects] box, click the volume in which the print queue is created, and then
click [OK].

7. Check the settings, and then click [Create].

8. Select the object in which the printer is located, and then click [Create] on the [Object] menu.

9. In the [Class of new object] box, click [Printer], and then click [OK]. For NetWare 5, click
[Printer (Non NDPS)].

10. In the [Printer name] box, enter the printer name

11. Select the [Define additional properties] check box, and then click [Create].

12. Click [Assignments], and then click [Add] in the [Assignments] area.

13. In the [Available objects] box, click the queue you, and then click [OK].

14. Click [Configuration], click [Parallel] in the [Printer type] list, and then click
[Communication].

15. Click [Manual load] in the [Communication type] area, and then click [OK].

16. Check the settings, and then click [OK].

17. Select a context specified using NIB Setup Tool, and then click [Create] on the [Object] menu.

18. In the [Class of new object] box, click [Print Server], and then click [OK]. For NetWare 5,
click [Print Sever (Non NDPS)].

19. In the [Print Server Name] box, enter the print server name.

Use the same print server name specified using NIB Setup Tool.

20. Select the [Define additional properties] check box, and then click [Create].

21. Click [Assignments], and then click [Add] in the [Assignments] area.

22. In the [Available objects] box, click the queue you created, and then click [OK].

23. Check the settings, and then click [OK].
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24. Start the print server by entering the following from the console of the NetWare server.

If the print server is in operation, quit and restart it.

To exit

CAREE: unload pserver

To start

CAREE: load pserver "print_server_name"

Setting up using Web Image Monitor

1. Start Web Image Monitor.

2. Click [Login].

A dialog box for entering the login user name and login password appears.

3. Enter the login user name and password, and then click [Login].

For details about the login name and password, consult your administrator.

4. Click [Configuration] in the left area, and then click [NetWare Print Settings].

5. Confirm the settings, and then click [OK].

Configuration is now complete. Wait several minutes before restarting Web Image Monitor.

6. Click [Logout].

Setting Up as a Remote Printer (NetWare 3.x)

Follow the procedure below to use the printer as a remote printer under NetWare 3.x.

Setting up using PCONSOLE

1. Enter "PCONSOLE" from the command prompt.

F:> PCONSOLE

2. Create a print queue.

When using the existing print queue, go to the procedure for creating a printer.

3. From the [Available Options] menu, select [Print Queue Information], and then press the
[Enter] key.

4. Press [Insert] key, and then enter a print queue name.

5. Press [Esc] key to return to the [Available Options] menu.

6. Set up the network connection to a printer.

7. On the [Available Options] menu, click [Print Server Information], and then press the [Enter]
key.
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8. To create a new print server, press the [Insert] key, and then enter a print server name.

For a currently defined print server, select a print server in the [Print Server] list.

9. From the [Print Server Information] menu, select [Print Server Configuration].

10. From the [Print Server Configuration] menu, select [Printer Configuration].

11. Select the printer indicated as [Not Installed].

12. To change the printer name, enter a new name.

A name "Printer x" is assigned to the printer. The "x" stands for the number of the selected printer.

13. As type, select [Remote Parallel, LPT1].

The IRQ, Buffer size, Starting form, and Queue service mode are automatically configured.

14. Press the [Esc] key, and then click [Yes] on the confirmation message.

15. Press the [Esc] key to return to [Print Server Configuration Menu].

16. Assign print queues to the created printer.

17. From [Print Server Configuration Menu], select [Queues Serviced By Printer].

18. Select the printer created.

19. Press the [Insert] key to select a queue serviced by the printer.

You can select several queues.

20. Follow the instructions on the screen to make other necessary settings.

Following these steps, check that the queues are assigned.

21. Press the [Esc] key until "Exit?" appears, and then select [Yes] to exit PCONSOLE.

22. Start the print server by entering the following from the console of the NetWare server.

If the print server is in operation, quit and restart it.

To quit

CAREE: unload pserver

To start

CAREE: load pserver "print_server_name"

• If the printer works as configured, the message "Waiting for job" appears.

Setting up using Web Image Monitor

1. Start Web Image Monitor.

2. Click [Login].

A dialog box for entering the login user name and login password appears.

3. Enter the login user name and password, and then click [Login].

For details about the login name and password, consult your administrator.
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4. Click [Configuration] in the left area, and then click [NetWare Print Settings].

5. Confirm the settings, and then click [OK].

Configuration is now complete. Wait several minutes before restarting Web Image Monitor.

6. Click [Logout].

Setting Up as a Remote Printer (NetWare 4.x, 5/5.1, 6/6.5)

Follow the procedure below to use the printer as a remote printer under NetWare 4.x, 5/5.1 and 6.

• To use the printer as a remote printer under NetWare 4.x/5/5.1, set it to NDS mode.

• Do not use the printer as a remote printer when Pure IP is used.

Setting up using NWadmin

1. From Windows, start NWadmin.

For details about NWadmin, see the NetWare manuals.

2. Set up the network connection to a print queue. Select the object in which the print queue is
located in the directory tree, and then click [Create] on the [Object] menu.

3. In the [Class of new object] box, click [Print Queue], and then click [OK].

4. In the [Print Queue Name] box, enter the name of the print queue.

5. In the [Print Queue Volume] box, click [Browse].

6. In the [Available objects] box, click the volume in which the print queue is created, and then
click [OK].

7. Check the settings, and then click [Create].

8. Set up the network connection to a printer. Select the object in which the printer is located,
and then click [Create] on the [Object] menu.

9. In the [Class of new object] box, click [Printer], and then click [OK]. For NetWare 5, click
[Printer (Non NDPS)].

10. In the [Printer name] box, enter the printer name

11. Select the [Define additional properties] check box, and then click [Create].

12. Assign print queues to the created printer. Click [Assignments], and then click [Add] in the
[Assignments] area.

13. In the [Available objects] box, click the queue you created, and then click [OK].

14. Click [Configuration], click [Parallel] in the [Printer type] list, and then click
[Communication].
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15. Click [Manual load] in the [Communication type] area, and then click [OK]. Check the
settings, and then click [OK].

16. Set up the network connection to a print server. Select a context specified using NIB Setup
Tool, and then click [Create] on the [Object] menu.

17. In the [Class of new object] box, click [Print Server], and then click [OK]. For NetWare 5,
click [Print Sever (Non NDPS)].

18. In the [Print Server Name] box, enter the print server name.

Use the same print server name specified using NIB Setup Tool.

19. Select the [Define additional properties] check box, and then click [Create].

20. Assign the printer to the created print server. Click [Assignments], and then click Add in the
[Assignments] area.

21. In the [Available objects] box, click the queue you created, and then click [OK].

22. In the [Printers] area, click the printer you assigned, and then click [Printer] [Number].

23. Enter the printer number, and then click [OK]. Check the settings, and then click [OK].

24. Start the print server by entering the following from the console of the NetWare server.

If the print server is in operation, quit and restart it.

To exit

CAREE: unload pserver

To start

CAREE: load pserver "print_server_name"

25. Enter the printer server name as the context name, and then press the [OK] key.

26. Select the printer name on the context menu, and then press the [OK] key.

Setting up using Web Image Monitor

1. Start Web Image Monitor.

2. Click [Login].

A dialog box for entering the login user name and login password appears.

3. Enter the login user name and password, and then click [Login].

For details about the login name and password, consult your administrator.

4. Click [Configuration] in the left area, and then click [NetWare Print Settings].

5. Confirm the settings, and then click [OK].

Configuration is now complete. Wait several minutes before restarting Web Image Monitor.

6. Click [Logout].
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8. Special Operations under Windows

Printing Files Directly from Windows
You can print files directly using Windows commands. For example, you can print PostScript files for
PostScript 3.

Windows 95/98/Me

You can print files directly using "ftp" command.

Windows 2000/XP/Vista, Windows Server 2003/2003 R2, Windows NT 4.0

You can print files directly using "lpr", "rcp", or "ftp" command.

• To use “sftp” commands, use an sftp client software that is compatible with ssh v2.

Setup

Follow the procedure below to make network environment settings.

1. Enable TCP/IP with the control panel, and then set up the printer’s network environment
about TCP/IP including IP addresses.

TCP/IP of the printer is set as default.

2. Install a TCP/IP in Windows to set up the network environment.

Consult the administrator for the local setting information.

3. To print under Windows 2000/XP/Vista, Windows Server 2003/2003 R2, or Windows NT
4.0, install "Printing service for UNIX" as the network application. To print under Windows
NT 4.0, install "Microsoft TCP/IP printing" as the network application.

• For details about setting up "IPv4 address", see Hardware Guide.

• For details about setting the "IPv4 address" of the printer using DHCP, see p.373 "Cautions to
Take When Using in a network".

Using a Host Name Instead of an IPv4 Address

When a host name is defined, you can specify a printer by host name instead of IPv4 address. The host
names vary depending on the network environment.
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When using DNS

Use the host name set to the data file on the DNS server.

When setting the "IPv4 address" of a printer using DHCP

Use the printer name on the configuration page as the host name.

• For details about printing a configuration page, see p.184 "List/Test Print Menu".

In other cases

Add the IPv4 address and host name of the network printer to the hosts file on the computer used for printing.
Methods of addition vary depending on operating systems.

Windows 95/98/Me

1. Copy \WINDOWS\HOSTS.SAM to the same directory and name it "HOSTS" with no
extension.

2. Open the "\WINDOWS\HOSTS" file created using memo pad files, for instance.

3. Add an IP address and host name to the hosts file using the following format:

192.168.15.16 host # NP

"192.168.15.16" is the "IPv4 address", "host" is the printer's host name, and "#NP" is replaced by
comments. Insert a space or tab between "192.168.15.16" and "host", between "host" and "#NP"
respectively, using one line for this format.

4. Save the file.

Windows 2000/XP/Vista, Windows Server 2003/2003 R2, Windows NT 4.0

1. Open the hosts file using memo pad files, for instance.

The hosts file is in the following folder:

\WINNT\SYSTEM32\DRIVERS\ETC\HOSTS

"\WINNT" is the directory of the installation destination for Windows 2000/XP/Vista, Windows
Server 2003/2003 R2, and Windows NT 4.0.

2. Add an IPv4 address and host name to the hosts file using the following format:

192.168.15.16 host # NP

"192.168.15.16" is the "IPv4 address", "host" is the printer's host name, and "#NP" is replaced by
comments. Insert a space or tab between "192.168.15.16" and "host", between "host" and "#NP"
respectively, using one line for this format.
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3. Save the file.

• When using a host name under Windows Server 2003 with IPv6 protocol, perform host name
resolution using an external DNS server. The host file cannot be used.

Printing Commands

The following explains printing operations using the "lpr", "rcp", and "ftp" commands.

Enter commands using the command prompt window. The location of the command prompts varies
depending on operating systems:

• Windows 95/98

[Start] - [Programs] - [MS-DOS Prompt]

• Windows Me

[Start] - [Programs] - [Accessories] - [MS] - [DOS Prompt]

• Windows 2000

[Start] - [Programs] - [Accessories] - [Command Prompt]

• Windows XP/Vista, Windows Server 2003/2003 R2

[Start] - [All Programs] - [Accessories] - [Command Prompt]

• Windows NT 4.0

[Start] - [Programs] - [Command Prompt]

• Match the data format of the file to be printed with the emulation mode of the printer.

• If the message "print requests full" appears, no print jobs can be accepted. Try again when sessions
end. For each command, the amount of possible sessions is indicated as follows:

• lpr: 10

• rcp, rsh: 5

• ftp: 3

• Enter the file name in a format including the path from the directory executing commands.

• The "option" specified in a command is an intrinsic printer option and its syntax is similar to printing
from UNIX. For details, see UNIX Supplement.
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lpr

When specifying a printer by IP address

c:> lpr -Sprinter's IP address [-Poption] [-ol] \pass name\file name

When using a host name instead of an IP address

c:> lpr -Sprinter's host name [-Poption] [-ol] \pass name\file name

When printing a binary file, add the "-ol" option (lowercase O, and lowercase L).

When using a printer with the host name "host" to print a PostScript file named "file 1" located in the "C:
\PRINT" directory, the command line is as follows:

c:> lpr -Shost -Pfiletype=RPS -ol C:\PRINT\file1

rcp

First, register the printer's host name in the hosts file.

c:> rcp [-b] \pass name\file name [pass name\file name...] printer's host name:

[option]

• In file names, "*" and "?" can be used as wild cards.

• When printing a binary file, add the "-b" option.

When using a printer with the host name "host" to print a PostScript file named "file 1" or "file 2" located in
the "C:\PRINT" directory, the command line is as follows:

c:> rcp -b C:\PRINT\file1 C:\PRINT\file2 host:filetype=RPS

ftp

Use the "put" or "mput" command according to the number of files to be printed.

When one file is printed

ftp> put \pass name\file name [option]

When multiple files are printed

ftp> mput \pass name\file name [\pass name\file name...] [option]

1. Formulate the printer's IP address or the host name of the hosts file printer as an argument
and use the "ftp" command.

% ftp printer's IP address

2. Enter the user name and password, and then press the [OK] key.

For details about the user name and password, consult your administrator.

User:
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Password:

3. When printing a binary file, set the file mode to binary.

ftp> bin

When printing a binary file in ASCII mode, print may not come out correctly.

4. Specify files to be printed.

The following shows the examples of printing a PostScript file named "file 1" in the "C:\PRINT"
directory and printing file 1 and file 2.

ftp> put C:\PRINT\file1 filetype=RPS

ftp> mput C:\PRINT\file1 C:\PRINT\file2

5. Quit ftp.

ftp> bye

• "=", ",", "_", and ";"cannot be used for filenames. File names will be read as option strings.

• For "mput" command, option can not be defined.

• For "mput" command, "*" and "?" can be used as wild cards in file names.

• When printing a binary file in ASCII mode, print may not come out correctly.
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9. Mac OS Configuration

Mac OS
This section explains how to configure a Mac OS to use EtherTalk and USB.

The following explains how to configure Mac OS 9.1. If you are not using Mac OS 9.1, see the manual
of the Mac OS you are using for details.

• For Mac OS 8.6 and higher. (Mac OS X Classic environment is supported.)

• The PostScript 3 printer driver is stored in the following folder on the CD-ROM.

• Mac OS 8 and 9:PS Driver:(language):Disk1

Installing the PostScript 3 Printer Driver and PPD File

It is necessary to install a printer driver and PostScript Printer Description (PPD) files to print from a Mac
OS.

Follow the procedure below to install a printer driver and a PPD file into a Mac OS using Mac OS 8.6 and
higher.

PostScript 3 Printer Driver

1. Insert the CD-ROM into the CD-ROM drive.

2. Double-click the CD-ROM drive icon.

3. Double-click the [Mac OS 8 and 9] folder.

4. Double-click the [PS Driver] folder.

5. Double-click the folder of the language you use.

6. Open [Disk1], and then double-click the installer icon.

7. Follow the instructions on the screen.

PPD Files

1. Double-click the CD-ROM drive icon.

2. Double-click the [Mac OS 8 and 9] folder.

3. Double-click the [Printer Descriptions] folder.

4. Double-click the folder of the language you use.

5. Open the [Disk1] folder.
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6. Drag the PPD file and the plugin file into [Printer Descriptions] in [Extensions] under [System
Folder].

7. Restart the Mac OS.

Setting Up PPD Files

• Make sure that the printers are connected to an AppleTalk network before performing the following
procedure.

1. On the [Apple] menu, click [Chooser].

2. Click the Adobe PS icon.

3. In the [Select a PostScript Printer:] list, click the name of the printer you want to use.

4. Click [Create].

5. Click the printer you want to use, and then click [Select].

6. A PPD file is set up and the Adobe PS icon appears at the left of the printer name in the list.

Creating a Desktop Printer Icon

• Make sure that printers are connected to the USB before performing the following procedure.

To use a printer connected by USB, create a desktop printer icon.

1. Double-click [Desktop Printer Utility] in the [AdobePS Components] folder.

2. Click [AdobePS] in [With], click [Printer (USB) in] Create Desktop, and then click [OK].

3. Click [Change] in [USB Printer Selection].

4. Select the model you are using in [Select a USB Printer:], and then click [OK].

5. Click [Create].

6. Enter the printer name, and then click [Save].

7. Quit Desktop Printer Utility.

Setting Up Options

1. On the [Apple] menu, click [Chooser].

2. Click the Adobe PS icon.
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3. In the [Select the PostScript Printer:] list, click the name of the printer you want to use, and
then click [Setup...].

4. Click [Configure].

A list of options appears.

5. Select the option you want to set up, and then select an appropriate setting for it.

6. Click [OK].

The list of options closes.

7. Click [OK].

The [Chooser] dialog box appears.

8. Close the [Chooser] dialog box.

• If the option you want to select is not displayed, PPD files may not be set up correctly. To complete
the setup, check the name of the PPD file displayed in the dialog box.

Installing the ColorSync Profiles

ColorSync profiles enable a printer to print colors consistent with those on the computer display. You must
install the ColorSync profile to use this function.

Follow the procedure below to install the ColorSync profiles.

1. Start a Mac OS.

2. Double-click the hard disk icon, and then open the appropriate folder for installing the
ColorSync profiles.

The location of the appropriate folder may vary depending on the version of the Mac OS. The
following are examples:

• System: Preferences: ColorSync profiles

• System: ColorSync profiles

3. Insert the CD-ROM into the CD-ROM drive.

The CD-ROM drive icon appears.

4. Double-click the CD-ROM drive icon.

The contents of the CD-ROM appear.

5. Double-click the [Mac OS 8 and 9] folder.

6. Double-click the [ColorSync Profiles] folder.

7. Drag the file to the [ColorSync Profiles] folder under [System Folder].

The ColorSync profiles are installed.

Mac OS
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The ColorSync profiles are consistent with color characteristics defined by the International Color
Consortium (ICC).

For some computer displays, particular settings need to be created by ColorSync. For details, see the
appropriate manuals for your computer display.

Installing Adobe Type Manager

• Quit all applications currently running before installation. Install ATM after you restart the computer.

1. Start a Mac OS.

2. Insert the CD-ROM into the CD-ROM drive.

3. Double-click the CD-ROM drive con.

4. Double-click the [Mac OS 8 and 9] folder.

5. Double-click the [ATM folder].

6. Double-click the ATM 4.6.2 installer icon.

7. Follow the instructions on the screen.

8. When the procedure is complete, restart the computer. ATM will be completely installed only
after restarting.

9. On the [Apple] menu, open [Control Panel], and then click [~ATM].

The ATM control panel opens.

• For details about installation, see the operating instructions in the ATM folder.

Installing Screen fonts

Follow the procedure below to install screen fonts.

The screen fonts described below can be found in the [Fonts] folder on the CD-ROM.

1. Start a Mac OS.

2. Insert the CD-ROM into the CD-ROM drive.

The CD-ROM drive icon appears.

3. Double-click the CD-ROM drive icon.

The contents of the CD-ROM appear.

4. Double-click the [Mac OS 8 and 9] folder.

5. Double-click the [Fonts] folder.
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6. Double-click the [ScreenFonts] folder.

7. Double-click the [TrueType] or Type1 folder.

Select the font type you want to use.

8. Copy the fonts you want to install in Fonts under [System Folder].

9. A confirmation message appears.

10. Click [OK].

The fonts are installed.

11. Restart the Mac OS.

Changing to EtherTalk

Follow the procedure below to configure to a Mac OS to use EtherTalk.

1. Open [Control Panel], and then double-click the AppleTalk icon.

2. On the [Connect via:] pop-up menu, click [Ethernet].

3. If you change zones, select a name on the [OK] pop-up menu.

4. Close the AppleTalk control panel.

5. Restart the computer.

• The procedures used to configure Mac OS may vary depending on the Mac OS version. The
following describes how to configure Mac OS 9.1. If you are using a different version of Mac
OS, use the following procedures as a reference and see the manuals for your Mac OS version.

• Confirm the Connection to the Printer with TCP/IP.

• For information about installing applications required for EtherTalk, see the Mac OS manuals.
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Mac OS X
This section explains how to configure a Mac OS X to use EtherTalk and USB.

Follow the procedure below to configure Mac OS X 10.1. If you are not using Mac OS X 10.1, see the
manual of the Mac OS X you are using for details.

• For Mac OS X 10.1 or higher.

• The PPD files are stored in the following folder on the CD-ROM.

Mac OS X:PPD Installer

Installing the PPD Files

Follow the procedure below to install a PPD file to print from Mac OS X.

• You need an administrator name and a password (phrase). For details, consult your administrator.

1. Insert the CD-ROM into the CD-ROM drive.

2. Double-click the CD-ROM drive icon.

3. Double-click the [Mac OS X] folder.

4. Double-click the [MacOSX PPD Installer] folder.

5. Double-click the installer icon.

6. Follow the instructions on the screen.

Setting Up the PPD File

1. Start Printer Setup Utility.

2. Click [Add].

Mac OS X 10.4 or later

Click [More Printers...]. Then select the zone from the second pop-up menu.

Other Mac OS X

Click [AppleTalk] on the first pop-up menu.

If the zone is set, select the zone from the second pop-up menu.
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3. Select the printer, and then select its manufacturer from the [Printer Model:] pop-up menu.

Under Mac OS X 10.4 or later, select the printer you are using from the [Print Using] popup menu.

A list of printer types appears.

4. Select the PPD file for the model you are using, and then click [Add].

5. Quit Printer Setup Utility.

Setting Up Options

1. Start System Preferences.

2. Click [Print & Fax].

3. In the [Printer] list, click the name of the printer you want to use, and then click [Printer
Setup...].

4. Select the option you want to set up, and then select an appropriate setting for it.

5. Click [Apply Changes].

• If the option you want to select is not displayed, PPD files may not be set up correctly. To complete
the setup, check the name of the PPD file displayed in the dialog box.

Using USB Interface

Follow the procedure below to setup USB connection.

1. Start Printer Setup Utility.

2. Click [Add].

Mac OS X 10.4 or later

Click a printer that has "USB" indicated in the "Connection" column.

Other Mac OS X

Click [USB] on the pop-up menu.

The connected printer appears.

3. Select the printer, and then select its manufacturer from the [Printer Model:] pop-up menu.

Under Mac OS X 10.4 or later, you are using from the [Print Using] pop-up menu.

A list of printer types appears.

4. Select the connected printer from the list of printer models, and then click [Add].
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329

9



5. Quit Printer Setup Utility.

• When printing with a USB connection to a Macintosh computer, printer language does not
change automatically. Use the control panel on this printer to change printer language to [Auto
Detect] or [PS] before printing.

• USB2.0 can be used only with Mac OS X 10.3.3 or higher.

Using Bonjour

Follow the procedure below to print using Bonjour under Mac OS X 10.2.3 or higher. Ethernet, wireless
LAN connections can also be used.

1. Start Printer Setup Utility.

2. Click [Add].

Mac OS X 10.4 or later

Click a printer that has "Bonjour" indicated in the "Connection" column.

Other Mac OS X

Click [Rendezvous] on the pop-up menu.

3. Select the name of the connected printer from the list of printer models, and then click [Add].

Under Mac OS X 10.4 or later, Installable Options window appears. Select the option you want to
set up, and then select an appropriate setting for it, and then [Continue].

4. Quit Printer Setup Utility.

When printing with a Rendezvous connection to a Macintosh computer, printer language does not
change automatically. Use the control panel on this printer to change printer language to [Auto Detect]
or [PS] before printing.

Changing to EtherTalk

Follow the procedure below to configure a Mac OS X to use EtherTalk.

• You need an administrator name and a password (phrase). For details, consult your administrator

1. Open [System Preference], and then click the Network icon.

2. Click [Built-in Ethernet] in the [Show:] list box.

3. Click the [AppleTalk] tab.

4. Select the [Make AppleTalk Active] check box.
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5. To change AppleTalk zones, select a name from the [AppleTalk Zone:] pop-up menu.

6. When the settings are made, click [Apply Now].

7. Quit [System Preference].

• For information about installing applications required for EtherTalk, see the Mac OS manuals.
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Configuring the Printer
Use the control panel to enable AppleTalk. (The default is active.)

9. Mac OS Configuration

332

9



Using PostScript 3

Job Type

Use this to select the type of print job.

The following table shows the tabs or menus where you can select this function.

Mac OS [Job Type:] on [Job Log] in the print dialog box.

Mac OS X [Job Type:] on [Job Log] in the print dialog box.

You can select the following items:

Normal Print

Select this for normal printing. The print job starts immediately after the print command is given.

Sample Print

Use this function to print only one set of a multiple print jobs.

The other sets are saved in the printer. The saved job can be printed from the printer's control panel.
You can also delete the saved job.

• The "User ID:" can contain up to eight alphanumeric (a- z, A- Z, 0- 9) characters.

• Entering the "User ID:" helps you distinguish your print job from others.

Locked Print

Use this function to save documents in the printer memory with a password, and then edit and print
them as you want.

• The "User ID:" can contain to eight alphanumeric (a-z, A-Z, 0-9) characters. The "Password"
must be 4-8 digits.

• Entering the "User ID:" helps you distinguish your print job from others.

Hold Print

Use this function to temporarily hold a file in the printer, and print it from the computer or the printer's
control panel later.

• The "User ID:" can contain up to eight alphanumeric (a- z, A- Z, 0- 9) characters.

• The "File Name:" can contain to 16 alphanumeric (a-z, A-Z, 0-9) characters.

• Entering the "User ID:" helps you distinguish your print job from others.

Using PostScript 3

333

9



Stored Print

Use this function to store a file in the printer, and then print it from the computer or the printer's control
panel later.

• The "User ID:" can contain up to eight alphanumeric (a- z, A- Z, 0- 9) characters. The "Password"
must be 4-8 digits.

• The "File Name:" can contain to 16 alphanumeric (a-z, A-Z, 0-9) characters.

• You can assign a password to a saved document, but password assignment is not mandatory.

• Entering the "User ID:" helps you distinguish your print job from others.

Store and Print

Use this function to prints the file at once and also stores the file in the printer.

• The "User ID:" can contain up to eight alphanumeric (a- z, A- Z, 0- 9) characters. The "Password"
must be 4-8 digits.

• The "File Name:" can contain to 16 alphanumeric (a-z, A-Z, 0-9) characters.

• You can assign a password to a saved document, but password assignment is not mandatory.

• Entering the "User ID:" helps you distinguish your print job from others.

Using Sample Print

• You need Mac OS X v10.2 or higher to use this function.

• The number of pages the printer can save varies depending on the contents of the print images. At
most, the printer can save 100 jobs or 9,000 pages for Sample Print, Locked Print, Hold Print and
Stored Print.

• Sample Print files will not appear on the display panel if they have already been executed or deleted
using the Web browser before you select [Sample Print] from the control panel.

• Sample Print files printed or deleted using Web Image Monitor after you select [Sample Print] using
the control panel will appear on the display panel. However, an error message will appear if you try
to print or delete those Sample Print files.

• If the application has a collate option, make sure that it is not selected before sending a print job. By
default, sample print jobs are automatically collated by the printer driver. If the collate option is
selected in the application print dialog box, more prints than intended may be printed.

• Print jobs are not saved on the hard disk in the following cases. You can check the error log for jobs
not saved.
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• When there are 100 Sample Print, Locked Print, Hold Print and Stored Print jobs saved on the
hard disk.

• When the total number of pages saved on the hard disk exceeds 9,000 pages.

1. In the application, on the [File] menu, click [Print].

The [Print] dialog box appears.

2. Set the number of copies to two or more.

The sample print job is sent to the printer, and one set is printed.

3. In the pop-up menu, click [Job Log].

4. On the [Job Type:] pop-up menu, select [Sample Print].

5. In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters.

The user ID associates the user with his/her jobs.

6. Check the printed output to make sure the settings are correct.

If the settings are correct, perform the following steps to print the remaining sets.

If you want to delete a saved job, see p.117 "Sample Print".

7. On the printer's control panel, press [Prt.Jobs].

8. Select [Sample Print Jobs], and then press [Job List].

A list of sample print files stored in the printer appears.

User ID, Date/Time and File Name also appear.

9. Select the file you want to print by pressing it.

A list of print files stored in the printer appears.

10. Press [Print] to change the number of sets to be printed.

11. Enter the new number of sets using the number keys.

If you do not want to change the set quantity, perform the following steps.

You can enter up to 999 sets.

Press [Escape] to correct any entry mistakes.

12. Press [Print].

The remaining sets are printed.

• Press [Cancel] to cancel printing.

• When printing finishes, the stored file is deleted.

• To stop printing after printing has started, press [Job Reset]. The file will be deleted.

• If there is a print job outstanding, this is printed before the sample print job.
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Deleting a Sample Print File

1. Press [Prt.Jobs].

A list of print files stored in the printer appears.

2. Select [Sample Print Jobs], and then press [Job List].

A list of sample print files stored in the printer appears.

3. Select the file you want to delete by pressing it.

To cancel a selection, press the highlighted jobs again.

Only one file can be selected at a time.

4. Press [Delete].

A confirmation screen appears.

5. Press [Delete] to delete the file.

After the file is deleted, the printer screen reappears.

• Press [Cancel] to cancel the delete request.

Using Locked Print

• You need Mac OS X v10.2 or higher to use this function.

• The number of pages the printer can save varies depending on the contents of the print images. At
most, the printer can save 100 jobs or 9,000 pages for Sample Print, Locked Print and Hold Print.

• Locked Print files will not appear on the display panel if they have already been printed or deleted
using Web Image Monitor before you select [Locked Print] using the control panel.

• Locked Print files printed or deleted using Web Image Monitor after you have selected [Locked Print]
using the control panel will still appear on the display panel. However, an error message will appear
if you try to print or delete those Locked Print files.

• If the application has a collate option, make sure that it is not selected before sending a print job. By
default, locked print jobs are automatically collated by the printer driver. If the collate option is selected
in the application print dialog box, more prints than intended may be printed.

• Print jobs are not saved on the hard disk in the following cases. You can check the error log for jobs
not saved.

• When there are 100 Sample Print, Locked Print, Hold Print and Stored Print jobs saved on the
hard disk.

• When the total number of pages saved on the hard disk exceeds 9,000 pages.

9. Mac OS Configuration

336

9



1. In the application, click [Print] on the [File] menu.

The [Print] dialog box appears.

2. In the pop-up menu, click [Job Log].

3. On the [Job Type:] pop-up menu, click [Locked Print].

4. In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters, and then enter a 4-8 digit password in the [Password:] box.

The user ID associates the user with his/her jobs.

5. After making the necessary settings, click [Print].

The document file is saved in the printer.

To print the document, perform the following steps.

To delete the document, see p.120 "Locked Print".

6. On the printer's control panel, press [Prt.Jobs].

7. Select [Locked Print Jobs], and then press [Job List].

A list of locked print files stored in the printer appears.

User ID, Date/Time and File Name also appear.

8. Select the file you want to print by pressing it.

A list of print files stored in the printer appears.

9. Press [Print].

The password screen appears.

10. Enter the password using the scroll keys, and then press [OK].

A confirmation screen appears.

A confirmation screen will appear if the password is not entered correctly. Press [OK] to enter the
password again.

11. Press [Print].

The locked file is printed.

• Press [Cancel] to cancel printing.

• When printing finishes, the stored file is deleted.

• To stop printing after printing has started, press [Job Reset]. The file will be deleted.

Deleting a Locked Print File

1. Press [Prt.Jobs].

A list of print files stored in the printer appears.
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2. Select [Locked Print Jobs], and then press [Job List].

A list of locked print files stored in the printer appears.

3. Select the file you want to delete by pressing it.

To cancel a selection, press the highlighted jobs again.

Only one file can be selected at a time.

4. Press [Delete].

A password screen appears.

5. Enter the password using the scroll keys, and then press [OK].

A confirmation screen appears.

A confirmation screen will appear if the password is not entered correctly. Press [Clear] to enter the
password again.

When multiple files are selected, the printer deletes only files that correspond to the entered password.
The number of files to be deleted is displayed on the confirmation screen.

6. Press [Delete].

After the file is deleted, the printer screen reappears.

• Press [Cancel] to cancel the delete request.

Using Hold Print

• You need Mac OS X v10.2 or higher to use this function.

• The number of pages the printer can save varies depending on the contents of the print images. At
most, the printer can save 100 jobs or 9,000 pages for Sample Print, Locked Print and Hold Print.

• Hold Print files will not appear on the display panel if they have already been printed or deleted using
Web Image Monitor before you select [Hold Print] using the control panel.

• Hold Print files printed or deleted using Web Image Monitor after you have selected [Hold Print] using
the control panel will still appear on the display panel. However, an error message will appear if you
try to print or delete those Hold Print files.

• If the application has a collate option, make sure that it is not selected before sending a print job. By
default, Hold print jobs are automatically collated by the printer driver. If the collate option is selected
in the application print dialog box, more prints than intended may be printed.

• Print jobs are not saved on the hard disk in the following cases. You can check the error log for jobs
not saved.

• When there are 100 Sample Print, Locked Print, Hold Print and Stored Print jobs saved on the
hard disk.
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• When the total number of pages saved on the hard disk exceeds 9,000 pages.

1. In the application, click [Print] on the [File] menu.

The [Print] dialog box appears.

2. In the pop-up menu, click [Job Log].

3. On the [Job Type:] pop-up menu, click [Hold Print].

4. In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters. File Name can also be set.

The user ID associates the user with his/her jobs.

5. After making the necessary settings, click [Print].

The document file is saved in the printer.

To print the document, perform the following steps.

To delete the document, see p.123 "Hold Print".

6. On the printer's control panel, press [Prt.Jobs].

A list of print files stored in the printer appears.

7. Select [Hold Print Jobs], and then press [Job List].

A list of hold print files stored in the printer appears.

User ID, Date/Time and File Name also appear.

8. Select the file you want to print by pressing it.

9. Press [Print].

The hold print file is printed.

• Press [Cancel] to cancel printing.

• To stop printing after printing has started, press [Job Reset]. The file will be deleted.

• When printing is completed, the stored file is deleted.

Deleting a Hold Print File

1. Press [Prt.Jobs].

A list of print files stored in the printer appears.

2. Select [Hold Print Jobs], and then press [Job List].

A list of hold print files stored in the printer appears.

Depending on the security settings, certain print jobs may not be displayed.

3. Select the file you want to delete by pressing it.

To cancel a selection, press the highlighted job again.

Only one file can be selected at a time.
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4. Press [Delete].

A confirmation screen appears.

5. Press [Delete].

After the file is deleted, the printer screen reappears.

• Press [Cancel] to cancel the delete request.

Using Stored Print

• You need Mac OS X v10.2 or higher to use this function.

• Stored Print files will not appear on the display panel if they have already been printed or deleted
using Web Image Monitor before you select [Stored Print] using the control panel.

• Stored Print files printed or deleted using Web Image Monitor after you have selected [Stored Print]
using the control panel will still appear on the display panel. However, an error message will appear
if you try to print or delete those Stored Print files.

• If the application has a collate option, make sure that it is not selected before sending a print job. By
default, Stored print jobs are automatically collated by the printer driver. If the collate option is selected
in the application print dialog box, more prints than intended may be printed.

• Print jobs are not saved on the hard disk in the following cases. You can check the error log for jobs
not saved.

• When there are 100 Sample Print, Locked Print, Hold Print and Stored Print jobs saved on the
hard disk.

• When the total number of pages saved on the hard disk exceeds 9,000 pages.

1. In the application, click [Print] on the [File] menu.

The [Print] dialog box appears.

2. In the pop-up menu, click [Job Log].

3. On the [Job Type:] pop-up menu, click [Stored Print] or [Stored and Print].

• [Stored Print]

Stores the file in the printer and print it later using the control panel.

• [Stored and Print]

Prints the file at once and also stores the file in the printer.

4. In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z, 0-9)
characters, and then enter a 4-8 digit password in the [Password:] box. File Name can also
be set.

The user ID associates the user with his/her jobs.
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You can assign a password to a saved document, but password assignment is not mandatory.

The password must be entered when printing or deleting.

5. After making the necessary settings, click [Print].

The document file is saved in the printer.

To print the document, perform the following steps.

To delete the document, see p.126 "Stored Print".

6. On the printer's control panel, press [Prt.Jobs].

A list of print files stored in the printer appears.

7. Select [Stored Print Jobs], and then press [Job List].

A list of Stored Print files stored in the printer appears.

User ID, Date/Time and File Name also appear.

Depending on the security settings, certain print jobs may not be displayed.

8. Select the file you want to print by pressing it.

9. Press [Print].

A confirmation screen appears.

If you have already set a password, proceed to the following step.

10. Enter the password using the scroll keys, and then press [OK].

A confirmation screen appears.

A confirmation screen will appear if the password is not entered correctly. Press [OK] to enter the
password again.

If you have not set the password, proceed to the following step.

11. Press [Print].

The Stored Print file is printed.

• Press [Cancel] to cancel printing.

• Stored Print files sent to the printer is not deleted unless you delete them in the printer, or enable
automatic deletion of Stored Print files.

Deleting a Stored Print File

1. Press [Prt.Jobs].

A list of print files stored in the printer appears.

2. Select [Stored Print Jobs], and then press [Job List].

A list of Stored Print files stored in the printer appears.

3. Select the file you want to delete by pressing it.
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4. Press [Delete].

A confirmation screen appears.

5. Enter the password using the scroll keys, and then press [OK].

A confirmation screen appears.

A confirmation screen will appear if the password is not entered correctly. Press [OK] to enter the
password again.

6. Press [Delete].

After the file is deleted, the printer screen reappears.

• Press [Cancel] to cancel the delete request.

• If you have already set a password in the printer driver, enter it to delete.

User Code

Use this to set a user code for print logging.

Enter a user code using up to eight digits. A user code identifies a group of users and allows you to check
the number of sheets printed under each code with SmartDeviceMonitor for Admin.

The following table shows the tabs or menus where you can select this function.

Mac OS Select the [Enable User Code] check box, and then
enter a user code in the [User Code:] box on [Job
Log] in the print dialog box.

Mac OS X Select the [Enable User Code] check box, and then
enter a user code in the [User Code:] box on [Job
Log] in the print dialog box.

Paper Size

Use this to select the size of paper you want to use.

The following table shows the tabs or menus where you can select this function.

Mac OS [Paper:] on the [Page Attributes] tab in the Page
Setup dialog box.

Mac OS X [Paper Size:] in the Page Setup dialog box.
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• For details about the paper sizes supported by this printer, see Hardware Guide.

Fit to Paper

When the size of the document and paper size differ, set whether or not to print according to paper size.

Mac OS [Fit to Paper] on [Printer Specific Options] in the
print dialog box.

Mac OS X [Fit to Paper] on the [Features x] tab on [Printer
Features] in the print dialog box.

Prompt User

Print is performed with the size of document to be printed unchanged.

Nearest Size and Scale

If the paper size is smaller than the selected paper size, the driver reduces the print size.

If the paper size is larger than the size of document to be printed, print is not to fit the paper size.

Nearest Size and Crop

When the paper size is smaller than the size of document to be printed, print is adjusted to meet the
paper size.

Input Slot

Use this to select the paper sources.

The following table shows the tabs or menus where you can select this function.

Mac OS [Paper Source:] on [General] in the print dialog
box.

Mac OS X [Paper Feed] in the print dialog box.

• For details about the paper sources, see Hardware Guide.

Resolution

Use this to set the resolution types.
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The following table shows the tabs or menus where you can select this function.

Mac OS [Resolution] on [Printer Specific Options] in the print
dialog box.

Mac OS X [Resolution] on the [Features x] tab on [Printer
Features] in the print dialog box.

• For more information about the resolution types, see Hardware Guide.

Orientation Override

Use this to set the paper orientation.

The following table shows the tabs or menus where you can select this function.

Mac OS [Orientation Override] on [Printer Specific
Options] in the print dialog box.

Mac OS X [Orientation Override] on the [Feature Sets: X] tab
on [Printer Features] in the print dialog box.

You can select the following items:

• Off

• Landscape

• Portrait

Duplex Printing

Use this function to select duplex printing.

The following table shows the tabs or menus where you can select this function.

Mac OS [Print on Both Sides] on [Layout] in the print dialog
box.

Mac OS X • 10.3 or higher

The [Two Sided Printing] check box on
[Layout] in the print dialog box.

• Other Mac OS X
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The [Print on both Sides] check box on
[Duplex] in the print dialog box.

None

Disables duplex printing.

Flip on Long Edge

Prints so you can open it to the long edge when bound along the long edge.

Flip on Short Edge

Prints so you can open it to the short edge when bound along the short edge.

Color Mode

Use this function to select whether the document is printed in color or black and white.

The following table shows the tabs or menus where you can select this function.

Mac OS [Color Mode] on [Printer Specific Options] in the
print dialog box.

Mac OS X [Color Mode] on the [Features x] tab on [Printer
Features] in the print dialog box.

Color

Prints color documents in full color.

• Color images are printed using CMYK toner: Cyan, Magenta, Yellow, and Black. CMYK
represents the three primary subtractive colors.

• If you want to adjust the print color, use the settings in the Advanced dialog box accessed from
the Advanced button on the [Print Quality] tab.

Black and White

Prints everything, including color documents, in black and white. Black and White printing is faster
than Color. To stop black and white areas being printed with CMYK toner, select [Black and White]
in the printer driver as well as in the application.

Gradation

Use this function to select a type of gradation suited to your requirements.

The following table shows the tabs or menus where you can select this function.
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Mac OS [Printer Specific Options] in the print dialog box.

Mac OS X [Gradation] on the [Features x] tab on [Printer
Features] in the print dialog box.

Fast

Prints quickly but loses smoothness.

Standard

Prints with good gradation.

Color Profile

Use this function to select the color profile pattern.

The following table shows the tabs or menus where you can select this function.

Mac OS [Color Profile] on [Printer Specific Options] in the
print dialog box.

Mac OS X [Color Profile] on the [Features x] tab on [Printer
Features] in the print dialog box.

Auto

Use this setting to automatically configure the best color profile pattern based on the appearance of
the document to be printed.

Photographic

Use this setting to enhance reproduction of photos and graphics that include midtones.

Presentation

Use this setting to enhance reproduction of documents containing text and graphics. This CRD is best
for printing colored charts, graphs, presentation materials and so on. If you use this CRD for printing
photographs, color and gradation might not reproduce so well.

Solid Color

Use this setting to print specific single colors, logos and so on.

User Setting

Use this setting to print images using a CRD downloaded from your application.

CLP Simulation

Prints the output colors similar to the colors displayed on the computer screen.
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• Use this function to select a color rendering dictionary (CRD). The CRD is referred to color matching,
so you should select the appropriate CRD for the document you are printing. The selected CRD is also
referred to when [Fine] or [Fine] is selected for "Colour Setting". The following items are available:
[Auto], [Photographic], [Presentation], and [Solid Color].

Color Setting

Use this function to select the correction method used for color conversion.

• The color rendering dictionary selected in the Color Profile setting is used.

The following table shows the tabs or menus where you can select this function.

Mac OS [Color Profile] on [Printer Specific Options] in the
print dialog box.

Mac OS X [Color Profile] on the [Features x] tab on [Printer
Features] in the print dialog box.

Off

No modification to the color setting.

Fine

Select this setting to perform color matching based on the printer's built-in color rendering dictionaries,
and to perform CMYK conversion. This setting performs printing at an output target of Monitor g =
1.8.

Super Fine

Select this setting to use a color rendering dictionary similar to the Fine setting but is capable of
producing output that is more vivid. Use this setting to emphasize lighter colors. This setting performs
printing at an output target of Monitor g = 2.2.

• Use this function to select a color rendering dictionary (CRD). The CRD is referred to color matching,
so you should select the appropriate CRD for the document you are printing. The selected CRD is also
referred to when [Fine] or [Super Fine] is selected for "Color Setting". The following items are available:
[Auto], [Photographic], [Presentation], and [Solid Color].

Toner Saving/Level Color

Use this function to reduce the amount of toner used when printing.
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The following table shows the tabs or menus where you can select this function.

Mac OS [Toner Saving] on [Printer Specific Options] in the
print dialog box.

Mac OS X [Toner Saving] on the [Features: Set x] tab on
[Printer Features] in the print dialog box.

• For details about this function, see printer driver Help.

Collate

Use this function to enable collation. With this feature, the printer can efficiently print collated sets of multiple-
page documents.

• Make sure that the following check boxes have not been selected.

• Mac OS

The [Collate] check box in the print dialog box.

• Mac OS X

• The [Collate] check box on [Copies & Pages] in the printer dialog box.

The following table shows the tabs or menus where you can select this function.

Mac OS [Collate] on [Printer Specific Options] in the print
dialog box.

Mac OS X [Collate] on the [Features: Set x] tab on [Printer
Feature] in the printer dialog box.

Paper Type

Use this to select the paper type.

The following table shows the tabs or menus where you can select this function.

Mac OS [Paper Type:] on [Printer Specific Options] in the
print dialog box.

Mac OS X [Paper Type] on the [Feature Set: x] tab on [Printer
Features] in the print dialog box.
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• For details about the media type supported by this printer, see Hardware Guide.

Black Over Print

Select whether or not to apply a black color over any other colors when printing.

The following table shows the tabs or menus where you can select this function.

Mac OS [Black Over Print] on [Printer Specific Options] in
the print dialog box.

Mac OS X [Black Over Print] on the [Features: Set x] tab on
[Printer Features] in the print dialog box.

Image Smoothing

Use this to select the image smoothing type.

The following table shows the tabs or menus where you can select this function.

Mac OS [Image Smoothing] on [Printer Specific Options] in
the print dialog box.

Mac OS X [Image Smoothing] on the [Feature Set: x] tab on
[Printer Features] in the print dialog box.

Off

Disables image smoothing.

On

Performs image smoothing unconditionally.

Auto

Performs image smoothing automatically for images that have a resolution less than 25% of supported
printer resolution.

Less than 90 ppi - Less than 300 ppi

Performs image smoothing only when the image has an image resolution (pixels per inch) less than
the respective value you have selected in the list.

• When Auto is selected, data processing may take a long time.
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• When [Image Smoothing:] is used for a mask image, this function may have an undesired effect on
the print result.

Separate into CMYK

Use this to select the print separation type.

You can separate the printing data into CMYK to specify a specific color combination.

Mac OS [Separate into CMYK] on [Printer Specific Options]
in the print dialog box.

Mac OS X [Separate into CMYK] on the [Features: Set x] tab
on [Printer Features] in the print dialog box.

CMYK Simulation Profile

You can simulate the color tone of the printing ink.

You can select the printing ink standard from US OffsetPrint, Euroscale, JapanColor and PaletteColor.

Mac OS [CMYK Simulation Profile] on [Printer Specific
Options] in the print dialog box.

Mac OS X [CMYK Simulation Profile] on the [Features: Set x]
tab on [Printer Features] in the print dialog box.

Dithering

Use this function to set the Image Rendering mode.

The following table shows the tabs or menus where you can select this function.

Mac OS Dithering: on Printer Specific Options in the print
dialog box.

Mac OS X Dithering: on the Feature Set: x tab on Printer
Features in the print dialog box.

You can select the following items:
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Auto

Use this setting to configure the best dithering method automatically depending on the appearance
of the document to be printed.

Photographic

Performs dithering using an appropriate pattern for photographs.

Text

Performs dithering using an appropriate pattern for text.

User Setting

Use this setting to print images set in half tone in your application.

Gray Reproduction

Use this function to select Black Color mode for text and line art.

The following table shows the tabs or menus where you can select this function.

Mac OS [Gray Reproductions (Text/LineArt)] on [Printer
Specific Options] in the print dialog box.

Mac OS X [Gray Reproductions (Text/LineArt)] on the
[Features: Set x] tab on [Printer Features] in the print
dialog box.

Black by K

Select this setting to use a black toner.

Black/Gray by K

Black portions are printed in gray.

CMY+K

Select this setting to use all toners.

Black/Gray by K (Text only)

Prints black text in gray.

Black by K (Text only)

Prints text using black toner.
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Color Matching

Use this function to select whether or not you want the colors in the documents to be adjusted before printing,
so that the printed page matches the colors on the screen closer.

Image Color Control

Open the [Image Color Matching] dialog box, and then click this button to specify exactly how you
want the colors on your screen adjusted before printing.
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Printer Utility for Mac
By using Printer Utility for Mac, you can download fonts, change the name of the printer and so on.

• If a Macintosh and printer are connected by USB, you cannot use Printer Utility for Mac.

• Printer Utility for Mac is included on the CD-ROM labeled "Printer Drivers and Utilities".

• Printer Utility for Mac requires Mac OS 7.6.1-9.x, or Mac OS X 10.1.x or 10.2.1. Mac OS X 10.0.x
and 10.2 are not supported.

Installing Printer Utility for Mac

Follow these steps to install Printer Utility for Mac on the printer.

1. Start the Macintosh.

2. Insert the CD-ROM into the CD-ROM drive.

The CD-ROM icon appears.

3. Double-click the CD-ROM icon.

The contents of the CD-ROM appear.

4. Double-click the [Mac OS 8 and 9] icon to open it.

Under Mac OS X, double-click the [Mac OS X] folder.

5. Double-click the [PS Utility] folder on the CD-ROM, and then drag the [Printer Utility for
Mac] file, and then drop it into the Macintosh hard disk.

6. Drag the CD-ROM icon and drop it into [Trash] to eject the CD-ROM.

Printer Utility for Mac is installed.

• Printer Utility for Mac is included on the CD-ROM labeled "Printer Drivers and Utilities".

• Printer Utility for Mac requires Mac OS 8.1 or higher. (Mac OS X Classic environment is
supported.)

• Printer Utility for Mac cannot use Mac OS X (native mode).
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Starting Printer Utility for Mac

Mac OS

• Before starting Printer Utility for Mac, make sure the printer is selected in [Chooser] on the Apple
menu.

1. Double-click the Printer Utility for Mac icon.

The [Printer Utility for Mac] dialog box appears.

2. Click [OK].

Printer Utility for Mac will take a few seconds to start.

Mac OS X

1. Double-click the Printer Utility for Mac icon.

The [Printer Utility for Mac] dialog box appears.

2. Click [OK].

3. In the [Available Printers:] box, select the printer you want to use.

If you change zones, select a name from [Available Network Zones:].

Click [Choose Printer...] on the Printer Utility for Mac menu if you want to change the printer.

4. Select the printer you want to use.

Printer Utility for Mac will take a few seconds to start.

5. Click [Choose].

Printer Utility for Mac Functions

Downloading PS Fonts

You can download the PS fonts to the printer memory or hard disk drive.

• The following procedure to download the fonts assume that you are a system administrator. If you
are not, be sure to consult your system administrator.

• During the download, do not turn off the power switch, operate the panel or open or close the cover.

• If the printer restarts, all the printer settings return to the defaults.
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• Confirm that a Macintosh and the printer are connected with Appletalk.

1. Select [Download PS Fonts...] on the [File] menu.

2. Click [Add to list].

The dialog box to select fonts appears.

3. Select the desired font files, and then click [Open].

The list of selectable font names appears.

4. After adding all the fonts you want to download, click [OK].

The dialog box of selected fonts to download appears.

5. Click [Download].

The fonts begin to download, and the download status is shown.

6. When the completion message appears, click [OK].

7. Click [Cancel].

• Some fonts cannot be downloaded.

• Before downloading, read the documentation about the fonts you want to use.

Displaying Printer Fonts

You can display the available fonts currently downloaded to the printer. Fonts in the printer memory and
hard disk drive can be displayed.

1. Select [Display Printer's Fonts...] on the [File] menu.

A dialog box appears.

2. Select [Printer's memory] or [Printer's disk].

3. Click [OK].

• The fonts displayed in italics are the default fonts.

Deleting Fonts

You can delete fonts from the printer's memory or hard disk drive.

• You cannot delete the fonts displayed in italic.

1. Select [Display Printer's fonts] on the [File] menu.

A dialog box appears.
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2. Select [Printer's memory] or [Printer's disk].

3. Select the fonts you want to delete.

4. Click [Delete].

A confirmation message appears.

5. Confirm the fonts you want to delete and the printer name from which you want to delete
the fonts.

6. Click [Continue], and then click [OK].

7. Click [OK].

Initializing the Printer Disk

When initializing the printer hard disk, all the fonts downloaded to the printer hard disk drive are deleted.
Before initializing, be sure to check the fonts on the hard disk drive.

• When initializing the printer hard disk drive from the control panel, all of the data on the printer hard
disk drive is deleted. Before initializing, be sure to check the data on the hard disk drive.

• Do not turn off the power switch until initializing is completed, otherwise the hard disk drive might be
damaged.

1. Select [Initialize Printer's Disk...] on the [File] menu.

The confirmation message appears. To cancel initialization, click [Cancel].

2. Click [Execute].

Initializing starts.

3. When the completion message appears, click [OK].

Page Setup

You can set the paper size on which to print "Print Fonts Catalogue" and "Prints Fonts Sample".

1. Select [Page Setup...] on the [File] menu.

2. Select the paper size.

3. Click [OK].

Printing Font Catalog

You can print the names of fonts available on the printer.

1. Select [Print Fonts Catalog...] on the [File] menu.
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2. Click [Print].

• The paper selected under [Page Setup] is used.

Printing Font Sample

You can print samples of fonts downloaded to the hard disk drive or memory.

1. Select [Print Fonts Sample...] on the [File] menu.

2. Click [Print].

• Print by using the paper selected on [Page Setup].

Renaming the Printer

You can change the printer name displayed under Appletalk. If you connect several printers on the network,
assign different names so you can identify them. If several printers have the same name, a digit appears
next to the printer name in [Chooser].

• You can enter up to 31 digits and letters.

• Do not use symbols, for example "*", ":", "=", "@", "~".

Mac OS

1. On the [File] menu, click [Rename Printer...].

2. In the [New Name:] filed enter a new name.

3. Click [Rename].

The printer name is changed.

4. Click [OK].

5. On the Apple menu, click [Chooser].

6. Click the [AdobePS] icon.

7. Select the printer whose name you changed, and then close the [Chooser] dialog box.

If there are several AppleTalk zones, select the zone the printer belongs to.

Mac OS X

1. On the [File] menu, click [Rename Printer...].

2. In the [New Name:] filed enter a new name.
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3. Click [Rename].

The printer name is changed.

4. Click [OK].

5. On the [Printer Utility for Mac] menu, click [Choose Printer...].

6. In the [Available Network Zones:] list, select the zone for the Macintosh in use.

7. In the [Available Printers:] list, select the printer whose name you changed, and then click
[Choose].

Restarting the Printer

You can restart the printer.

1. Select [Restart Printer] on the [File] menu.

2. Confirm the message that appears on the screen, and then click [Restart].

The printer restarts.

The fonts downloaded in the printer memory will be deleted.

If the printer restarts, all the printer settings return to the defaults.

Downloading PostScript Files

You can download a Postscript file to the printer.

1. Select [Download PostScript File...] on the [Utility] menu.

2. Select the file name to download, click the file name, and then click [Open].

3. Type the log file name, and then click [Save].

The selected file is downloaded.

Errors are recorded in the log file.

Selecting the Zone

You can change the zone to which the printer belongs under Appletalk.

• Confirm that a Macintosh and printer are connected with Appletalk.

Mac OS

1. On the [Utility] menu, click [Select Zone...].

The zone to which the printer belongs and the available zone list appear.
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2. Select the zone in which you want to locate the printer, and then click [Change].

A confirmation message appears.

3. Click [Continue].

A confirmation message appears.

4. Click [OK].

5. On the Apple menu, click [Chooser].

6. Click the [AdobePS] icon.

7. In the [AppleTalk zone:] list, select the zone you changed.

8. In the [Select a PostScript Printer:] list, select the printer you want to use.

9. Close the [Chooser] dialog box.

Mac OS X

1. On the [Utility] menu, click [Select Zone...].

The zone to which the printer belongs and the available zone list appear.

2. Select the zone which you want to locate the printer in, and then click [Change].

A confirmation message appears.

3. Click [Continue].

A confirmation message appears.

4. Click [OK].

5. On the [Printer Utility for Mac] menu, click [Choose Printer...].

6. In the [Available Network Zones:] list, select the zone you changed.

7. In the [Available Printers:] list, select the model of printer in use, and then click [Choose].

Displaying the Printer Status

You can display and confirm the current status of the printer.

1. Select [Display Printer Status...] on the [Utility] menu.

The current status of the printer appears.

2. Confirm the current status of the printer.

You can confirm the memory capacity, the VM (Virtual Memory) space, the hard disk drive status and
available space on the hard disk drive. You can also confirm the zone to which the printer belongs.

3. Click [OK].
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Launching the Dialogue Console

You can create and edit a PostScript file for printing, and then download it to the printer.

• "Launch Dialogue Console" is recommended for users with an understanding of PostScript.

• Do not download any file other than PostScript files to the printer.

• "Launch Dialogue Console" must be used at your own responsibility.

1. Select [Launch Dialogue Console...] on the [Utility] menu.

Open the editing screen. The Dialogue Console menu bar appears.

2. Type the PostScript command in the editor screen.

To edit a PostScript file, select [Open] on the [File] menu to open it.

You can search or replace a character string by using the [Search] menu.

3. After editing the PostScript file, select [Download Top Window] on [Console] menu to start
printing.

The PostScript file is sent to the printer.

The [Reply from Printer] box opens, depending on the PostScript file you sent.

4. Select [Return To Main Menu] on the [Console] menu to close the PostScript file.
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10. Security Measures Provided by this
Printer

Using Authentication and Managing Users
This section explains how to improve this printer's security.

The setting can be done only by the administrator.

Enabling Authentication

To control administrators' and users' access to the printer, perform administrator authentication and
user authentication using login user names and login passwords. To perform authentication, the
authentication function must be enabled.

Specifying Authentication Information to Log on

Users are managed using the personal information managed in the printer's address book.

Enabling user authentication limits usage of printer to people registered in the address book to use
the printer. Users can be managed in the address book by the user administrator.

Specifying Which Functions are Available

This can be specified by the user administrator. Specify the functions available to registered users. By
making this setting, administrators can limit the functions available to users.
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Preventing Information Leaks
Guarding Against Unauthorized Copying (Unauthorized Copy Prevention)

Using the printer driver, mask and pattern can be embedded in the printed document.

Guarding Against Unauthorized Copying (Data security for copying)

Using the printer driver with the data security for the copying function, a document can be printed
with an embedded pattern of hidden text.

To gray out the copy or stored file of a copy-guarded document when the document is copied or
stored , the optional security module is required.

Printing confidential files

Using the printer's Locked Print, files can be stored in the printer as confidential files and then print
them. Those file can be printed using the printer's control panel and collected on the spot to prevent
others from seeing it.

Preventing Data Leaks Due to Unauthorized Transmission

You can specify in the address book which users are allowed to send files using the scanner or fax
function.

You can also limit the direct entry of destinations to prevent files from being sent to destinations not
registered in the address book.

Protecting Registered Information in the Address Book

This function allows administrator to specify which users have permission to access the data in the
address book. Usage of the data in the address book by unregistered users can be prevented.

Administrator can also encrypt the data in the address book to protect the data from unauthorized
reading.

Managing Log Files

Data security can by improved by deleting log files stored in the printer. By transferring the log files,
administrator can check the history data and identify unauthorized access.

To transfer the log data, the log collection server is required.

Overwriting the Data on the Hard Disk

Before disposing of the printer, make sure all data on the hard disk is deleted. Prevent data leakage
by automatically deleting transmitted printer jobs from memory.

To overwrite the hard disk data, the optional ipp unit is required.
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Limiting and Controlling Access
Preventing Modification or Deletion of Stored Data

Users with access permission to stored files can be specified. Permit selected users who have to access
permissions to stored files to modify or delete the files.

Preventing Modification of Printer Settings

The printer settings that can be modified depend on the type of administrator account.

Register the administrators so that users cannot change the administrator settings.

Limiting Available Functions

This function allows administrator to specify which users have accessibility to each of the printer's
functions, to prevent unauthorized operation.

Limiting and Controlling Access
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Enhanced Network Security
Preventing Unauthorized Access

Limit IP addresses or disable ports to prevent unauthorized access over the network and protect the
address book, stored files, and default settings.

Encrypting Transmitted Passwords

Prevent login passwords, group passwords for PDF files, and IPP authentication passwords being
revealed by encrypting them for transmission.

Also, encrypt the login password for administrator authentication and user authentication.
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Configuring SSL Encryption
When you access the printer using a Web Image Monitor or IPP, you can establish encrypted
communication using SSL.

When you access the printer using an application such as SmartDeviceMonitor for Admin, you can establish
encrypted communication using SNMPv3 or SSL. To protect data from interception, analysis, and
tampering, you can install a server certificate in the printer, negotiate a secure connection, and encrypt
transmitted data.

SSL (SSL (Secure Sockets Layer)Secure Sockets Layer)

AQC899S

1. To access the printer from a user’s computer, request for the SSL server certificate and public key.

2. The server certificate and public key are sent from the printer to the user’s computer.

3. Create shared key from the user's computer, and then encrypt it using public key.

4. The encrypted shared key is sent to the printer.

5. The encrypted shared key is decrypted in the machine using private key.

Configuring SSL Encryption
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6. Transmit the encrypted data using the shared key, and then decrypt the data at the machine to
attain secure transmission.

10. Security Measures Provided by this Printer

366

10



11. Appendix

Software and Utilities Included on the CD-ROM
The following softwares and utilities are included in the CD-ROMs that come with the printer.

Font Manager 2000

For installing new screen fonts, or organizing and managing fonts already in the system. For details
about Font Manager 2000, see the manual on the CD-ROM labeled "Printer Drivers and Utilities".

SmartDeviceMonitor for Admin

For the system administrator to manage network printers.

• SmartDeviceMonitor for Admin Help.

DeskTopBinder - SmartDeviceMonitor for Client

For users to manage their network print status.

• DeskTopBinder - SmartDeviceMonitor for Client Help.

Viewing the contents of the CD-ROM

1. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

2. Click [Browse This CD-ROM].

Explorer starts and displays the contents of the CD-ROM.

Printer Drivers for This Printer

Printing requires installing a printer driver appropriate to your operating system. The following drivers are
included on the CD-ROM provided with this printer.

PCL 5c/6 printer driver

This printer driver allows the computer to communicate with the printer via a printer language.

The following operating system is supported.

• Windows 95/98/Me, Windows 2000/XP/Vista, and Windows Server 2003/2003 R2

• For Windows NT 4.0, Service Pack 6 or higher is required.
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RPCS printer driver

This printer driver allows the computer to communicate with the printer using a printer language. In
addition to the conventional user interface, another preset user interface is provided.

The following operating system is supported.

• Windows 95/98/Me, Windows 2000/XP/Vista, and Windows Server 2003/2003 R2

PostScript Printer Drivers and PPD files

PostScript printer drivers and the PPD files are included on the CD-ROM provided with this printer.
PostScript printer drivers allow the computer to communicate with the printer using a printer language.
PPD files allow the printer driver to enable specific printer functions.

The following operating system is supported.

• Windows 95/98/Me, Windows 2000/XP/Vista, Windows Server 2003/2003 R2, Mac
OS, and Mac OS X.

• The PostScript printer drivers and PPD files are included on the CD-ROM labeled "Printer Drivers
and Utilities".

• For Mac OS, version 8.6 or higher is required. (Mac OS X Classic environment is supported.)

PPD files

PPD files are included on the CD-ROM provided with this printer. PPD files allow the printer driver to
enable specific printer functions.

SmartDeviceMonitor for Admin

SmartDeviceMonitor for Admin is an application that uses TCP/IP and IPX/SPX to monitor network printers.
It can monitor multiple network printers using IP address. We recommend that administrators use this
application.

File path

SmartDeviceMonitor for Admin is stored in the following folder on the CD-ROM.

NETWORK\DEVMON\ADMIN\DISK1

Operating system Protocol stack

Windows 95/98/Me TCP/IP provided with Windows 95/98/Me

IPX/SPX provided with Windows 95/98/Me

NetWare Client provided with Windows
95/98

Novell Client provided with Windows 95/98
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Operating system Protocol stack

Windows 2000 TCP/IP provided with Windows 2000

IPX/SPX provided with Windows 2000

NetWare Client provided with Windows 2000

Novell Client provided with Windows 2000 or
Window NT

Windows XP TCP/IP provided with Windows XP

IPX/SPX provided with Windows XP

NetWare Client provided with Windows XP

Novell Client provided with Windows XP

Windows Vista TCP/IP provided with Windows Vista

Novell Client provided with Windows Vista

Windows Server 2003 TCP/IP provided with Windows Server 2003

IPX/SPX provided with Windows Server 2003

NetWare Client provided with Windows Server
2003

Novell Client provided with Windows Server
2003

Windows NT 4.0 TCP/IP provided with Windows NT

IPX/SPX provided with Windows NT

Client Service for NetWare provided with
Windows NT

Novell Client provided with Windows 2000 or
Windows NT

Available functions

SmartDeviceMonitor for Admin has the following functions to check:

• printer supplies such as paper or toner;

• results of print jobs executed from the computer.

• For information about using SmartDeviceMonitor for Admin, see SmartDeviceMonitor for
Admin Help.
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DeskTopBinder - SmartDeviceMonitor for Client

SmartDeviceMonitor for Client has the following functions. We recommend that users install this application.

• Printing in a peer-to-peer network, using TCP/IP, and IPP from Windows 95/98/Me/2000/XP,
Windows Server 2003, and Windows NT 4.0.

• Constantly monitoring the status of devices on the network using TCP/IP and IPX/SPX.

File path

SmartDeviceMonitor for Client is stored in the following folder on the CD-ROM.

NETWORK\DEVMON\CLIENT\DISK1

Operating system Protocol stack

Windows 95/98/Me TCP/IP provided with Windows 95/98/Me

IPX/SPX provided with Windows 95/98/Me

NetWare Client provided with Windows
95/98/Me

Novell Client provided with Windows 95/98/
Me

Windows 2000 TCP/IP provided with Windows 2000

IPX/SPX provided with Windows 2000

NetWare Client provided with Windows 2000

Novell Client provided with Windows 2000 or
NT

Windows XP TCP/IP provided with Windows XP

IPX/SPX provided with Windows XP

NetWare Client provided with Windows XP

Novell Client provided with Windows XP

Windows Vista TCP/IP provided with Windows Vista

Novell Client provided with Windows Vista

Windows Server 2003 TCP/IP provided with Windows Server 2003

IPX/SPX provided with Windows Server 2003

NetWare Client provided with Windows Server
2003

Novell Client provided with Windows Server
2003
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Operating system Protocol stack

Windows NT 4.0 TCP/IP provided with Windows NT

IPX/SPX provided with Windows NT

Client Service for NetWare provided with
Windows NT

Novell Client provided with Windows 2000 or
Windows NT

Available functions

SmartDeviceMonitor for Client has the following functions.

• Peer-to-peer print function

• Prints directly on the network printer without sending any data to a print server.

• Prints on a substitute printer when there are too many jobs waiting on the specified printer,
or when an error disables printing (Recovery Printing).

• Allocates multiple print jobs to multiple printers (Parallel Printing).

• Executes prior group registration of printers specified for Recovery Printing or Parallel
Printing.

• Notification function

• Displays an error message when there is an error on the specified printer while transferring
or printing data.

• Notifies a print completion. You can also be notified of the print condition, such as displaying
the notice only when Recovery Printing is executed.

• Monitoring function

• Checks printer supplies such as paper or toner.

• Simultaneously monitors multiple printers in use.

• Checks the printer's network settings and detailed information of printers.

• Enables you to check the print job log using the user ID.

• To perform Recovery or Parallel printing, the same options that are installed on the original printer
must be installed on the other printers also. Printers that lack a required option cannot be used for
Recovery or Parallel printing.

• To perform Recovery or Parallel printing, the same paper loaded in the original printer must be loaded
in the other printers also. Load all printers with the same paper as that loaded in the tray selected for
printing.
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• Results of Recovery or Parallel Printing might differ, depending on the model of the other printer and
the options installed on it.

• If you select Sample Print or Locked Print, you cannot select Recovery Printing or Parallel Printing.

• For details about using SmartDeviceMonitor for Client, see SmartDeviceMonitor for Client Help.
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Cautions to Take When Using in a network

Connecting a Dial-up Router to a Network

When the NetWare file server and printer are on opposite sides of a router, packets are sent back and
forth, causing communication charges to be incurred. Because packet transmission is a specification of
NetWare, you need to change the configuration of the router. If the network you are using does not allow
you to configure the router, configure the printer instead.

Configuring the router

Filter packets so that they do not pass over the dial-up router.

• The MAC address of the printer doing the filtering is printed on the printer configuration page. For
details about printing a configuration page, see p.184 "List/Test Print Menu" .

• For details about configuring the printer if the router cannot be configured, see the instructions below.

Configuring the printer with NetWare

1. Following the setup method described earlier in this manual, configure the file server.

2. Set the frame type for NetWare environment.

• For details about selecting a frame type, see p.206 "Host Interface Menu".

Configuring the printer without NetWare

When not printing, the network interface board sends packets over the network. Set NetWare to "inactive".

• For details about selecting protocols, see p.206 "Host Interface Menu".

Using DHCP

You can use the printer in a DHCP environment. You can also register the printer NetBIOS name on a
WINS server when it is running. Note the following points when an Ethernet interface is simultaneously
installed.

Cautions to Take When Using in a network
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When static IPv4 addresses are set for each interface

• IPv4 address: When set at the same value, the Ethernet interface is preferred.

• Subnet mask: When a value overlaps, the Ethernet interface is preferred.

• Gateway address: The value set is used. For the gateway address, set the gateway address
located in the subnetwork set by the interface. If the value is outside the subnet range set by the
interface, it operates as "0.0.0.0".

When obtaining addresses from the DHCP server

• IP Address, Subnet Mask: you can configure addresses assigned by a DHCP server. If IPv4
addresses overlap or the same subnet IP addresses are selected, the effective value is assigned
only to the prioritized interface. Ethernet has default interface priority.

• AutoNet: A temporary IPv4 address starting with 169.254 and not used on the network, is
assigned to the prioritized interface.

• Gateway Address, DNS Server Address, and Domain Name: You can configure the addresses
assigned by DHCP to the prioritized interface.

If the gateway address is beyond the range of the subnet selected for the interface, the printer
operates using "0.0.0.0".

Ethernet has default interface priority.

When there are static IPv4 addresses and addresses assigned by DHCP

• IPv4 Address and subnet mask: if a static IPv4 address is the same as an address assigned by
DHCP, or the static subnet mask address and the subnet mask address assigned by DHCP
overlap, the printer uses the static IPv4 address interface. The interface with the DHCP setting is
set by default.

• Gateway Address: operates using the address entered manually.

If a static address is not selected, or is set to 0.0.0.0, the interface using the address assigned
by DHCP is used.

• NetBIOS name on a WINS server must be configured for the WINS server.

• Supported DHCP servers are: Windows 2000 Server, Windows Server 2003, and
Windows NT 4.0, and the DHCP server included with NetWare and UNIX.

• If you do not use the WINS server, reserve the printer's IP address in the DHCP server so
the same IPv4 address is assigned every time.

• To use the WINS server, change the WINS server setting to "active" using the control panel.

• Using the WINS server, you can configure the host name via the remote network printer
port.

• DHCP relay-agent is not supported. If you use DHCP relay-agent on a network via ISDN,
it will result in increased line charges. This is because your computer connects to the ISDN
line whenever a packet is transferred from the printer.If there is more than one DHCP server,

11. Appendix

374

11



use the same setting for all servers. The printer operates using data from the DHCP server
that responds first.

Using AutoNet

If the printer IPv4 address is not assigned by a DHCP server automatically, a temporary IPv4 address
starting with 169.254, which is not used on the network, can be automatically selected by the printer.

You must change this setting to "on" to use AutoNet.

• The IP address assigned by the DHCP server is given priority over that selected by AutoNet.

• You can confirm the current IPv4 address on the configuration page.

• When AutoNet is running, the NetBIOS name is not registered on the WINS server.

• The printer cannot communicate with devices that do not have the AutoNet function. However, this
printer can communicate with Macintosh computers running Mac OS X 10.2.3. or higher.

• For more information about the configuration page, see p.184 "List/Test Print Menu" .

• See p.240 "Remote Maintenance by telnet" .

Configuring the WINS Server

The printer can be configured to register its NetBIOS name with a WINS server when the power is turned
on. This enables the NetBIOS name of the printer to be specified from SmartDeviceMonitor for Admin even
in a DHCP environment. This section explains configuring the WINS server.

• The WINS server is supported with Windows NT 4.0 Server Service Pack 4 or higher, and Windows
2000 Servers WINS Manager.

• For details about the WINS server settings, see Windows Help.

• If there is no reply from the WINS server, the NetBIOS name is registered by broadcast.

• The NetBIOS name can be entered using up to 13 alphanumeric characters.

Using Web Image Monitor

1. Start a Web browser.

2. Enter "http://(printer's address)/" in the address bar to access the printer whose settings
you want to change.

Top Page of Web Image Monitor appears.
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3. Click [Login].

The dialog box for entering the user name and password appears.

4. Enter the user name and password, and then click [Login].

Contact your administrator for information about the settings.

5. In the left area, click [Configuration], and then click [Network].

6. Click [TCP/IP].

7. Check that [Enable] is selected for [WINS] in the [Ethernet+IEEE 802.11b] column, and then
enter the WINS server IPv4 address in [Primary WINS Server] and [Secondary WINS
Server].

8. Click [Apply].

9. Quit Web Image Monitor.

Using telnet

See p.240 "Remote Maintenance by telnet" .

Using the Dynamic DNS Function

Dynamic DNS is a function which dynamically updates (registers and deletes) records (A record and PTR
record) managed by the DNS server. When a DNS server is part of the network environment to which this
printer, a DNS client, is connected, records can be dynamically updated using this function.

Updating

Updating procedure varies depending on whether the printer IP address is static or acquired by DHCP.

• When the dynamic DNS function is not used, records managed by the DNS server must be updated
manually, if the printer's IP address is changed.

• To update the record using the printer, the DNS server has to have one of the following:

• No security settings made.

• If security settings are made, an IP-specified client (this printer) permits updating.

For a static IP setting

If the IP address or host name is changed, the A and PTR records are updated.

If the A record is registered, CNAME is also registered. CNAMEs that can be registered are as follows:

• Ethernet and IEEE 802.11b

RNPXXXXXX (XXXXXX represents the last 3 hexadecimal bytes of the MAC address)
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For DHCP settings

As a substitute for the printer, the DHCP server updates the record, and one of the following occurs:

• When the printer acquires the IP address from the DHCP server, the DHCP server updates the A
and PTR records.

• When the printer acquires the IP address from the DHCP server, the printer updates the A record,
and the DHCP server updates the PTR record.

If the A record is registered, CNAME is also registered. CNAMEs that can be registered are as follows:

• Ethernet and IEEE 802.11b

RNPXXXXXX (XXXXXX represents the last 3 hexadecimal bytes of the MAC address)

• Dynamic update using message authentication (TSIG, SIG(0)) is not supported.

DNS servers targeted for operation

For static IP setting

• Microsoft DNS servers with standard Windows 2000 Server/Windows Server 2003 features

• BIND 8.2.3 or higher

For DHCP setup, when the printer updates the A record

• Microsoft DNS servers with standard Windows 2000 Server/Windows Server 2003 features

• BIND 8.2.3 or higher

For DHCP setup, when the DHCP server updates records

• Microsoft DNS servers with standard Windows 2000 Server/Windows Server 2003 features

• BIND 8.2.3 or higher

• DNS servers with standard NetWare 5 (or a higher version) features

DHCP servers targeted for operation

As a substitute for the printer, DHCP servers capable of updating the A record and PTR record are as
follows:

• Microsoft DHCP servers with standard Windows 2000 Server (Service Pack 3 or higher versions)/
Windows Server 2003 features

• ISC DHCP 3.0 or higher

• DHCP server with standard NetWare 5 features
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Setting the dynamic DNS function

Make settings with telnet using the "dns" command. For details, see p.240 "Remote Maintenance by
telnet" .
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Installing Font Manager 2000

• Under Windows 2000/XP, Windows Server 2003/2003 R2, or Windows NT 4.0, installing
applications by Auto Run requires administrator permission. To install a printer driver by Auto Run,
log on using an account that has administrator permission.

1. Quit all applications currently running.

2. Insert the CD-ROM into the CD-ROM drive.

The installer starts.

3. Click [Font Manager 2000].

4. Follow the instructions on the screen.

Installing Font Manager 2000
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Using Adobe PageMaker Version 6.0, 6.5, or
7.0
Under Windows 95/98/Me/2000/XP, Windows Server 2003/2003 R2, or Windows NT 4.0 with
Adobe PageMaker, you need to copy PPD files to the PageMaker folder.

PPD files have the .ppd extension in the folder "DRIVERS\PS\WIN9X_ME \(Language)\DISK1\" on the
CD-ROM.

The "WIN9X_ME" folder inside the "PS" folder is for Windows 95/98/Me. Use the folder at this level that
is appropriate for the operating system you are currently using.

The third folder "(Language)" may be substituted by an appropriate language name.

Copy the .ppd file to the PageMaker folder.

• For PageMaker 6.0 default installation

The directory is "C:\PM6\RSRC\PPD4".

• For PageMaker 6.5 default installation

The directory is "C:\PM65\RSRC\USENGLISH\PPD4".

The "USENGLISH" may vary depending on your language selection.

• For PageMaker 7.0 default installation

The directory is "C:\PM7\RSRC\USENGLISH\PPD4";.

The "USENGLISH" may vary depending on your language selection.

• If the driver is not set correctly after copying the ".ppd" file, printing may not be performed properly.

• When using PageMaker, the optional features that can be selected by the printer driver will not be
active. The following procedure describes how to activate the optional printer features.

1. On the [File] menu, click [Print].

The [Print Document] dialog box appears.

2. Make the necessary settings in the [Features] box.
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When Using Windows Terminal Service/
MetaFrame
The following explains how to use Windows Terminal Service and Maintenance.

Operating Environment

The following operating systems and MetaFrame versions are supported.

Windows NT Server 4.0 Terminal Server Edition with SP6 or higher

• MetaFrame 1.8 SP3/FR1+SP3/SP4

• MetaFrame XP 1.0 SP1/SP2/FR1

Windows 2000 Server/Advanced Server

• MetaFrame 1.8 SP3/FR1+SP3/SP4

• MetaFrame XP 1.0 SP1/SP2/SP3/SP4/FR1/FR2/FR3

• MetaFrame Presentation Server 3.0

• Citrix Presentation Server 4.0

Windows Server 2003

• MetaFrame XP 1.0 FR3

• MetaFrame Presentation Server 3.0

• Citrix Presentation Server 4.0

Supported Printer Drivers

When Windows Terminal Service is operating

• PCL printer drivers

• PostScript 3

• RPCS drivers

• Some RPCS printer driver functions do not work if Windows Terminal Service is installed.

Limitations

The following limitations apply to the Windows Terminal Service environment.

These limitations are built in Windows Terminal Service or MetaFrame.
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Windows Terminal Service

In an environment where Windows Terminal Service is installed, some printer driver functions are
unavailable, even if no Windows Terminal Service functions are used. Use the install mode to install
SmartDeviceMonitor for Client in an environment where Terminal Service is running on a Windows
NT Server 4.0 Terminal Server Edition or Windows 2000 Server family computer. The following are
the two methods of installation using the install mode:

1. Use [Add/Remove Programs] in [Control Panel] to install SmartDeviceMonitor for Client.

2. Enter the following command in the MS-DOS command prompt:

CHANGE USER /INSTALL

To quit the install mode, enter the following command in the MS-DOS command prompt:

CHANGE USER /EXECUTE

• For more information, see Windows Help.

MetaFrame's [Auto-creating client printers]

Using [Auto-creating client printers], you can select a logical printer created by copying the client's
local printer data to the MetaFrame server. We strongly recommend testing this function in your
network environment before using it for your work.

• The settings for optional equipment will not be stored in the server after the equipment is
disconnected. The settings for optional equipment will be restored to its defaults each time the
client computer logs on to the server.

• When printing a large number of bitmap images or using the server in a WAN environment over
dial-up lines such as ISDN, printing may not be possible or errors may occur, depending on
data transfer rates.

• When using MetaFrame XP 1.0 or higher versions, we recommend making settings in [Client
Printer bandwidth] under [Citrix Management Console] according to the environment.

• If a print error occurs on the server and the print job or a printer created in [Auto-creating client
printers] cannot be deleted, we recommend the following:

• MetaFrame 1.8 SP3, MetaFrame XP 1.0 SP1/FR1

Make settings in [Delete unfinished print jobs] in the registry. For details, see the Readme
file provided with MetaFrame.

• MetaFrame XP 1.0 FR2

Make settings in [Delete pending print jobs at logout] under [Printer Properties
Management] of Citrix Management Console.

MetaFrame's [Printer driver replication]

Using [Printer driver replication], you can distribute printer drivers across all servers in a server farm.
We strongly recommend testing this function in your network environment before using it for your
work.
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• If the printer drivers are not properly copied, install them directly onto each server.
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Cautions When Using Bluetooth Interface Unit
The optional Bluetooth interface unit operation mode is set to [Public] as default.

If the setting is changed to [Private], only registered computers can use this printer via the Bluetooth interface
unit.

Check the operation mode settings using Web Image Monitor or telnet.

• For details about using Web Image Monitor, see p.213 "Using Web Image Monitor". For details
about setting items, see Web Image Monitor Help.

• For details about making operation mode settings using telnet, see p.240 "Remote Maintenance by
telnet".
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Copyrights

expat

• The software including controller, etc. (hereinafter "software") installed on this product uses the expat
under the conditions mentioned below.

• The product manufacturer provides warranty and support to the software of the product including the
expat, and the product manufacturer makes the initial developer and copyright holder of the expat,
free from these obligations.

• Information relating to the expat is available at:

http://expat.sourceforge.net/

Copyright (c) 1998, 1999, 2000 Thai Open Source Software Centre, Ltd. and Clark Cooper.

Copyright (c) 2001, 2002 Expat maintainers.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the Software without restriction, including without limitation
the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software,
and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions
of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN
AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

NetBSD

1. Copyright Notice of NetBSD

For all users to use this product:

This product contains NetBSD operating system:

For the most part, the software constituting the NetBSD operating system is not in the public domain; its
authors retain their copyright.

The following text shows the copyright notice used for many of the NetBSD source code. For exact copyright
notice applicable for each of the files/binaries, the source code tree must be consulted.

A full source code can be found at http://www.netbsd.org/.
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Copyright (c) 1999, 2000 The NetBSD Foundation, Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgment:

This product includes software developed by The NetBSD Foundation, Inc. and its contributors.

4. Neither the name of The NetBSD Foundation nor the names of its contributors may be used to endorse
or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE NETBSD FOUNDATION, INC. AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.
IN NO EVENT SHALL THE FOUNDATION OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.

2. Authors Name List

All product names mentioned herein are trademarks or registered trade-marks of their respective owners.

The following notices are required to satisfy the license terms of the software that we have mentioned in
this document:

• This product includes software developed by the University of California, Berkeley and its contributors.

• This product includes software developed by the NetBSD Foundation.

• This product includes software developed by The NetBSD Foundation, Inc. and its contributors.

• This product includes software developed for the NetBSD Project. See http://www.netbsd.org/ for
information about NetBSD.

• This product contains software developed by Ignatios Souvatzis for the NetBSD project.

• This product contains software written by Ignatios Souvatzis and MichaelL. Hitch for the NetBSD
project.

• This product contains software written by Michael L. Hitch for the NetBSD project.

• This product includes cryptographic software written by Eric Young(eay@cryptsoft.com)

• This product includes cryptographic software written by Eric Young(eay@mincom.oz.au)
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• This product includes software designed by William Allen Simpson.

• This product includes software developed at Ludd, University of Lulea, Sweden and its contributors.

• This product includes software developed at Ludd, University of Lulea.

• This product includes software developed at the Information Technology Division, US Naval Research
Laboratory.

• This product includes software developed by Berkeley Software Design, Inc.

• This product includes software developed by David Jones and Gordon Ross

• This product includes software developed by Gordon W. Ross and Leo Weppelman.

• This product includes software developed by Hellmuth Michaelis and Joerg Wunsch

• This product includes software developed by Internet Research Institute, Inc.

• This product includes software developed by Leo Weppelman and Waldi Ravens.

• This product includes software developed by Mika Kortelainen

• This product includes software developed by Aaron Brown and Harvard University.

• This product includes software developed by Adam Ciarcinski for the NetBSD project.

• This product includes software developed by Adam Glass and Charles M.Hannum.

• This product includes software developed by Adam Glass.

• This product includes software developed by Advanced Risc Machines Ltd.

• This product includes software developed by Alex Zepeda, and Colin Wood for the NetBSD Projet.

• This product includes software developed by Alex Zepeda.

• This product includes software developed by Alistair G. Crooks.

• This product includes software developed by Alistair G. Crooks. for the NetBSD project.

• This product includes software developed by Allen Briggs

• This product includes software developed by Amancio Hasty and Roger Hardiman

• This product includes software developed by Berkeley Software Design, Inc.

• This product includes software developed by Berkeley Software Design, Inc.

• This product includes software developed by Bill Paul.

• This product includes software developed by Bodo Moeller. (If available, substitute umlauted o for
oe)

• This product includes software developed by Boris Popov.

• This product includes software developed by Brad Pepers

• This product includes software developed by Bradley A. Grantham.

• This product includes software developed by Brini.

• This product includes software developed by Causality Limited.

• This product includes software developed by Charles D. Cranor and Seth Widoff.
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• This product includes software developed by Charles D. Cranor and Washington University.

• This product includes software developed by Charles D. Cranor, Washington

• University, and the University of California, Berkeley and its contributors.

• This product includes software developed by Charles D. Cranor, Washington University, the University
of California, Berkeley and its contributors.

• This product includes software developed by Charles D. Cranor.

• This product includes software developed by Charles Hannum.

• This product includes software developed by Charles M. Hannum, by the University of Vermont and
State Agricultural College and Garrett A.Wollman, by William F. Jolitz, and by the University of
California, Berkeley, Lawrence Berkeley Laboratory, and its contributors.

• This product includes software developed by Charles M. Hannum.

• This product includes software developed by Christian E. Hopps, Ezra Story, Kari Mettinen, Markus
Wild, Lutz Vieweg and Michael Teske.

• This product includes software developed by Christian E. Hopps.

• This product includes software developed by Christian Limpach

• This product includes software developed by Christopher G. Demetriou for the NetBSD Project.

• This product includes software developed by Christopher G. Demetriou.

• This product includes software developed by Christos Zoulas.

• This product includes software developed by Chuck Silvers.

• This product includes software developed by Colin Wood for the NetBSD Project.

• This product includes software developed by Colin Wood.

• This product includes software developed by Cybernet Corporation and Nan Yang Computer
Services Limited

• This product includes software developed by Daishi Kato

• This product includes software developed by Dale Rahn.

• This product includes software developed by Daniel Widenfalk and Michael L. Hitch.

• This product includes software developed by Daniel Widenfalk for the NetBSD Project.

• This product includes software developed by Darrin B. Jewell

• This product includes software developed by David Miller.

• This product includes software developed by Dean Huxley.

• This product includes software developed by Eduardo Horvath.

• This product includes software developed by Eric S. Hvozda.

• This product includes software developed by Eric S. Raymond

• This product includes software developed by Eric Young (eay@@mincom.oz.au)

11. Appendix

388

11



• This product includes software developed by Eric Young (eay@cryptsoft.com)

• This product includes software developed by Eric Young (eay@mincom.oz.au)

• This product includes software developed by Ezra Story and by Kari Mettinen.

• This product includes software developed by Ezra Story, by Kari Mettinen and by Bernd Ernesti.

• This product includes software developed by Ezra Story, by Kari Mettinen, Michael Teske and by
Bernd Ernesti.

• This product includes software developed by Ezra Story, by Kari Mettinen, and Michael Teske.

• This product includes software developed by Ezra Story.

• This product includes software developed by Frank van der Linden for the NetBSD Project.

• This product includes software developed by Gardner Buchanan.

• This product includes software developed by Gary Thomas.

• This product includes software developed by Gordon Ross

• This product includes software developed by Gordon W. Ross

• This product includes software developed by HAYAKAWA Koichi.

• This product includes software developed by Harvard University and its contributors.

• This product includes software developed by Harvard University.

• This product includes software developed by Herb Peyerl.

• This product includes software developed by Hubert Feyrer for the NetBSD Project.

• This product includes software developed by Iain Hibbert

• This product includes software developed by Ian F. Darwin and others.

• This product includes software developed by Ian W. Dall.

• This product includes software developed by Ichiro FUKUHARA.

• This product includes software developed by Ignatios Souvatzis for the NetBSD Project.

• This product includes software developed by Internet Initiative Japan Inc.

• This product includes software developed by James R. Maynard III.

• This product includes software developed by Jared D. McNeill.

• This product includes software developed by Jason L. Wright

• This product includes software developed by Jason R. Thorpe for And Com-munications, http://
www.and.com/

• This product includes software developed by Joachim Koenig-Baltes.

• This product includes software developed by Jochen Pohl for The NetBSD Project.

• This product includes software developed by Joerg Wunsch

• This product includes software developed by John Birrell.

• This product includes software developed by John P. Wittkoski.
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• This product includes software developed by John Polstra.

• This product includes software developed by Jonathan R. Stone for the NetBSD Project.

• This product includes software developed by Jonathan Stone and Jason R. Thorpe for the NetBSD
Project.

• This product includes software developed by Jonathan Stone.

• This product includes software developed by Jukka Marin.

• This product includes software developed by Julian Highfield.

• This product includes software developed by Kazuhisa Shimizu.

• This product includes software developed by Kazuki Sakamoto.

• This product includes software developed by Kenneth Stailey.

• This product includes software developed by Kiyoshi Ikehara.

• This product includes software developed by Klaus Burkert,by Bernd Ernesti, by Michael van Elst,
and by the University of California, Berkeley and its contributors.

• This product includes software developed by LAN Media Corporation and its contributors.

• This product includes software developed by Leo Weppelman for the NetBSD Project.

• This product includes software developed by Leo Weppelman.

• This product includes software developed by Lloyd Parkes.

• This product includes software developed by Luke Mewburn.

• This product includes software developed by Lutz Vieweg.

• This product includes software developed by MINOURA Makoto, Takuya Harakawa.

• This product includes software developed by Manuel Bouyer.

• This product includes software developed by Marc Horowitz.

• This product includes software developed by Marcus Comstedt.

• This product includes software developed by Mark Brinicombe for the NetBSD project.

• This product includes software developed by Mark Brinicombe.

• This product includes software developed by Mark Murray

• This product includes software developed by Mark Tinguely and Jim Lowe

• This product includes software developed by Markus Wild.

• This product includes software developed by Martin Husemann and Wolfgang Solfrank.

• This product includes software developed by Masanobu Saitoh.

• This product includes software developed by Masaru Oki.

• This product includes software developed by Mats O Jansson and Charles D.Cranor.

• This product includes software developed by Mats O Jansson.

• This product includes software developed by Matt DeBergalis
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• This product includes software developed by Matthew Fredette.

• This product includes software developed by Matthias Pfaller.

• This product includes software developed by Michael Graff for the NetBSD Project.

• This product includes software developed by Michael Graff.

• This product includes software developed by Michael L. Hitch.

• This product includes software developed by Michael Shalayeff.

• This product includes software developed by Michael Smith.

• This product includes software developed by Mike Glover and contributors.

• This product includes software developed by Mike Pritchard.

• This product includes software developed by Minoura Makoto.

• This product includes software developed by Nan Yang Computer Services Limited.

• This product includes software developed by Niels Provos.

• This product includes software developed by Niklas Hallqvist, Brandon Creighton and Job de Haas.

• This product includes software developed by Niklas Hallqvist.

• This product includes software developed by Onno van der Linden.

• This product includes software developed by Paul Kranenburg.

• This product includes software developed by Paul Mackerras.

• This product includes software developed by Per Fogelstrom

• This product includes software developed by Peter Galbavy.

• This product includes software developed by Phase One, Inc.

• This product includes software developed by Philip A. Nelson.

• This product includes software developed by Philip L. Budne.

• This product includes software developed by RiscBSD.

• This product includes software developed by Roar Thronaes.

• This product includes software developed by Rodney W. Grimes.

• This product includes software developed by Roger Hardiman

• This product includes software developed by Roland C. Dowdeswell.

• This product includes software developed by Rolf Grossmann.

• This product includes software developed by Ross Harvey for the NetBSD Project.

• This product includes software developed by Ross Harvey.

• This product includes software developed by Scott Bartram.

• This product includes software developed by Scott Stevens.

• This product includes software developed by Shingo WATANABE.
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• This product includes software developed by Softweyr LLC, the University of California, Berkeley, and
its contributors.

• This product includes software developed by Soren S. Jorvang.

• This product includes software developed by Stephan Thesing.

• This product includes software developed by Steve Woodford.

• This product includes software developed by Takashi Hamada

• This product includes software developed by Takumi Nakamura.

• This product includes software developed by Tatoku Ogaito for the NetBSD Project.

• This product includes software developed by Terrence R. Lambert.

• This product includes software developed by Tetsuya Isaki.

• This product includes software developed by Thomas Gerner

• This product includes software developed by Thomas Klausner for the NetBSD Project.

• This product includes software developed by Tobias Weingartner.

• This product includes software developed by Todd C. Miller.

• This product includes software developed by Tohru Nishimura and Reinoud Zandijk for the NetBSD
Project.

• This product includes software developed by Tohru Nishimura for the NetBSD Project.

• This product includes software developed by Tohru Nishimura. for the NetBSD Project.

• This product includes software developed by TooLs GmbH.

• This product includes software developed by Toru Nishimura.

• This product includes software developed by Trimble Navigation, Ltd.

• This product includes software developed by WIDE Project and its contributors.

• This product includes software developed by Waldi Ravens.

• This product includes software developed by Wasabi Systems for Zembu Labs, Inc. http://
www.zembu.com/

• This product includes software developed by Winning Strategies, Inc.

• This product includes software developed by Wolfgang Solfrank.

• This product includes software developed by Yasushi Yamasaki

• This product includes software developed by Zembu Labs, Inc.

• This product includes software developed by the Alice Group.

• This product includes software developed by the Center for Software Science at the University of Utah.

• This product includes software developed by the Charles D. Cranor, Washington University, University
of California, Berkeley and its contributors.
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• This product includes software developed by the Computer Systems Engineering Group at Lawrence
Berkeley Laboratory.

• This product includes software developed by the David Muir Sharnoff.

• This product includes software developed by the Harvard University and its contributors.

• This product includes software developed by the Kungliga Tekniska Hogskolan and its contributors.

• This product includes software developed by the Network Research Group at Lawrence Berkeley
Laboratory.

• This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit.
(http://www.OpenSSL.org/)

• This product includes software deve

Netatalk(NetBSD)/NetaTalk 1.4b2+asun2.1.3

Copyright (c) 1990,1991 Regents of The University of Michigan. All Rights Reserved.

FreeBSD 4.6.2/netipx

Copyright (c) 1984, 1985, 1986, 1987, 1993

The Regents of the University of California. All rights reserved.

Modifications Copyright (c) 1995, Mike Mitchell

Modifications Copyright (c) 1995, John Hay

Sablotron

Sablotron (Version 0.82) Copyright (c) 2000 Ginger Alliance Ltd. All Rights Reserved

a) The application software installed on this product includes the Sablotron software Version 0.82
(hereinafter, "Sablotron 0.82"), with modifications made by the product manufacturer. The original code
of the Sablotron 0.82 is provided by Ginger Alliance Ltd., the initial developer, and the modified code of
the Sablotron 0.82 has been derived from such original code provided by Ginger Alliance Ltd.

b) The product manufacturer provides warranty and support to the application software of this product
including the Sablotron 0.82 as modified, and the product manufacturer makes Ginger Alliance Ltd., the
initial developer of the Sablotron 0.82, free from these obligations.

c) The Sablotron 0.82 and the modifications thereof are made available under the terms of Mozilla Public
License Version 1.1 (hereinafter, "MPL 1.1"), and the application software of this product constitutes the
"Larger Work" as defined in MPL 1.1. The application software of this product except for the Sablotron
0.82 as modified is licensed by the product manufacturer under separate agreement(s).
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d) The source code of the modified code of the Sablotron 0.82 is available at: http://support-
download.com/services/device/sablot/notice082.html

e) The source code of the Sablotron software is available at: http://www.gingerall.com

f) MPL 1.1 is available at: http://www.mozilla.org/MPL/MPL-1.1.html

JPEG LIBRARY

• The software installed on this product is based in part on the work of the Independent JPEG Group.

SASL

CMU libsasl

Tim Martin

Rob Earhart

Rob Siemborski

Copyright (c) 2001 Carnegie Mellon University. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. The name "Carnegie Mellon University" must not be used to endorse or promote products derived
from this software without prior written permission.

For permission or any other legal details, please contact:

Office of Technology Transfer

Carnegie Mellon University

5000 Forbes Avenue

Pittsburgh, PA 15213-3890

(412) 268-4387, fax: (412) 268-7395

tech-transfer@andrew.cmu.edu

4. Redistributions of any form whatsoever must retain the following acknowledgment: "This product
includes software developed by Computing Services at Carnegie Mellon University (http://
www.cmu.edu/computing/)."

CARNEGIE MELLON UNIVERSITY DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE,
INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL
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CARNEGIE MELLON UNIVERSITY BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL
DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING
OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Samba(Ver 3.0.4)

For SMB transmission, this machine uses Samba ver 3.0.4 (hereinafter referred to as Samba 3.0.4).

Copyright (c) Andrew Tridgell 1994-1998

This program is free software; you can redistribute it and/or modify it under the terms of the GNU General
Public License as published by the Free Software Foundation; either version 2 of the License, or (at your
option) any later version.

This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even
the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU
General Public License along with this program; if not, write to the Free Software Foundation, Inc., 675
Mass Ave, Cambridge, MA 02139, USA.

• The source code for SMB transmission by this machine can be downloaded from the following website:
http://support-download.com/services/scbs

RSA BSAFE®

• This product includes RSA BSAFE (c) cryptographic software from RSA Security Inc.

• RSA, BSAFE are either registered trademarks or trademarks of RSA Security Inc. in the United States
and/or other countries.

• RSA Security Inc. All rights reserved.
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Open SSL

Copyright (c) 1998-2004 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgment:

"This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://
www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products
derived from this software without prior written permission. For written permission, please contact openssl-
core@openssl.org.

5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their
names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment:

"This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://
www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS" AND ANY EXPRESSED OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product
includes software written by Tim Hudson (tjh@cryptsoft.com).

Original SSLeay License

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com).

The implementation was written so as to conform with Netscapes SSL.
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This library is free for commercial and non-commercial use as long as the following conditions are aheared
to. The following conditions apply to all code found in this distribution, be it the RC4, RSA, lhash, DES, etc.,
code; not just the SSL code. The SSL documentation included with this distribution is covered by the same
copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be removed. If
this package is used in a product, Eric Young should be given attribution as the author of the parts of the
library used. This can be in the form of a textual message at program startup or in documentation (online
or textual) provided with the package.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the following
disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgement: "This product includes cryptographic software written by Eric Young
(eay@cryptsoft.com)" The word 'cryptographic' can be left out if the rouines from the library being used
are not cryptographic related :-).

4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application
code) you must include an acknowledgement: "This product includes software written by Tim Hudson
(tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG "AS IS" AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

The licence and distribution terms for any publically available version or derivative of this code cannot be
changed. i.e. this code cannot simply be copied and put under another distribution licence

[including the GNU Public Licence.]

Open SSH

The licences which components of this software fall under are as follows. First, we will summarize and say
that all components are under a BSD licence, or a licence more free than that.
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OpenSSH contains no GPL code.

1)

Copyright (c) 1995 Tatu Ylonen <ylo@cs.hut.fi>, Espoo, Finland All rights reserved

As far as I am concerned, the code I have written for this software can be used freely for any purpose. Any
derived versions of this software must be clearly marked as such, and if the derived work is incompatible
with the protocol description in the RFC file, it must be called by a name other than "ssh" or "Secure Shell".

[Tatu continues]

However, I am not implying to give any licenses to any patents or copyrights held by third parties, and the
software includes parts that are not under my direct control. As far as I know, all included source code is
used in accordance with the relevant license agreements and can be used freely for any purpose (the GNU
license being the most restrictive); see below for details.

[However, none of that term is relevant at this point in time. All of these restrictively licenced software
components which he talks about have been removed from OpenSSH, i.e.,

- RSA is no longer included, found in the OpenSSL library

- IDEA is no longer included, its use is deprecated

- DES is now external, in the OpenSSL library

- GMP is no longer used, and instead we call BN code from OpenSSL

- Zlib is now external, in a library

- The make-ssh-known-hosts script is no longer included

- TSS has been removed

- MD5 is now external, in the OpenSSL library

- RC4 support has been replaced with ARC4 support from OpenSSL

- Blowfish is now external, in the OpenSSL library

[The licence continues]

Note that any information and cryptographic algorithms used in this software are publicly available on the
Internet and at any major bookstore, scientific library, and patent office worldwide. More information can
be found e.g. at "http://www.cs.hut.fi/crypto".

The legal status of this program is some combination of all these permissions and restrictions. Use only at
your own responsibility. You will be responsible for any legal consequences yourself; I am not making any
claims whether possessing or using this is legal or not in your country, and I am not taking any responsibility
on your behalf.

NO WARRANTY

BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE
PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED
IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
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PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH
YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY
SERVICING, REPAIR OR CORRECTION.

IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY
COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE
PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL,
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY
TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING
RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE
PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

2)

The 32-bit CRC compensation attack detector in deattack.c was contributed by CORE SDI S.A. under a
BSD-style license.

Cryptographic attack detector for ssh - source code

Copyright (c) 1998 CORE SDI S.A., Buenos Aires, Argentina.

All rights reserved. Redistribution and use in source and binary forms, with or without modification, are
permitted provided that this copyright notice is retained.

THIS SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES ARE
DISCLAIMED. IN NO EVENT SHALL CORE SDI S.A. BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY OR CONSEQUENTIAL DAMAGES RESULTING FROM THE USE
OR MISUSE OF THIS SOFTWARE.

Ariel Futoransky <futo@core-sdi.com>

<http://www.core-sdi.com>

3)

One component of the ssh source code is under a 3-clause BSD license, held by the University of California,
since we pulled these parts from original Berkeley code.

Copyright (c) 1983, 1990, 1992, 1993, 1995

The Regents of the University of California. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of the University nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.
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THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

4)

Remaining components of the software are provided under a standard 2-term BSD licence with the
following names as copyright holders:

Markus Friedl

Theo de Raadt

Niels Provos

Dug Song

Kevin Steves

Daniel Kouril

Wesley Griffin

Per Allansson

Jason Downs

Solar Designer

Todd C. Miller

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR "AS IS" AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
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(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

5)

Portable OpenSSH contains the following additional licenses:

c) Compatibility code (openbsd-compat)

Apart from the previously mentioned licenses, various pieces of code in the openbsd-compat/ subdirectory
are licensed as follows:

Some code is licensed under a 3-term BSD license, to the following copyright holders:

Todd C. Miller

Theo de Raadt

Damien Miller

Eric P. Allman

The Regents of the University of California

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of the University nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

Open LDAP

The OpenLDAP Public License Version 2.8, 17 August 2003

Redistribution and use of this software and associated documentation ("Software"), with or without
modification, are permitted provided that the following conditions are met:

Copyrights

401

11



1. Redistributions in source form must retain copyright statements and notices,

2. Redistributions in binary form must reproduce applicable copyright statements and notices, this list of
conditions, and the following disclaimer in the documentation and/or other materials provided with the
distribution, and

3. Redistributions must contain a verbatim copy of this document.

The OpenLDAP Foundation may revise this license from time to time. Each revision is distinguished by a
version number. You may use this Software under terms of this license revision or under the terms of any
subsequent revision of the license.

THIS SOFTWARE IS PROVIDED BY THE OPENLDAP FOUNDATION AND ITS CONTRIBUTORS "AS IS"
AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.
IN NO EVENT SHALL THE OPENLDAP FOUNDATION, ITS CONTRIBUTORS, OR THE AUTHOR(S) OR
OWNER(S) OF THE SOFTWARE BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT
OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The names of the authors and copyright holders must not be used in advertising or otherwise to promote
the sale, use or other dealing in this Software without specific, written prior permission. Title to copyright
in this Software shall at all times remain with copyright holders.

OpenLDAP is a registered trademark of the OpenLDAP Foundation.

Copyright (c) 1999-2003 The OpenLDAP Foundation, Redwood City, California, USA. All Rights
Reserved. Permission to copy and distribute verbatim copies of this document is granted.
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